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Abstract

This work describes the simulation of excitonic solar cells and organic light emitting

diodes using the Finite Element Method.

Although solar cells and light emitting diodes have different functions, the former is

the time reversal of the latter. This equivalence enables these seemingly disparate

functional devices to be simulated analogously. Solar cells based on organic polymers

as well as dye-sensitised titanium dioxide are considered and remarkably, these can

also be described using a common physical basis, termed the excitonic solar cell. This

description accounts for the fact the generation profile of charge carriers in excitonic

solar cells is different to that in conventional solar cells such as those made from silicon

p-n junctions.

Part I investigates two related timescales relevant to the dye-sensitised solar cell and

compares a simple analytical model to the numerical simulations under fast extraction

conditions. The transport time is shown to be well described numerically, however, the

photovoltage rise time was not successfully obtained and the grounds for this discrep-

ancy are investigated.

Part II surveys devices based on organic materials. Firstly, a parametric study of so-

lar cells with a complex inter-digitated structure are considered and are consistently

shown to be limited by low charge transport efficiencies and space charge effects at

high illumination intensity. In addition, the open circuit voltage in these devices is

described by specified deviations from the built-in voltage. Secondly, experimental

current-voltage characteristics of organic light emitting diodes (OLEDs) made from

organic dendrimers are simulated. Distinct regions of the dendrimer molecule control

different material properties, thus making them ideal candidates for future device ap-

plications where different attributes can be separately optimised. The simulations show

that the Mott-Schottky model - describing the charge injection barrier height from a

metallic electrode - is not adhered to in devices which are prepared and tested under

ambient conditions.
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Chapter 1

Introduction

1.1 Preamble

This thesis is concerned with the simulation of novel functional devices. That is, solar

cells and light emitting diodes which are not based on highly pure crystalline semi-

conductors such as silicon and gallium arsenide. Although the majority of the results

reported here will be concerned with organic solids alone, work on photoelectrochem-

ical systems based on hybrid organic/inorganic systems containing titanium dioxide

(TiO2) will be discussed also.

The prototypical electronic device is the inorganic p-n junction, comprising two pieces

of semiconductor in contact with one another, one with a net positive charge and one

with a net negative charge [1]. This simple structure forms the basis of many modern

electronic devices including solar cells [2]. In the last two decades however, there has

been a surge of interest in making devices from materials utilising organic solids such

as polymers [3, 4] and also inorganic photoelectrochemical systems. The Grätzel solar

cell is a frequently cited example of the latter [5, 6].

World energy use is rising inexorably. For example, total consumption rose from

roughly 47 quads (1 quad is equal to 2.9 × 1011kWh) in 2000 to just over 53 quads in

2004 according to the US Department of Energy. This is an incredible rise considering

the value in 1980 was just 25.5 quads [7]. However, even in 2005, only 0.06% of the

energy production of America (the world’s largest consumer) came from photovoltaic

sources. This compares with 0.12% from wind and 2.7% from hydroelectric sources

[8]. These figures seem absurdly small when compared with the amount of solar radia-

tion incident on the surface of the Earth, at 125,000TW [9]. This shows that the Sun

7



supplies enough energy to the Earth in approximately 7 minutes to provide all the elec-

trical power currently used in one year. Solar cells are a potential route to generating

electricity more sustainably but should be considered as a part of the solution rather

than as a panacea for the World’s energy problems.

Another route to reduce energy usage is to use more efficient electrical devices such

as displays and light-emitting diodes, LEDs. For example, in America, lighting is the

single largest burden on the energy budget, accounting for 30% of the electricity con-

sumed in 2001 [10]. Solid state lighting (using the light-emitting properties of semicon-

ductors) offers the potential to produce light with considerably higher efficiency than

traditional fluorescent and incandescent sources. For example the standard filament

light bulb has an efficiency of between 1-4% compared to LED efficiency of between

20-50% [11]. Other advantages of these systems include lifetimes of up to 100 times

greater than tungsten based bulbs, toughness which comes from containing no glass

and the possibility of using up to 90% less electricity than traditional sources of light

[11].

1.2 Photovoltaics

The discovery of the photovoltaic effect is widely attributed to Edmund Becquerel in

1839 when he observed a photocurrent in silver coated platinum in aqueous solution

[2, 12, 13]. It is now known that Becquerel had observed a photoelectrochemical effect,

although the net result was the same [12]. Selenium was the next material to have noted

photovoltaic properties, as discovered by Adams and Day in 1877, although again it

was its photoconductivity which was discovered first [12, 13]. In the years that followed,

the photovoltaic effect was also noted in many other materials such as cuprous oxides,

lead sulphide and thallium sulphide. The photoconductive properties of selenium-based

materials, (where the current passed is proportional to the light intensity) made it ideal

for light meters and in 1885, the German industrialist Werner von Siemens was quoted

as saying that his research had demonstrated ...

“...for the first time, the direct conversion of the energy of light into elec-

trical energy [12].”

The photoconductive properties of these early materials initially excited researchers

because the possible applications in light meters meant the devices could work without

a separate battery [2].
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One common feature of these early photoactivated devices was the existence of an

energy barrier at the metal-semiconductor interface. However, it was not until the

1930s that the modern theory of these interfaces was developed by Mott, Schottky

and others [2] and they are now universally known as Schottky contacts. Before this

time it was thought that a third interlayer of low conductivity (for example, an oxide)

could have been responsible for the observed rectifying action [12]. Schottky contacts

were found to be poor photoconverters however due to their large dark currents [12].

Semiconductor-semiconductor junction devices have lower dark currents and it was the

development of this technology that lead to the subsequent rapid improvement in device

efficiency.

As with the transistor (invented in 1947 [1]) the development of the modern p-n junction

solar cell began at Bell Laboratories in America. In 1954 Chapin et al. reported a 6%

power conversion efficiency, a huge improvement on the previous best result of just 1%

from thermoelectric junction devices [14]. This research grew out of the need for extra-

terrestrial power generation for the American space programme, then at its very early

stages [12]. Also in 1954, a 6% efficient cadmium sulphide p-n junction cell was reported

[13, 15] and theoretical work indicating that other material combinations could provide

higher efficiencies led to work on p-n junctions made from gallium arsenide, indium

phosphide and cadmium telluride. Just four years later, in 1958, the power conversion

efficiency of silicon cells had increased by more than a factor of 2 to 14% [13]. None

of these, however, managed to overtake silicon as the most widely used photovoltaic

material, which it remains to this day. This was undoubtedly due, in part, to the

parallel development of silicon for computing applications [2]. Indeed, by the turn of

the millennium, the efficiency of single crystal silicon cells had increased to almost 25%

[12]. Although the cost of producing electricity from photovoltaic sources has remained

high throughout its development, it has opened up the possibility for producing power

in a stand-alone fashion, for example, in remote locations where fossil fuel supplies may

be scarce [2].

Due to the continuing high costs of silicon based solar cells (which, in 2005 still ac-

counted for 94% of the photovoltaics market), in the last 20 years, there has been much

interest in so-called second and third generation solar cell technologies [9]. In 2005,

second generation cells accounted for 5.6% of the remaining photovoltaic market after

first generation devices [16], where the term second generation describes so-called thin

film technologies using material combinations such as cadmium telluride and cadmium

selenide [2, 17]. These materials do not require the use of silicon and aim to be pro-

duced at significantly reduced cost by, for example, using non-crystalline substrates

such as glass, which are not suitable for the highest efficiency first generation cells [9].
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Third generation solar cells are altogether different and can be split into two further

categories, IIIa and IIIb [16]. Class IIIa cells aim to generate efficiencies well above

the 31% theoretical limit of a single junction device [18] by using exotic devices such

as hot carrier, impact ionisation, and multiband solar cells [17]. Hot carrier devices,

for example, aim to utilise the excess energy of charge carriers after photon absorption

and subsequent charge generation by extracting them before they have the chance to

thermalise to the band edge. In a first generation silicon device, if a photon of energy

greater than the bandgap is absorbed, the excess energy of a photogenerated electron

will be dissipated as heat (phonon emission) in a time of the order of femtoseconds

[2] and will not be available for conversion into electrical work. Informative reviews

of these generation IIIa systems are given in the work of Green [17] and Nelson [2]

however these systems will not be considered further here.

Class IIIb solar cells encompass those based on organic polymers [19] as well as dye-

sensitised nanocrystalline solar cells (DSSCs). The efficiency of an organic photovoltaic

module should be of the order of ∼10% power efficient and have a lifetime of betwen

3 and 5 years to become a competitive technology [20]. Indeed, efficiencies of up to

11% have been reported for liquid electrolyte DSSCs [21]. This lifetime is considered

to be akin to that of portable consumer electronics which may be powered by the solar

cells in question given they can have a shelf life of over one year. The DSSC consists

of titanium dioxide (TiO2) particles as the electron transporter covered in a monolayer

of light harvesting dye molecules immersed in liquid redox electrolyte [5, 21], or a solid

state hole conductor [22]. The aim of these class IIIb cells is to attain relatively small

efficiencies in conjunction with very low cost [16, 20]. It is these class IIIb devices

which will form the majority of the work presented here. Both classes of these devices

are also collectively referred to as excitonic solar cells [23], which will be discussed in

detail in section 1.6.

Saturated plastics (man-made polymers) where all carbon valence electrons are taken

up in covalent bonds are the most widely used materials in the world, both by volume

and by weight [24]. However, it is only in the last 30 years that interest has developed

in unsaturated semiconducting and metallic polymers, culminating in the 2000 Nobel

Prize for chemistry, awarded to Heeger, Shirakawa and Macdiarmid

“for their discovery and development of conductive polymers”.

In a seminal paper, Chiang et al. demonstrated that the electrical conductivity of

polyacetylene could be increased by up to 11 orders of magnitude by the addition of

halogen dopants [4].
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Molecular photovoltaic systems had been known since the mid 20th century [25] and

frequently used the device structure of one layer of organic material contacted to elec-

trodes with different work functions. Reference [26] provides an informative, early

(1983) review. A breakthrough occurred in 1986 by the use of a two layer structure

with a planar interface between them [27]. The realisation was that charges were being

created at the interface between the layers of copper phthalocyanine and the organic

perylene derivative rather than in the bulk as in inorganic solar cells. An excellent

review of the development of organic solar cells can be found in the chapter by Halls

and Friend in reference [12]. In 1995 another innovation was achieved by the discovery

that intimate blending of two different polymers [28, 29], or a polymer with C60 [30]

could bring about an improvement in device performance. The initial photogenerated

state in an organic material is an exciton, a bound state of an electron and a hole. This

state needs to be separated at a material heterojunction and its constituent charges

transported to their respective electrodes. The blending of the materials means that

the excitons are always generated close to an interface and are less likely to recombine

before diffusing to a junction for dissociation. In the polymer-polymer blend case, a

power conversion efficiency of 1% was obtained and the cell was found to be 2 or 3

orders of magnitude more efficient than a cell made up of either of the constituent

polymers respectively [12].

More recently still, hybrid solar cells made from polymers intermixed with inorganic

materials such as TiO2 have been proposed [31, 32]. These offer the possibility of

engineering the morphology of the device to an even greater extent to that which

is possible using a bulk heterojunction. Indeed these idealised geometries have been

shown to be potentially more efficient than bulk heterojunction or bilayer devices [33].

The quantification of the price of photovoltaic technology is most often considered in

terms of the cost per watt, or per watt-peak. This is the power which a solar cell

device will supply under standard test conditions of 1kWm−2 illumination intensity

and a temperature of 298K [7]. The American photovoltaics industry [34] and the US

Department of Energy [16] have decided on a target price of less than $0.5/W and

an efficiency of 18-20% for a competitive solar cell technology. However, in 2005, the

cost of producing crystalline photovoltaic modules was still at ∼$4/W, an order of

magnitude too high. Even in 2007, electricity generated from solar cells is still between

6 and 16 times more expensive than that generated by coal [9].

Whether or not a specific photovoltaic technology becomes competitive in the market-

place will depend not only on the cost, but also on the efficiency and product lifetime

[9, 20]. A product only succeeding in two of these will only be suitable for niche applica-

tions. This is clear in the case of silicon solar cells where the efficiency and lifetime are

certainly competitive but the price has kept them out of domestic generation in the UK.
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However, the German government introduced the 100,000 roofs programme in 1999 to

aid in the implementation of a significant solar cell component to their electricity needs

[35]. The price of electricity generated from solar cells is still high, however demand is

now elastic. That is, the market has found a stage where a small change in price has

a significant impact on the sales [9]. If this can be coupled to the reduction in unit

cost associated with an increase in production (worldwide photovoltaic cell production

is currently growing exponentially) then electricity prices of ∼$1/W are within reach

for these mainly silicon based, first generation solar cells.

A solar cell functions as a “light in, electricity out” device. The reverse operation,

“electricity in, light out” is the light emitting diode or LED. The development of these

latter structures will now be considered.

1.3 Displays

The history of electroluminescence (the emission of light caused by a current) can be

traced back to the report of the “curious phenomenon” of light emission from a silicon

carbide Schottky diode in 1907 [36]. This device showed “unsymmetrical passage of

current” [37]. Today this is referred to as as rectification, or diode behaviour. This was

therefore the first report of a light-emitting diode, or LED. In 1928 Lossev reported the

light-emitting properties of silicon carbide in more detail and performed experiments

which concluded that the emission was not due to incandescence (radiation due to finite

temperature) [36]. He concluded that the material was suitable for the construction of

so-called “light-relays” since the light could be generated and extinguished rapidly.

The postulation and subsequent experimental realisation of semiconducting III-V com-

pounds proved fruitful since they were found to be good optical emitters [36]. By

the early 1960s, wafers of gallium arsenide were being used as substrates for epitaxial

growth of p-n junctions for use in semiconductor lasers and the first reports of gal-

lium arsenide phosphide LEDs were published [36]. Subsequent work has lead to the

development of emitters across the visible spectrum with the development and patent

rights of the blue laser diode providing some controversy [38]. This is a testament to

the profitability and technological importance of these devices.

In the late 1980s, the modern era of the organic light emitting diode, or OLED, began

[39, 40, 41], although Pope had observed electroluminescence in anthracene some 25

years earlier in 1963 [42]. The problem with these very early devices was that the driving

voltages were very high (>100V). The use of considerably thinner films enabled the

drive voltages to be reduced by an order of magnitude. In references [40, 41] layers of
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small molecule organic materials were used, but the real breakthrough by the group

of Richard Friend in Cambridge [39] was to use a single layer of an organic polymer,

poly(p-phenylene vinylene) as the active layer. Displays based on conjugated polymers

similar to those used in reference [39] are already being commercialised [43].

1.4 Outlook

Due to their low materials cost and ease of processing at room temperature, OLEDs and

class IIIb photovoltaic devices hold much promise for future applications in consumer

electronics and remote area power generation for example. It is one of the goals of

these novel concepts in material design that they will be printed on flexible substrates

using technology used routinely in the publishing industry. This will enable the man-

ufacture of significantly higher numbers of cells than is currently possible using first

generation technology [20]. Recent work on so-called ‘supramolecular’ systems aims to

use materials which self-assemble into desired morphologies [44] and it is even possible

to design molecules with desired properties using quantum chemical techniques [45].

Understanding the size of the bandgap of an organic polymer for example is crucial

to the design of photovoltaic materials capable of absorbing a greater fraction of the

Sun’s rays than is currently possible [46, 47].

1.5 Physics of solar cells

The device physics pertinent to the study of solar cells is now considered. Of particular

relevance are the maximum limiting efficiency of a solar energy converter and the four

parameters

1. Short circuit current

2. Open circuit voltage

3. Fill factor

4. Power conversion efficiency at maximum power point

1.5.1 Limiting efficiency

The maximum efficiency of any thermodynamic heat engine is that of the Carnot cycle,
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Figure 1.1: Losses in a p-n junction solar cell with respect to the conduction band
(top solid line) and the valence band (bottom solid line) as a function of distance
from the cathode. (1) Thermalisation to the band edge, (2) junction loss, (3) contact
loss, (4) recombination loss. The dashed lines are the electrode work functions and
the (un)primed quantities represent processes relevant to (electrons) holes. Process 4
involves an electron and a hole, hence its inclusion in both the p and n sides of the
junction. From reference [17].

ηCarnot = 1− Tout

Tin
. (1.1)

The surface of the Sun (Tin) is roughly 6000K, so for a solar cell operating at 300K

(Tout), the Carnot efficiency is 95%. Crucially however, this is for a Carnot cycle

which assumes that, in equilibrium, the emitted photons from the cell go back to the

Sun helping it maintain thermal equilibrium [17, 2]. Regarding these photons as a

loss mechanism reduces this figure to 93.3%. This is far higher than the theoretical

maximum of 31% for a single junction device as shown by Shockley in 1961 [18]. It

is therefore necessary to look at the loss mechanisms in a generic single junction solar

cell, such as a classical p-n junction. These are illustrated in figure 1.1.

The thermalisation loss (process (1) in figure 1.1) limits the efficiency to ∼44% [18, 17].

This is because in an ideal semiconductor of bandgap, Eg, all incident photons with

energies below Eg will not be absorbed and those with energies above Eg will have

the same effect as those at Eg due to process (1) in figure 1.1. The usable voltage

obtainable from a solar cell is equal to the difference in potential between the contacts,

so this accounts for the loss mechanisms (2) and (3) [2]. To minimise process (3)

ohmic contacts can be used as these have zero resistance loss by definition. Process
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Figure 1.2: Qualitative representations of the current-voltage characteristic in the dark
(solid line) and under illumination (dashed line). The output power of the device under
illumination is also shown (©). This is the product of the current and the applied bias
and shows a clear maximum since the bias is zero at short circuit and the current is
zero at open circuit.

(4), recombination, can be minimised by using materials with long carrier lifetimes

[17]. The effect of radiative recombination is also important since a solar cell must

emit photons as well as absorb them to remain in equilibrium; this loss is completely

unavoidable [2]. The bandgap of the converter material is crucial also because a small

bandgap is required for a large photocurrent but a large value is needed for a high open

circuit voltage; both of which are important for high efficiency. These factors gives rise

to an optimum value of Eg and a maximum efficiency of 31% [18].

Recently, the limiting efficiency of an organic photoconverter has been considered [48],

concluding on a figure of ∼20%, roughly twice the figure thought to be needed to break

into commercial applications. The improvements which need to be overcome before

this figure can be realised include better absorption matching with the solar spectrum,

surmounting of the ‘exciton diffusion bottleneck’ (the dissociation of excitons before

they can recombine) and decreasing cell resistance [48]. A more complete review of the

detailed balance theory in the context of solar cells is given in reference [49].

1.5.2 Electrical parameters

Figure 1.2 shows the form of the current-voltage characteristic for a solar cell in the

dark and under illumination. The short circuit current density, Jsc is defined as the

current density under illumination at zero applied bias and under these conditions the

potential difference between the electrodes is called the built-in bias, Vbi. The open
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Figure 1.3: Schematic representation of exciton diffusion and dissociation in a two-
component organic solar cell. The exciton (squares) moves by diffusion in phase 1
until it meets the material heterojunction. Material 2 has a higher electron affinity
and ionisation potential and so the electron (filled circle) is transferred to 2 and the
hole (empty circle) stays on 1. After exciton dissociation, the electron and hole are
transferred to their respective electrodes to complete the circuit.

circuit voltage, Voc, is the applied bias at which the photogenerated, extracted current

equals the injected current and therefore the total current is zero. Other important

quantities for solar cells are the maximum power point power conversion efficiency, ηmpp

and the fill factor, FF . The efficiency at maximum power point is the power density

delivered to the external circuit divided by the incident illumination power density, P0,

ηmpp =
JmppVampp

P0
. (1.2)

JmppVampp is the product of the current density and the applied voltage at the maximum

power point. The FF is defined as

FF =
JmppVampp

JscVoc
≡ ηmppP0

JscVoc
. (1.3)
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Figure 1.4: A schematic diagram of a bulk heterojunction solar cell showing exciton
generation and dissociation as well as the subsequent transport of electron and holes to
their respective extracting electrodes. Used with permission from J. Nelson, Depart-
ment of Physics, Imperial College London.

and is a measure of the ‘squareness’ of the current-voltage characteristic in figure 1.2

[2].

These four important performance parameters are often stated under AM1.5 illumi-

nation conditions. The AM stands for air mass and the 1.5 represents the increased

path length of the light through the Earth’s atmosphere compared to that with the

sun overhead. Specifically, when the angle of incidence (θ) is such that cosec(θs)=1.5,

θs=42o [2].

The Shockley diode equation for a solar cell under bias (as shown in figure 1.2) gives

the current-voltage characteristic of an ideal, single junction, solar cell [1],
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Figure 1.5: The function of the DSSC showing electron injection and diffusion as well
as the redox properties of the electrolyte. From reference [21].

J = J0

(

exp

(

eVa

kBT

)

− 1

)

+ Jsc, (1.4)

where J0 is the reverse bias saturation current, e is the electron charge, kB is Boltz-

mann’s constant, Va is the applied bias and T is the absolute temperature. Therefore,

the applied bias when the total current is zero (the open circuit voltage, Voc) is

Voc =
kBT

e
ln

(

Jsc

J0
+ 1

)

. (1.5)

Assuming that Jsc is proportional to the light intensity, the open circuit voltage is

expected to increase logarithmically [2].
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Figure 1.6: Comparison of the photogeneration mechanisms of conventional (left) and
excitonic (right) solar cells. From reference [23].

1.6 Excitonic solar cells

In an organic polymer or dendrimer, the initially photogenerated state is a strongly

bound electron-hole pair, called an exciton. The exciton is charge neutral and therefore

moves by diffusion. The binding energy of this exciton is ∼100meV, which is roughly

two orders of magnitude greater than that in inorganic semiconductors [19]. Since the

thermal energy at room temperature is ∼25meV, excitons are not usually observed at

room temperature in inorganic semiconductors - since they can rapidly dissociate by

absorption of a phonon - and the resulting state is therefore a free electron-hole pair

[23]. The spatial distributions of photogenerated electrons and holes are thus identical

in the absence of excitons. Conversely, the thermal energy is not strong enough to

dissociate the exciton in an organic polymer at room temperature. Photovoltaic action

demands that the exciton be split into its constituent charges and a common way of

achieving this is to include a second material in the vicinity of the absorption site.

If one material has a larger electron affinity and ionisation potential (2) then the exciton

can be separated and the electron may be transferred to (2) and the hole left on (1),

assuming the photogeneration occurred on (1) [19], as illustrated in figure 1.3. In fact,

the resulting state after exciton dissociation is not a free electron in the acceptor and a

free hole in the donor but a bound charge-transfer state known as a polaron pair, which

extends across the junction between the two materials. Another possibility is that the

exciton is transferred between the phases in a process known as energy transfer. The

key point is that charge transfer will occur if the energy of the charge-transfer state is

lower than that of an exciton on either material respectively [50]. After charge transfer

has occurred and the electron and hole are separated, the charges will then diffuse in

different directions as they have opposite spatial derivatives.

This subtle difference between organic and inorganic solar cells has a powerful effect
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Figure 1.7: Bandstructure of an organic bilayer device at short circuit, flat band and
open circuit conditions, from [55]. The acceptor material is poly(9,9’-dioctylfluorene-
co-benzothiadiazole) (F8BT) and the donor is poly(9,9’-dioctylfluorene-co-bis-N,N’-(4-
butylphenyl)-bis-N,N’-phenyl-1,4-phenylenediamine) (PFB), which are both commonly
used organic polymers.

on the performance of the device [23, 51, 52, 53, 54] and crucially, the same excitonic

description can be used for the DSSC as well as for organic heterojunction solar cells.

Figures 1.4 and 1.5 show schematic diagrams of a bulk heterojunction, polymer blend

solar cell and a DSSC respectively.

The common feature of the photogeneration mechanism of excitonic solar cells is that

the processes of charge generation and separation happen simultaneously at a material

heterojunction. The organic-organic interface separates the exciton into its constituent

charges as shown in the right hand pane of figure 1.6 and the same simultaneity of

charge separation and generation occurs at the dye-TiO2 interface in the DSSC. The

exciton is created in the dye at the surface of the TiO2, which is followed by fast electron

injection into the conduction band of the TiO2 [21]. In an inorganic device, such as

silicon, electron-hole pairs are generated together in a bulk material and hence they

will tend to diffuse in the same direction, as in the left hand pane of figure 1.6. Because

the charges need to get to the opposite sides of the device to constitute a photovoltaic

effect, the action of an electric field is needed to pull the charges apart. This limits Voc

to be less than Vbi, whereas values of the Voc greater than Vbi are routinely observed

in organic devices; as in the work reported by Ramsdale et al. [56]. In this case, the

reason for the Voc being greater than Vbi is that at an applied bias equal to Vbi, there is

a diffusion current away from the interface which needs to be negated by a drift current

at open circuit where the total current is zero [56]. Therefore, there must be an electric

field opposing the direction of the built-in field. This can only be the case if Voc > Vbi

and is illustrated in figure 1.7 for a bilayer polymer device.

In a semiconductor, the movement of charges by drift is driven by the gradient of the

electric potential and the diffusion is driven by the gradient of the chemical potential

[23]. The former is generally greater in conventional solar cells because both photogen-

erated electrons and holes will tend to diffuse in the same direction, as noted above. In
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organic devices however, carriers are generated at an interface between dissimilar ma-

terials leading to a large chemical potential gradient. The dominance of the chemical

potential gradient in organics is further enhanced by the generally low charge densities,

which reduces the drift current. Also, the converse situation is intensified in inorgan-

ics by the high mobilities, which tend to smooth out concentration gradients, hence

reducing the diffusion current [23].

All of these factors together can mean that in excitonic devices, the chemical potential

gradient can be larger than the electric potential gradient. The DSSC is an extreme

example where - since all electric fields are screened below a certain doping level in

the TiO2 [21] - the drift velocity is zero everywhere and movement of charge is driven

by chemical potential gradients only. The two fundamental forces, the electric and

chemical potential gradients, can be considered together to be aspects of the same,

electrochemical, potential. This unified potential is also referred to as the quasi-Fermi

level, or free energy [21].

The dye-sensitised solar cell is now considered in part I and organic devices in part II

of this work.
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Part I: Dye-sensitised solar cells
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Chapter 2

Simulation of dye-sensitised

nanocrystalline solar cells

In this chapter, the device physics of simulating a DSSC after it has undergone a

short (8ns) laser pulse at open circuit is introduced before moving on to simulation

results. Reference is frequently made to the transport time and rise time throughout.

The former is the time taken for 63% of the excess photogenerated electrons to be

extracted from the device and the latter is that needed to extract just enough to

charge the capacitance of the underlying substrate. This capacitance has been shown

to be significantly smaller than that of the TiO2 and therefore only a small fraction of

the excess electrons are extracted in this case. The origin of the figure of 63% is that

1 − 1
e=0.63, where e is the base of natural logarithms. This assumes that the rise of

the photovoltage can be described by a single exponential function.

2.1 Introduction

The functional parts of a DSSC consist of inorganic titanium dioxide (TiO2), sensitised

by a monolayer of highly-absorbing dye molecules, immersed in a iodide/triiodide redox

couple solution. There have also been recent efforts to replace the redox liquid with

a solid state hole transporter [22]. Upon photoexcitation, electrons are excited from

the dye molecule into the conduction band of the TiO2. This leaves a hole on the dye

molecule which is reduced by the redox couple. The TiO2 conduction band electrons

are extracted at the anode and to complete the circuit an electron is injected into the

redox couple at the opposite electrode. Power conversion efficiencies as high as 11%

have been demonstrated using the liquid-based DSSC [21], which is roughly a factor of
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Figure 2.1: Schematic band diagram of the TiO2 in a DSSC. The top of the figure
represents the conduction band level, EC and the bottom is the equilibrium Fermi level
EFn,eq, which is the level up to which electron traps are filled at zero bias and zero
light intensity. The small arrows represent the trapping and subsequent de-trapping of
a conduction band electron.

two higher than the maximum reported efficiency for polymer blend devices.

Electric fields have been shown to be largely screened in liquid electrolyte DSSCs [57]

and therefore the transport of conduction band electrons can be well described by

diffusive transport with electric fields playing a relatively minor rôle [21, 58, 59]. This

diffusive transport is complicated by the fact that the TiO2 contains many electron

traps in its bandgap. Figure 2.1 schematically illustrates the trapping and detrapping

of conduction band electrons with these states.

2.2 Methodology

A new method of characterising the transport behaviour in DSSCs at open circuit

has been proposed recently [60]. The experimental method consists of two different

measurements on a DSSC held at open circuit Voc,

1. A photocurrent measurement.

2. A photovoltage measurement.
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Figure 2.2: Equivalent circuit diagram for the DSSC, the components of which are
the capacitance of the TiO2, CT iO2, its transport resistance, Rtrans, the capacitance of
the underlying substrate, Csub, its resistance, Rsub, and the effective resistance due to
recombination, Rrec. The dashed line represents the incident laser pulse which injects
electrons in the TiO2. The battery symbol illustrates the constant, DC bias on the
cell, equal to Voc and the switch is open (solid line) for photovoltage measurements and
closed (dashed line) for photocurrent measurements. Adapted from reference [60].

These two experiments can be represented by the equivalent circuit in figure 2.2

In both measurements, the solar cell is held at open circuit with a bias across the cell

under illumination. In the photocurrent measurement, the switch in figure 2.2 is closed

and the circuit is complete. An additional short pulse of laser light is then incident

on the DSSC which injects some electrons into the TiO2 and raises the voltage by a

small amount, typically ∼2mV [60]. In equivalent circuit terms, this is the same as

the addition of some extra charge to Csub. Because the circuit is complete, the extra

charge can flow around the external circuit and the current, j(t), can be integrated to

give the amount of charge from the laser pulse, Q(t),

Q(t) =

∫ t

0
j(t′)dt′. (2.1)

The associated transient response measures the flow of electrons through the TiO2 film

and the corresponding time constant, τtrans can be expressed as

τtrans = RtransCT iO2, (2.2)
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which is the transport time of the DSSC, using the standard relationship for the time

taken to charge a capacitor through a resistor. It is important that the photovoltage

rise in the TiO2 is small because it is the transport properties of the DSSC at open

circuit conditions which are of interest.

In the second experiment, the charge is prevented from flowing around the external

circuit by opening a switch in figure 2.2. Therefore, when the laser pulse is incident on

the DSSC, the extra photogenerated charge will flow into the substrate capacitance,

Csub, and the current will stop flowing throughRtrans when the voltage across Csub and

CT iO2 is equal. It has been experimentally verified that the capacitance of the TiO2,

which is due to its high trap density, is much larger than that of the substrate. This

means that only a small fraction of the total charge generated by the pulse needs to be

given to Csub for the system to regain equilibrium. As for the photocurrent experiment,

the current can be integrated to find the charge that has flowed into Csub. This charge

can then be divided by the Csub to obtain the photovoltage rise in the substrate, Uph(t),

Uph(t) =

∫ t
0 j(t

′)dt′

Csub
=
Q(t)

Csub
, (2.3)

assuming implicitly that CT iO2
≫ Csub. This assumption indicates that the voltage

across CT iO2 will remain constant as Csub is charged. This amounts to charging the

substrate capacitance through the resistance Rtrans at a constant bias.

The transient response of the system in this case represents the rise time of the photo-

voltage in the substrate, τrise, and is given by

τrise = RtransCsub. (2.4)

From equations 2.4 and 2.2, the transport time can be obtained from the rise time if

the capacitances are known,

τtrans = τrise
CT iO2

Csub
. (2.5)

The goal of this experimental method is to obtain τtrans from a measurement of τrise.

Once τtrans has been obtained from equation 2.5, the diffusion coefficient, Dn, can be

obtained from
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Dn =
d2

τtrans
, (2.6)

where d is the thickness of the TiO2 layer.

In addition to the consideration of the photovoltage rise, its decay can give τn, the

conduction band electron lifetime. These two quantities can be combined to define the

electron diffusion length, Ln [2, 21],

Ln =
√

Dnτn. (2.7)

This is an important parameter because the longer the diffusion length, the greater the

chance of electron extraction before recombination. Ultimately, Ln should be greater

than the width of the TiO2 layer, d, so that all photgenerated carriers can contribute

to the photocurrent. It is therefore the goal of this work to simulate the quantities

τtrans and τrise numerically.

2.3 Modelling electrons in dye-sensitised solar cells

The numerical scheme to simulate τtrans and τrise at open circuit in a DSSC is now

described.

2.3.1 Bulk transport and trapping in the DSSC

As noted earlier, the electric field in DSSCs is largely screened so that the transport

of conduction band electrons can be described by a trap-limited diffusion equation

[58, 61]. The multiple trapping model is applied which solves for the densities of

conduction band, nc, and trapped electrons, nt in the TiO2,

∂nc

∂t
= D0

∂2nc

∂x2
+ αI0 exp (−αx)− kcb0 (nc − nc,eq)−

∂nt

∂t
, (2.8)

∂nt

∂t
= Nt,0

〈

∂f

∂t

〉

= 〈ktnc (1− f)− kdNt,0f〉 . (2.9)
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D0 is the bare diffusion coefficient (if trapping were absent), α the absorption coefficient,

I0 the illumination intensity, kcb0 is the rate constant for recombination of conduction

band equilibrium nc,dark is the equilibrium density of electrons in the dark, Nt,0 is the

total density of trap sites, f is the trap occupation probability, kt is the rate constant

for trapping and kd is the rate for detrapping. In the case where ∂nc

∂t = 0, ∂nt

∂t = 0 also

and therefore traps make no contribution to the device behaviour.

It is crucial to note that kd is not a constant, but depends on the trap depth because

there is a distribution of electron traps in a DSSC [21]. This distribution decays

exponentially into the bandgap as shown in figure 2.3 and can be described by the

equation,

g(ET ) =
Nt,0β

kBT
exp

(

−β (EC − ET )

kBT

)

, (2.10)

where the factor β represents the rate at which the trap distribution falls off into the

bandgap [61]. The triangular brackets in equation 2.9 represent the averaging over

the trap distribution, equation 2.10. The implementation of these equations for the

modelling of the DSSC is non-trivial since the coupled system of equations (equations

2.8 and 2.9) amounts to a system of integro-differential equations which needs manip-

ulating before it can be solved using the COMSOL software package used throughout

this work. This is because, for a generic variable, ν,

〈ν〉 =
∫ EC

EF n,eq

dET g(ET )ν(ET ), (2.11)

where EFn,eq is the equilibrium Fermi level of the redox solution and EC is the conduc-

tion band level in the TiO2. The solution to this problem is considered in Appendix

C.

2.3.2 Boundary conditions for electron transport time

Firstly, the boundary conditions for calculating the transport time of conduction band

electrons is considered. The boundary conditions for extraction of charge for the DSSC

are simpler in form than those used for the metal-organic interfaces as considered

previously. This is because of the absence of electric fields in the discussion so that,

for example, the Schottky effect does not require consideration. The interface between

the TiO2 and the electrolyte at the counter electrode is insulating for conduction band
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Figure 2.3: Graphical illustration of the trap distribution, g(ET ) showing that there
are exponentially more traps near the conduction band, that is, more shallow traps.
The top horizontal line represents the conduction band and the bottom horizontal line
is the equilibrium Fermi level, EFn,eq.

electrons so that ∂nc

∂x = 0. At the anode, x = 0, the excess conduction band electrons

are extracted at a rate, kext, so that

j(t) = eD0
∂nc(x, t)

∂x

∣

∣

∣

∣

x=0

= ekext

(

nc(0, t)− nc,eq exp

(

eVoc

kBT

))

, (2.12)

where the first equality is Fick’s law and nc,eq exp
(

eVoc

kBT

)

is the conduction band electron

density at open circuit, that is, before the laser pulse.

2.3.3 Boundary conditions for photovoltage rise times

For the case of calculating photovoltage rise times, equation 2.12 needs to be modified

because only a small fraction of the excess photogenerated charge need to be extracted.

This is because the substrate capacitance is significantly lower than the bulk capaci-

tance of the TiO2 due to the high density of traps [60]. However, when the photovoltage

rise time is considered, a way of telling the simulation’s clock to stop running when

enough charge has been extracted to charge the substrate capacitance is required.

Equation 2.12 can be thought of consisting of an extraction component ekextnc(0, t)
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and an injected component −ekextnc,eq exp
(

eVoc

kBT

)

. Since electrons are flowing into

the substrate, the voltage across it will rise by an factor equal to Boltzmann factor

exp
(

eUph(t)
kBT

)

, where Uph(t) is the photovoltage rise in the substrate, given by equation

2.3.

The boundary condition for calculation of the photovoltage rise time is therefore writ-

ten,

j(t) = ekext

(

nc(0, t)− nc,eq exp

(

eVoc

kBT

)

exp

(

eUph(t)

kBT

))

. (2.13)

The premise of this modified boundary condition is that the current will go to zero

when the substrate photovoltage has increased by the same amount as in the bulk

TiO2. The rise in the TiO2 photovoltage is assumed to take place instantaneously,

which is manifested in the rise in nc(0, t). Equation 2.13 assumes that the density of

conduction band electrons, nc(0, t), in the TiO2 does not change when the electrons

are extracted into the substrate. Compared to the situation before the pulse, the value

of nc(0, t) is assumed to be raised by a factor

exp

(

eVpulse

kBT

)

. (2.14)

In equation 2.14, Vpulse is the height of the photovoltage rise in the TiO2 and therefore,

nc(0, t) = nc,eq exp

(

e (Voc + Vpulse)

kBT

)

. (2.15)

The fact that the density at the anode will decrease as charge is extracted will tend to

reduce the rise time below the diffusion limit.

The essential difference between equation 2.13 (for the photovoltage rise time) and

equation 2.12 (for the electron transport time) is that the background by which the

excess charge is measured is changing in the former case.

30



2.3.4 The quasi-static approximation

As described in section 2.3.1, the densities of trapped (nt) and conduction band (nc)

electrons can be described by coupled differential equations. However, if the character-

istic timescales of trapping and detrapping are significantly faster than other competing

effects (diffusion, recombination etc.) then the effects of the electron traps can be ab-

sorbed into a single continuity equation for nc but with an effective diffusion coefficient,

Dn, and an effective conduction band lifetime, kcbn, which is the inverse of the recom-

bination rate [59, 61]. The fundamental equation of the quasi-static approximation

describes the relation between the rates of change of nc and nt, and assumes they are

proportional to one another,

∂nt

∂t
=
∂nt

∂nc

∂nc

∂t
. (2.16)

The proportionality function ∂nc

∂nt
is independent of time and will be derived later.

Equation 2.16 implies that even when the DSSC is not in equilibrium (that is, a current

flows), the trapped and conduction band electrons are in equilibrium with each other

[59]. This definition is analogous to that of the quasi-Fermi level, where electrons are

in thermal equilibrium with the underlying semiconductor structure but are not in

thermal equilibrium with the holes [21]. Considering equations 2.8 and 2.9, it can be

shown that

∂nc

∂t
= Dn

∂2nc

∂x2
− kcbn (nc − nc,eq) , (2.17)

with

Dn =
D0

1 + ∂nt

∂nc

, (2.18)

and

kcbn =
kcb0

1 + ∂nt

∂nc

. (2.19)

The problem is therefore reduced to the solution of a single diffusion equation with
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an effective diffusion coefficient and conduction band lifetime [59, 61]. An expression

for the function ∂nt

∂nc
is still required however. In steady state, ∂

∂t = 0, the solution to

equation 2.9 gives

f(ET ) =
1

1 + exp
{

(ET−EF )
kBT

} ≈ θ (EF − ET ) , (2.20)

where θ = 1 below the Fermi level and zero otherwise and the final relation is true if

kBT ≪ |ET − EF | . (2.21)

Using equation 2.11 for the variable f and the approximation in equation 2.21,

nt = Nt,0f = Nt,0

∫ EC

EF n,eq

dET g(ET )f(ET ) ≈ Nt,0

∫ EF n

EF n,eq

dET g(ET ). (2.22)

Now, using equation 2.10 for the trap distribution g(ET ),

nt ≈ Nt,0
β

kBT

∫ EF n

EF n,eq

dET exp

[

−β (EC − ET )

kBT

]

(2.23)

= Nt,0

(

exp

[

−β (EC − EFn)

kBT

]

− exp

[

−β (EC − EFn,eq)

kBT

])

(2.24)

=
Nt,0

Nβ
C

(

nβ
c − nβ

c,eq

)

. (2.25)

Therefore,

∂nt

∂nc
=
βNt,0

Nβ
C

nβ−1
c =

Nt,0β

NC

(

nc

NC

)β−1

, (2.26)

which is the desired expression.

32



2.3.5 Analytical model for τrise and τtrans

A simple analytical model for calculation of τrise and τtrans has been developed [62].

Experimentally, it has been found that the transport time of photogenerated electrons

is equal to

τtrans =
d2

2.8Dn
, (2.27)

where d is the thickness of the TiO2 layer (typically 4-10µm) and Dn is the diffusion

coefficient of conduction band electrons. The factor of 2.8 is an empirical factor deter-

mined experimentally and takes account of the non-uniform illumination profile in the

devices [62].

The capacitance per unit area of the TiO2 is due to the traps with the distribution

described by equation 2.10 and is given by,

CT iO2 = e2dg(Voc), (2.28)

which assumes that all the traps up to Voc are filled and those above it are empty. The

transport time is the product of the transport resistance of the TiO2, Rtrans, and its

capacitance, CT iO2
[60] so that using equations 2.27 and 2.28,

Rtrans =
d2

2.8DnCT iO2

=
d

2.8Dne2g(Voc)
. (2.29)

Equation 2.29 can now be used to calculate the rise time of the photovoltage from

equation 2.4

τrise =
dCsub

2.8Dne2g(Voc)
. (2.30)

Equations 2.27 and 2.30 are the diffusion limited transport time and rise time respec-

tively. These correspond to an infinite extraction rate, kext, at the TiO2/substrate

interface so that the limiting factor is the diffusion of conduction band electrons to

the electrode. For comparison with the numerical modelling of these quantities, it

is necessary to introduce the definition of the conduction band diffusion coefficient,
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Dn as it appears in equations 2.27, 2.29 and 2.30. For this purpose the quasi-static

approximation is used throughout and Dn is given by equation 2.18.

2.3.6 Modelling of the laser illumination

In equation 2.8 only the steady state illumination is considered. In order to take account

of the 8ns pulse, it must be modified thus,

∂nc

∂t
= D0

∂2nc

∂x2
+ α (I0 + [θ (t)− θ (t− τpulse)] δI0) exp (−αx)

−kcb0 (nc − nc,eq)−
∂nt

∂t
, (2.31)

where δI0 represents the additional pulse intensity and [θ (t)− θ (t− τpulse)] is equal

to 1 for 0 < t < τpulse and zero otherwise. The simulation begins at t = 0, which is

defined as the beginning of the pulse.

The calculation of the parameter δI0 is now considered. The capacitance of the TiO2

is significantly higher than that of the substrate, it is therefore a good approximation

to assume that the photovoltage rise is due to the increase in the density of trapped

electrons alone. If the photovoltage is to be raised by an amount ∆Uph=5mV, say.

the number of electrons per unit area, N , which must be supplied to raise the TiO2

photovoltage by ∆Uph is given by,

N =
CT iO2

∆Uph

e
=
e2dg (Voc)∆Uph

e
. (2.32)

Now assuming that these electrons are created by the absorption of photons from a

pulse of intensity δI0, then the number of generated electrons per cubic metre, G(x),

will be

G(x) = αδI0 exp (−αx) , (2.33)

which has the units of m−3s−1, so this is multiplied by the pulse length, τpulse to find

the number of absorbed photons per unit volume. Integrating between x = 0 and x = d

yields,
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N = τpulse

∫ d

0
αδI0 exp (−αx) dx = τpulseδI0 (1− exp (−αd)) . (2.34)

Comparing equations 2.32 and 2.34,

δI0 =
edg(Voc)∆Uph

τpulse (1− exp (−αd)) . (2.35)

The parameter in the numerical model which controls the photovoltage is the illumina-

tion intensity I0. So if a simulation at a photovoltage of 0.5V is needed, the intensity

(in number of photons per unit area per unit time) needs to be calculated. This is

achieved by using the equation [63],

nc(x = 0, t) = nc,eq exp

(

eVoc

kBT

)

=
I0α

D0 (γ2 − α2)
(A+ +A− + 1). (2.36)

In equation 2.36, the variables are given by

A+ =
{[kext + γD0]α exp (−αd)− [kext + αD0] γ exp (−γd)}

γ {kext [exp (γd) + exp (−γd)] + γD0 [exp (γd) + exp (−γd)]} (2.37)

A− =
{− [kext − γD0]α exp (−αd)− [kext + αD0] γ exp (γd)}

γ {kext [exp (γd) + exp (−γd)] + γD0 [exp (γd) + exp (−γd)]} (2.38)

γ =

√

kcb0

D0
, (2.39)

where kext=0 at open circuit. Therefore

I0 =
nc,eq exp

(

eVoc

kBT

)

D0

(

γ2 − α2
)

α(A+ +A− + 1)
, (2.40)

where Voc is set equal to the photovoltage, which is 0.5V in this case.
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Voc(V ) 0.4

Nt,0 (m−3) 2× 1025 [62]

β 0.2 [62]

D0 (m2s−1) 2× 10−5 [61]

kcb0 (s−1) 104 [61]

ktrap (s−1) 109 [63]

d(µm) 4 [62]

α(m−1) 3.2×104 [64]

Table 2.1: Simulation parameters for reproduction of the diffusion limited transport
times in a DSSC.

2.4 Results

2.4.1 Reproduction of diffusion limited transport times

In order to calculate the electron transport times, numerical simulations were performed

using the continuity equations for nc and nt in section 2.3.1, the extraction boundary

condition in section 2.3.2 and the description of the laser pulse give in section 2.3.6.

To ascertain whether this numerical model is giving physically realistic results it is

necessary to be able to reproduce data obtained using the simpler, diffusion limited

model given in section 2.3.5 above conditions of fast charge extraction. The transport

time is the time taken for 63%, (1 − 1
e = 0.63), of the photogenerated electrons to

be extracted. Therefore, the cumulative extracted charge from the numerical model is

plotted as a function of time and the calculated transport time is the time taken to

reach 63% of the maximum value. This can the be compared to the value obtained

from the diffusion limited model in section 2.3.5.

The values of the electron transport time obtained with the the numerical simula-

tions should approach those obtained by the diffusion limited model as kext approaches

104ms−1. This value was used in reference [58] and was chosen since it was found to

give diffusion limited results [62].

The parameters used for the simulations in this section are listed in in table 2.1 and

the values of the transport time for increasing kext are seen in figure 2.4, where the

dashed line is calculated using the diffusion limited model described in section 2.3.5.

Figure 2.4 shows that the numerical solution approximates the quasi-static model well

at values of kext above 104ms−1 as expected. The numerically calculated transport

times at high kext are within a factor of 2 of the diffusion limit, compared to a variation

in the transport time of a factor of roughly 1000 over the variation in kext in figure 2.4.

36



10
0

10
2

10
410

−2

10
−1

10
0

10
1

10
2

T
ra

ns
po

rt
 ti

m
e 

(s
)

k
ext

 (ms−1)

Figure 2.4: Transport times as a function of the extraction rate, kext, calculated using
the parameters given in table 2.1. The dashed line is the value from the diffusion
limited model.

This gives confidence that the numerical model is giving physically reasonable results

because the two models being compared are very different in nature. The simple,

quasi-static model assumed RC time constants for the calculation and the trapping is

taken into account by an effective diffusion coefficient. The numerical model however

explicitly considers trapping as well as the pulse itself, which is entirely absent from

the quasi-static model.

The dependence of τtrans on Voc has also been considered and it is expected that as

Voc increases, the rise time will decrease as has been reported experimentally [60].

This is because at higher photovoltages, the deeper traps become filled and so are

not involved in trapping. Since the detrapping rate is exponentially dependent on the

trap depth, the average time spent in traps will decrease and the effective diffusion

coefficient will increase, which is encapsulated in the quasi-static model detailed above.

Additionally, at high values of the open circuit voltage, the diffusion limited transport

time is expected to saturate because the effective diffusion coefficient approaches its

value in the absence of trapping, D0. This is anticipated to occur at open circuit

voltages approaching 1V where the Fermi level in TiO2 becomes close to the conduction

band. Values of the diffusion limited transport time are given in figure 2.5 and show

firstly that the model reproduces the expected transport times well at each value of Voc

and secondly that the transport time saturates when the diffusion coefficient approaches

its bare value, D0, as expected for values of Voc near 1V.
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Figure 2.5: Diffusion limited transport times as a function of open circuit voltage,
calculated using the parameters given in table 2.1 (−©) and those calculated from the
diffusion limited model (− −�). The dotted-dashed line is the value calculated when
the diffusion coefficient is equal to the bare value D0 in the diffusion limited model.

2.4.2 Reproduction of diffusion limited photovoltage rise times

As in the previous section, the behaviour of the photovoltage rise time is now considered

as a function of the rate of extraction of conduction band electrons, kext. The situation

is complicated in this case by the fact that only a fraction Csub

CTiO2

of the charge is to

be extracted. This is because the substrate capacitance is considerably smaller than

the TiO2 capacitance and therefore not all of the photogenerated charge in the TiO2

is needed to equalise the Fermi levels and hence reestablish equilibrium.

Again, numerical simulations were performed using the continuity equations for nc and

nt in section 2.3.1 and the description of the laser pulse give in section 2.3.6. However,

now the boundary condition used is different and the form given in section 2.3.3 is used.

In the previous section, the transport time was calculated as the time taken to extract

63% of the charge in the device. Now however, the current in the numerical model

will go to zero before all the charge has been extracted. In both cases, the extracted

current goes to zero at long times, and therefore the rise time can be found using the

same formalism as for the electron transport time. This is valid in the case of the rise

time because the photovoltage in the substrate is proportional to the amount of charge

extracted, from equation 2.3. Figure 2.6 shows the rise times obtained, again using the

parameters in table 2.1.

As opposed to the data in figure 2.4, the diffusion limit is underestimated by more than

a factor of 103 in this case. One possible reason for this considerable underestimation

of τrise is that some of the photogenerated charges are extracted before they can be
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Figure 2.6: Rise times calculated using the parameters given in table 2.1. The dashed
line is the value from the diffusion limited model.

trapped so that they cannot be described by the quasi-static approximation, which the

diffusion limited model uses as its basis. It is worth noting here that the data in figure

2.6 do show saturation of the rise time at high values of kext, which can be interpreted

as the transport becoming diffusion limited. However, this is not the same as the quasi-

static diffusion limit, indicated by the horizontal line in figure 2.6. Simulations were

therefore performed for increasing values of the trapping rate ktrap to see how high the

trapping rate needs to be for the quasi-static diffusion limit to be reproduced, or even

if this is possible with this method. For these simulations, a value of kext = 104ms−1

was used because this was found to be high enough for the rise time to saturate for

ktrap = 109s−1 as seen in figure 2.6.

Figure 2.7 shows the diffusion limited rise time as a function of the trapping rate,

ktrap and shows that, as expected, the rise time increases as ktrap is increased. Unex-

pectedly however, the rise time obtained as ktrap tends to infinity is still significantly

underestimating the value expected for the quasi-static diffusion limit. This is a clear

indication that the simulation method is an incomplete description of the physics be-

cause it is known experimentally that the photovoltage transients in cells of this kind

are diffusion limited [60]. It has already been shown that the assumptions underlying

the quasi-static approximation hold for calculation of the transport time in DSSCs.

It is therefore of interest to examine the further assumption implicit in the modified

Schottky boundary condition used for calculation of the rise time.

The conduction band electron profile in the device for high values of ktrap and kext

is therefore considered; specifically the density near the extracting electrode. The

boundary condition used for the calculation of rise times is given in equation 2.13. As

mentioned above, this equation assumes that the photovoltage will go to zero when
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Figure 2.7: Rise times calculated using the parameters given in table 2.1, but with
increasing ktrap and kext = 104ms−1. The dashed line is the value from the diffusion
limited model.

enough charge has been extracted for the substrate voltage to be raised by, say, 5mV.

The crucial assumption implicit in equation 2.13 however is that the density of con-

duction band charges is equal to nc,eq exp

(

e(Voc+Vpulse)
kBT

)

immediately after the pulse

and does not decrease. The rise time in this case is then the time it takes for the quasi-

Fermi level in the substrate to rise up to the level in the TiO2. Figure 2.8 shows the

densities of interest at the extracting electrode for ktrap=1013s−1 and kext = 104ms−1.

These parameters were chosen so that the rise time was maximal, as can be seen from

inspection of figure 2.7.

There are two noteworthy aspects of this figure. Firstly, the density of conduction band

electrons rises above that expected from the simple, quasi-static analysis (by roughly an

order of magnitude), which predicts that the density increases by a factor exp
(

eVpulse

kBT

)

compared to that before the pulse, nc,eq exp
(

eVoc

kBT

)

. This is particularly interesting

since a very high value of ktrap has been used for illustrative purposes. This value is

considerably higher than used previously in continuum modelling of DSSCs (∼107s−1)

[58] and even greater still than a very high value recently reported of ∼1012s−1 [65]. The

fact that the density increases to a value higher than expected from the simple analysis

means that the electrons will be diffusing faster than if they were held at the level

indicated by the dotted-dashed line in figure 2.8. However, this has already been shown

to be a minor effect because the transport time would be equally affected. Secondly,

the conduction band electron density decreases significantly below that expected from

the diffusion limited model. This is because the high value of the charge extraction rate

kext pulls the density down at the anode meaning that less charge has to be collected for

the current to go to zero. This is clear evidence that the assumption in the boundary

condition for the extraction of electrons is breaking down and causing the rise time to
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Figure 2.8: Relevant densities for the parameters in table 2.1 with ktrap=1013s−1

and kext = 104ms−1. The quantities are the conduction band density (−), the den-

sity at the anode at t = 0, nc,eq exp
(

eVoc

kBT

)

(· · ·) and the density expected from

nc,eq exp

(

e(Voc+Vpulse)
kBT

)

(−·).

be too fast.

Figure 2.9 shows a schematic of nc near the extracting electrode. Because the the value

of nc(0, t) is being pulled down at the interface (as is clear from from 2.8) the current

goes to zero before the density in the substrate can be raised by the factor exp
(

eVoc

kBT

)

and the rise time is reduced below that expected from the quasi-static model.

For further proof that the fast rise time is not a numerical effect, the magnitude of

the photovoltage rise was studied. The diffusion limited model expects that the pho-

tovoltage rise height of the substrate will be the same as that in the TiO2, i.e., 5mV.

The results of these simulations are shown in the figure 2.10, which are for the same

simulations as shown in figure 2.7.

Figure 2.10 shows that the height of the photovoltage rise saturates at ∼2.5mV. In the

simulations, the parameter δI0 is engineered deliberately to raise the internal voltage of

the TiO2 by 5mV. Therefore, the extracted current is going to zero before the ‘correct’

amount of charge has been extracted. This is therefore further proof that the faster

rise time than expected is a real effect and that the model as it stands does not contain

all the physics required to reproduce the experimentally observed diffusion limited rise

times.

Another indication that the model as described above is somewhat incomplete is that,

experimentally, the photovoltage transients are ‘well behaved’ when they approach their
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Figure 2.9: Illustration of the excess conduction band electron density, δnc, at the ex-

tracting electrode of a DSSC. The solid horizontal line represents the factor exp
(

eVoc

kBT

)

and the boundary condition, equation 2.13 assumes that the current will stop flowing
when enough electrons have flowed into the substrate to raise the density there by the
same factor. The arrows indicate advancing time and show the increasing density in
the substrate and the decreasing value of nc(0, t).

maximum and then decrease due to recombination. An example experimental trace can

be seen in figure 2.11 and shows a maximum at approximately 5µs after a fast rise,

followed by a slower fall, determined by the decay of the extra photogenerated charges

above the background illumination level.

Figure 2.11 shows that the current into the substrate of the solar cell goes smoothly to

zero when the substrate capacitance has been charged to a level where its Fermi level

reaches that of the illuminated TiO2. However, in the simulation results that have been

presented so far this is not the case. For example, figure 2.12 shows a photocurrent

transient for the parameters in table 2.1 and kext = 104s−1, which makes it clear that

the boundary condition as implemented thus far does not allow for smooth transition

when the substrate capacitance becomes charged up to that in the TiO2.

The factors considered above indicate that the successful simulation of the photovoltage

decay cannot be simulated using the precise methodology presented above.
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Figure 2.10: The photovoltage heights for the same data considered in figure 2.7.

2.4.3 Space charge effects in nanocrystalline TiO2 electrodes

It has recently been reported that there may be a barrier for the extraction of electrons

[66] at the substrate in DSSCs. Additionally, references [67] and [68] have explored the

effects of non-negligible electric fields, which have been neglected so far in this work.

These references show that for a complete description of the performance of the DSSC,

the effect of the electrostatic potential in terms of band bending and band offsets cannot

be completely ignored. However, it should be noted that for almost all situations of

interest, the field-free model has been shown to correctly reproduce experimental data

[58, 61].

Throughout the preceeding discussions of the DSSC, it has been assumed that electric

fields are negligible and that electron transport in the device is purely diffusive. The

possible influence of an electric field internal to the TiO2 grains in the solar cell is

now considered. The grains can be well approximated by spheres of radius ∼20nm and

dielectric constant, ǫr = 30 and it will be assumed in this discussion that they contain

1024 donor centres per cubic metre, corresponding to ionised oxygen atoms. In an

isolated, doped TiO2 grain, the Fermi level is just below the conduction band [21] and

that of the electrolyte redox couple is approximately 1eV below the same conduction

band level [21, 58, 61]. In order to maintain electrochemical equilibrium (i.e., Fermi

level continuity) electrons will be transferred to the electrolyte when the TiO2 grain is

placed into the electrolyte. Due to the presence of the oxygen, this flux will give rise to

an uncompensated positive space charge on the grain. Assuming that all of the excess

electrons have left the grain, the net charge density in the TiO2 will simply be equal

to the number of donor atoms, Nd.

Solving the Poisson equation analytically will give a feel for the possible band-bending
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Figure 2.11: Experimental photovoltage transient for a DSSC illuminated with an 8ns
pulse at Voc=566mV.

in the TiO2, which will be further examined later [69, 21]. Inside the sphere (of radius

R) the Poisson equation can be written using spherical polar coordinates. Assuming

spherical symmetry, only the radial component of the Poisson equation needs to be

considered,

∇2ψ =
∂2ψ

∂r2
+

2

r

∂ψ

∂r
=
−ρ
ǫ0ǫr

=
−eNd

ǫ0ǫr
, (2.41)

where ρ is the charge density and the first equality follows from the expression of ∇2

in spherical polar coordinates. Outside the sphere where ρ = 0,

∂2ψ

∂r2
+

2

r

∂ψ

∂r
= 0. (2.42)

This has the general solution

ψ =
a

r
+ b, (2.43)

where a and b are constants. The constant b can be set to zero because the position

of the ground (where the potential is zero) does not affect the outcome of the electric

field calculation and so the zero of potential is set at infinity. Far from the sphere of

charge, the sphere will appear as a point charge and therefore
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Figure 2.12: Simulated photocurrent transient for a DSSC illumination with an 8ns
pulse, the parameters in table 2.1 and kext = 104s−1.

a =
Q

4πǫ0ǫr
, (2.44)

which yields

ψ =
Q

4πǫ0ǫrr
, (2.45)

which is the standard result for the Coulomb potential of a point charge, Q, where

Q =
4

3
πR3ρ. (2.46)

Inside the grain, there is a constant term on the left hand side of the Poisson equation,

equation 2.41. Solving this equation and equating ψ at the surface of the grain (r = R)

gives

ψ =
ρ

6ǫ0ǫr

(

R2 − r2
)

+
ρR2

3ǫ0ǫr
=

eNd

6ǫ0ǫr

(

R2 − r2
)

+
eNdR

2

3ǫ0ǫr
. (2.47)

Substitution of the parameters given above gives a difference in the potential of 40mV

between the centre and the outer edge of the sphere. Since the potential varies as
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Figure 2.13: Illustration of the electron potential energy (in meV) in an ensemble of
20nm TiO2 particles for the parameters discussed above.

ψ ∼ −r2, the electron potential energy will vary as +r2 and conduction electrons will

tend to be drawn away from the surface of the grains where recombination with tri-

iodide molecules occurs. This could have important implications for DSSCs where the

grains are large and/or where the doping density is high. This is because the potential

difference between the centre and edge of the particles increases proportionately with

these quantities. Figure 2.13 shows an example for an ensemble of TiO2 grains for

the same parameters given above. A lattice of low potential energy pathways can be

seen in this figure, which may help funnel the conduction electrons to the anode where

they can be extracted with a lower recombination probability. This effect may help to

explain recent findings in the literature that electron diffusion lengths in DSSCs may

be significantly longer than previously thought [70].

Due to the complicated structure of the TiO2 matrix, some simplification is often

required in the process of simulation. For example, reference [68] considers a columnar,

cylindrical geometry to represent the TiO2 particles in contact with the substrate.

This is done to enable calculation of the dark electric potential profile and hence the

resultant electric field. These calculations are included here since the value of the

dielectric constant used in reference [68] is ǫr,rutile ≈ 130; that of rutile TiO2. However,

the polymorph of TiO2 used in the DSSC of interest here is the anatase form, which

has ǫr,anatase ≈ 30.
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For illustrative purposes, the effect of changing the values of the doping density and the

dielectric constant is examined with respect to the results in reference [68]. Dirichlet

boundary conditions are used at all boundaries in reference [68] and identical conditions

are used here. Specifically, at the substrate (junction) side,

ψj = −5kBT

e
(2.48)

and at the other surfaces,

ψs = −15kBT

e
. (2.49)

Firstly, the effect of the dielectric constant on a column of radius 20nm and length

200nm is considered. An exact comparison with reference [68] is precluded here because

the radius of column therein is set equal to the Debye length, LD,

LD =

√

ǫ0ǫrkBT

Nde2
. (2.50)

Here, Nd is the doping density inside the column and the number of free electrons

is assumed to be negligible. Therefore, if the doping density or dielectric constant is

changed, the resulting radius of the column is changed also, and there is no net effect

on ψ. Figure 2.14 shows the distribution of electric potential along the axis of cylinder

for different values of the doping density and dielectric constant.

All values of Nd and ǫr give similar shapes in the electric potential profile. The param-

eters originally considered in reference [68] are represented in figure 2.14 by the dotted

line. Using this result as the basis for comparison, it can be seen that changing the

dielectric constant to that of anatase TiO2 has very little effect on the potential profile

in the device apart from giving a slightly higher bulk value.

A marginally greater effect on the potential can be seen than that considered above

when the doping density is increased by a factor of 10 to 1024m−3 and ǫr,rutile is used.

This is because the order of magnitude increase in Nd gives a relatively larger change

in the source term of the Poisson equation than the relative change in ǫr (130/30≈4)

considered above.

The most striking effect occurs when the dielectric constant is decreased and the doping
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Figure 2.14: Electric potential along the cylindrical axis for Nd=1023m−3, ǫr,anatase

(−), Nd=1023m−3, ǫr,rutile (··), Nd=1024m−3, ǫr,anatase (· − ·), Nd=1024m−3, ǫr,rutile

(−−). The radius of the cylinder is 20nm.

density is increased. These both act to exacerbate the rate of change of band curvature,

as given by the Poisson equation. Most interesting of all however is the appearance of a

significant band bending at the counter electrode (right hand side) of the device. This

may act to aid collection of electrons generated far from the extracting electrode at the

left hand side of the device. This is because the resultant electric field at the counter

electrode is such that it will sweep electrons towards the extracting electrode. This

effect is well-known in the field of inorganic solar cells and is called a ‘back surface field’

[2]. This assertion that a high doping density may act to improve device performance

is in agreement with the result obtained above, which saw that low potential energy

pathways through the centre of the quasi-spherical TiO2 could be created by increasing

the value of Nd. In addition, this section shows that for a correct consideration of the

photovoltage rise time in a DSSC the band structure at the extracting electrode must

be considered.

2.5 Conclusions and further work

The transport time in a DSSC at open circuit has been successfully shown to obey

the diffusion limit given by the quasi-static approximation under the conditions of

fast extraction. However, the reproduction of the photovoltage rise time was not so

favourable. This has been attributed to the neglection of band bending effects and

to the breakdown of an implicit assumption in the boundary condition for charge ex-

traction. Electrostatic effects are frequently ignored in the literature, however, it has

48



been shown here that electric fields may be beneficial to device performance in two

ways. Firstly, the quasi-spherical nature of the TiO2 matrix could mean that electrons

are kept away from the grain surface, thus reducing recombination and increasing Ln.

Secondly, high doping densities may set up a ‘back surface field’ in the device, causing

electrons generated near the counter electrode to be more efficiently collected at the

extracting electrode. These effects may support recent results showing that electron

diffusion lengths in DSSCs may be significantly longer than previously reported.
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Part II: Organic solar cells and

OLEDs
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Chapter 3

Simulation of ideal morphology

polymer solar cells

Much research has taken place in recent decades on organic solar cells with bulk het-

erojunction morphologies. However, recent work has shown that the most effective

geometry at harvesting sunlight is formed from interpenetrating fingers of donor and

acceptor materials [33], which will be termed an ideal morphology throughout this

work. This type of geometry has also been documented for hybrid inorganic-organic

devices made from conjugated polymers and inorganic materials such as TiO2 [32].

This chapter presents time-independent simulations of these devices where the two ac-

tive phases are both polymeric in nature. Particular attention is paid to the influence

of the intermediate polaron pair charge-transfer state on device performance as well as

the effect of space charge on the open circuit voltage.

3.1 π-conjugated organic polymers

Figure 3.1 shows some commonly used organic polymers. Technically, a conjugated

organic polymer is a carbon-containing long chain molecule where there is alternation

between single and multiple (often double) carbon-carbon bonds [3]. It consists of many

repeat units where the unit cell is known as a monomer. It is of interest to consider

the electronic structure of an isolated carbon atom before considering the solid state.

The atomic state of carbon, isolated from any other outside influence is 1s22s22p2.

However, the energy of an ensemble of carbon atoms can be lowered if the electronic

configuration is altered from this state. This fundamental principle is the basis of the

chemical bond [71].
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Figure 3.1: Some examples of chemical structures of conjugated polymer materials,
from [3].

52



Figure 3.2: The evolution of the bandstructure of organic materials, from the isolated
atomic picture on the left to the solid state on the right, adapted from [12].

Now consider the promotion of an electron from the filled 2s shell, giving 1s22s2p3. This

change of electronic structure requires about 6eV of energy. The formation of covalent

bonds between neighbouring carbon atoms, however, reduces the energy by more than

6eV, thus making this latter structure energetically favourable. In his lectures on this

subject [24], Alan Heeger notes that a key realisation in the development of conjugated

polymers was that the resulting electronic structure of polyacetylene - the simplest

conjugated polymer - is similar to that of a semiconductor. This fundamental structure

consists of extended conduction and valence bands separated by a bandgap. There is

now one unfilled s orbital and three filled p orbitals. These states can now form

hybridised structures [12]. Three covalent bonds are formed from the three hybridised

sp2 orbitals with the two carbon atoms on either side of the atom in question, and one

with another atom or chemical moiety. These bonds (the σ bonds) give the materials

their structural stability. There is now one valence electron left per atom, and these

electrons form a delocalised pz orbital band, known as a π-band, when many atoms are

in close proximity and this is illustrated in figure 3.2. Optoelectronic transitions can

now be made between the highest occupied molecular orbital (HOMO), or π orbital to

the lowest unoccupied molecular orbital (LUMO), or π∗ band [3]. The analogy with

standard semiconductor conduction and valence bands is clear from figure 3.2.

Optical excitations between π electron states are structurally stable since the σ bonds

are unaffected. Indeed, if an electron were excited between the σ bands then the

material would degrade and become a photoresist since the structural backbone of the

polymer would come apart [24]. For polyacetylene, virtually all photoexcitations are

within the π bandstructure because the σ-σ∗ splitting is ∼10eV.
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The device characteristics upon which this work is based involve the solution of partial

differential equations. These involve the transport of electrons, holes and excitons, the

injection of electrons and holes at the interface between the transport materials and

the metallic electrodes, generation and recombination of electrons and holes and the

interaction between charges resulting in a distribution of electric potential. All these

coupled equations are solved self-consistently.

3.2 Electrons and holes in organic semiconductors

Firstly, the transport of charge carriers in organic semiconductors is considered. The

standard form of the drift-diffusion equations, as used throughout the simulations of

organic devices herein are given by

Jn(p) = eµn(p)n(p)E + (−)eDn(p)∇n(p) (3.1)

for electrons (holes). Jn(p) is the electron (hole) current density, e is the magnitude

of the electron charge, µn(p) is the electron (hole) mobility, n(p) is the electron (hole)

density, E is the electric field in the device and Dn(p) is the electron (hole) diffusion

coefficient. The mobility and diffusion coefficient are connected via the Einstein relation

D

µ
=
kBT

e
, (3.2)

which is used throughout this work, although it has been shown that the diffusion

coefficient can be enhanced at high charge densities [72]. The electric field, E, is

related to the electric potential, ψ through

E = −∇ψ (3.3)

and the potential is found from the solution of the Poisson equation,

−∇2ψ =
e (p− n)

ǫ0ǫr
, (3.4)

where ǫ0ǫr is the product of the permittivity of free space and the dielectric constant.
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This combination of equations is very widely used in the literature [55, 73, 74, 75, 76, 77].

The short circuit boundary conditions on the Poisson equation used here are given by

ψ = −φBn, (3.5)

and in a multi-layer structure, the difference in the electron affinities must be taken

into account at opposite sides of the device. In equation 3.5, φBn is the barrier for

electron injection into the semiconductor and the boundary conditions on equation

3.1 are considered in detail in section 3.3. When a bias is applied to the device, the

potential boundary condition at one side needs to be altered to give,

ψ = −φBn ± Va, (3.6)

where Va is the value of the bias. The reason for the ± in equation 3.6 is that the

definition of ‘forward bias’ is poorly defined in the literature and it is often implied

that ‘forward bias’ and ‘positive bias’ are synonymous. This can be shown to be false

by noting that a positive bias on one side is equivalent to a negative bias at the opposite

side. The correct definition of forward bias is one that acts to oppose the built-in field

in the device. The quantity, Vbi is defined as the potential difference between the

electrodes at zero applied bias.

The electron and hole transport equations can also be used for the simulation of inor-

ganic devices [1] where disorder is small. However, in organic materials where disorder

is present [19], the mobility is parameterised by a form which depends on the electric

field,

µn(p) = µn(p)0 exp
(

γ
√
E
)

, (3.7)

where γ is a material dependent constant. This functional form has been derived by

considering the interactions of electrons and holes with permanent dipoles of random

position within the organic material [78].

The fundamental processes in the bulk of a semiconductor system are transport, re-

combination and generation and can be represented by the continuity equations,
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∂n(p)

∂t
= Gn(p) −Rn(p) + (−)

1

e
∇ · Jn(p), (3.8)

where the electron (hole) current, Jn(p) is given by equation 3.1 and Gn(p) and Rn(p)

are the electron (hole) generation and recombination rates [1].

3.3 Organic-metal interfaces

Firstly, the potential energy of an electron near a metal interface in the presence of

an image potential and an applied electric field, E, is considered. Throughout this

discussion, electrons will be considered. However, entirely analogous expressions exist

for holes. The potential near the interface is described by

ψ (x) = φBn − Ex−
e

16πǫ0ǫrx
, (3.9)

where x is the distance between the metal and the charge, φBn is the Schottky barrier

height [1] and the zero of potential is taken as the metal work function.

Figure 3.3(a) illustrates that the application of an externally applied field (of the correct

sign) will give a reduction in barrier height for charge injection. This barrier reduction

is given by differentiating the expression for the potential in equation 3.9. This gives

the distance, xM at which the potential is a maximum,

xM =

(

e

16πǫ0ǫrE

)1/2

. (3.10)

Substituting this into equation 3.9, gives the barrier height reduction for charge injec-

tion from the metal work function, ΦM , as a function of applied electric field, ∆φ−Bn,

∆φ−Bn =

(

eE

4πǫ0ǫr

)1/2

. (3.11)

Some care needs to be exercised when applying the Schottky lowering formula, since

equation 3.11 only applies for a certain sign of the electric field [77]. Considering an

electron at the interface given in equation 3.3, the Schottky effect only applies if the
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Figure 3.3: Schematic diagram of the potential energy of an electron near a metal
electrode for (a), when the Schottky effect is valid (and the barrier for injection is
lowered) and (b), for the opposite sign of the field (where the barrier height is increased).
The dotted lines show the potential energy due to a constant applied field, the solid
line shows the Coulomb potential (the last term in equation 3.9) and the dashed line
gives total potential. In (b) the −Ex term in equation 3.9 is replaced by +Ex. In both
cases the solid central horizontal line is the barrier height without the Schottky effect
or applied field.

energy of the particle decreases as it moves away from the interface [79]. This becomes

clearer if figure 3.4 is considered, which shows a single layer device band diagram

at different bias conditions. This lowering of energy as charges move away from the

electrodes corresponds to electrons drifting ‘downhill’ and holes drifting ‘uphill’ in

standard band diagrams, such as figure 3.4. This is because of the difference in sign of

the charge on an electron and a hole.

In band diagrams, the top line represents the conduction band, EC , or the lowest

unoccupied molecular orbital, LUMO, in organic materials. The bottom line is the

valence band, EV , or highest occupied molecular orbital, HOMO. These bands represent

the potential energy of carriers, that is

EC ∼ −ψ + constant (3.12)

and
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Figure 3.4: Band diagrams for a single layer organic device at (a) flat band, (b) short
circuit and (c) Va > Vbi, where the bands are tilted in the opposite direction to that
at short circuit. At each possible injection site, the letters Y and N indicate whether
or not Schottky lowering is appropriate. The case illustrated in (c) will be where the
Schottky lowering has the most pronounced effect on device performance since in this
case the barrier lowering is applicable to the smaller barrier at each electrode interface.

EV ∼ −ψ − Eg + constant. (3.13)

Eg is the bandgap of the material, and since no equations used in this work depend on

the value of the potential, ψ, only its gradient, the constant is set equal to zero without

any loss of generality.

3.3.1 The Scott-Malliaras formalism

To simulate the injection and extraction of electrons and holes at the electrodes the

model of Scott and Malliaras is used [80, 81]. This is a physically realistic model

based on the recombination of charges with their electrostatic images in the metallic

electrode. The flux of charges from organic to metal is calculated by considering that

the average charge which approaches the metal will recombine with its electrostatic

image in the metal if the binding energy exceeds the thermal energy, kBT . This occurs

at a distance,
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xC =
e2

16πǫ0ǫr
. (3.14)

In this work it is the behaviour away from equilibrium that is of interest and hence the

form of the injected and extracted currents at non-zero applied electric field is required.

In the regime where Schottky lowering is appropriate, it can be shown [80, 82] that

the current density across the metal-organic interface is given by the difference of the

current densities injected into, and extracted from the organic material, Jinj and Jrec,

Jn = A∗T 2 exp

(−eφBn

kBT

)

exp
(

√

f
)

− neS(E)

= Jinj − Jrec (3.15)

where

S(E) = S(0)
(

1/ψ(f)2 − f
)

/4 (3.16)

is the field-dependent recombination velocity and

S(0) =
16πǫ0ǫrk

2
BT

2µn

e3
, (3.17)

is the value at zero field. In equations 3.15 and 3.16, f is the so-called reduced field

[80, 81]

f =
e3E

4πǫ0ǫrk2
BT

2
(3.18)

and

ψ(f) = f−1 + f−1/2 − f−1
(

1 + 2f1/2
)1/2

. (3.19)

Equations 3.16 and 3.19 are derived in Appendix A. The standard theory for Schottky

barrier lowering is used in equation 3.15 and the injected current density is given by,
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Jinj = A∗T 2 exp

(

−e
(

φBn −∆φ−Bn

)

kBT

)

= A∗T 2 exp







−e
(

φBn −
√

eE
4πǫ0ǫr

)

kBT







= A∗T 2 exp

(−eφBn

kBT

)

exp

(√

e3E

4πǫ0ǫrk2
BT

2

)

= A∗T 2 exp

(−eφBn

kBT

)

exp
(

√

f
)

, (3.20)

where equation 3.11 has been used to define the Schottky barrier lowering.

Image force lowering of the thermionic emission barrier is only applicable at one par-

ticular sign of the field. The effect when the field changes sign has been considered in

reference [55] and this formalism is used here. The premise of the argument is that for

signs of the field where the Schottky effect is not valid, the binding energy between the

injected carrier and its image charge must be less than or equal to kBT for the injected

charge to escape recombination. This is shown in figure 3.3(b) where it can be seen that

there is no peak in the total potential profile. It is because of this lack of maximum in

the potential that the notion of escaping recombination is invoked since injection into

the potential profile in figure 3.3(b) will be more difficult for a finite applied bias [55].

The magnitude of the increase in barrier height, ∆φ+
Bn, is given by equation 3.21.

∆φ+
Bn =

e2E

16πǫ0ǫrkBT
, (3.21)

and so, since the recombination velocity takes its zero field value [55] in this regime,

Jn = A∗T 2 exp

(−eφBn

kBT

)

exp

(

−f
4

)

− neS(0)

= Jinj − Jrec. (3.22)

In equation 3.22, the injected component can be written in terms of f because,
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Jinj = A∗T 2 exp

(

−e
(

φBn + ∆φ+
Bn

)

kBT

)

= A∗T 2 exp





−e
(

φBn + e2E
16πǫ0ǫrkBT

)

kBT





= A∗T 2 exp

(−eφBn

kBT

)

exp

(

− e3E

16πǫ0ǫrk2
BT

2

)

= A∗T 2 exp

(−eφBn

kBT

)

exp

(

−f
4

)

. (3.23)

Equation 3.21 has been used here to define the increase in injection barrier height in

this regime.

3.4 Excitons in organic semiconductors

Next, the exciton population in organic devices is considered. Since excitons are charge

neutral, they move only by diffusion. The continuity equation [83] describing the

density of excitons is

∂S

∂t
= ∇ · (Dexc∇S)− S

τexc
+

Q

~ω
, (3.24)

where Sn(p) is the density of excitons in the acceptor (donor), Dexc is the exciton

diffusion coefficient, τexc is the exciton lifetime, Q is the energy dissipated by the

optical excitation per unit volume per unit time, ~ is Planck’s constant divided by 2π

and ω is the angular frequency of the light [84]. The exciton diffusion length, Lexc is

given by

Lexc =
√

Dexcτexc, (3.25)

and is the average distance an exciton diffuses before decaying. The excitons are

assumed to be perfectly quenched (separated) at the polymer-polymer interface and

the electrodes. At the electrodes, however, excitons will recombine non-radiatively and

will not give a contribution to the photocurrent [85]. Therefore, at the heterojunction

and at the electrode,
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S = 0. (3.26)

The dissociation of excitons at the interface between two polymers has been considered

in detail for a bilayer structure [55] and the same formalism is used here. It is assumed

that within 1nm of the interface, the excitons dissociate into a so-called polaron pair,

which straddles the junction but remains bound and immobile [86]. This polaron pair

can then either recombine back into an exciton with rate constant krec, or dissociate

with the electric field-dependent rate kdiss(E). Polaron pairs can also be formed from

recombination of free charges, so that the areal density (number per unit area) of

polaron pairs, X, at the interface can be described by

∂X

∂t
= GX − krecX − kdiss(E)X + FX . (3.27)

Here, GX is the polaron pair generation rate from exciton dissociation and FX is the

rate of formation from the capture of free charge [55]. FX is described by a Langevin-

like rate [87] using the smaller of the two majority carrier mobilities, µsmall, as has been

recently used to describe the behaviour of polymer-fullerene blends [88]. The width of

the charge generation region at the interface, h, is 1nm, and

FX =
nintpinthµsmalle

3ǫ0ǫr
, (3.28)

where n(p)int is the value of the electron (hole) density at the polymer-polymer inter-

face.

The reason for this dependence on the smaller of the two mobilities instead of the

original Langevin dependence on the sum is due to the majority carriers being confined

to the separate materials. Therefore, for recombination to occur, a charge sitting at the

interface has to wait for a charge of opposite sign to approach it before recombination

can occur. Hence the recombination is controlled by the smaller of the two mobilities.

Langevin recombination of electrons and holes is considered in each bulk material, but

it is found to be negligible compared with other processes as found previously [55]. In

the steady state, ∂X
∂t = 0 and therefore

X =
GX + FX

krec + kdiss(E)
, (3.29)
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where the form of GX is given by the flux of excitons at the interface [83, 89],

GX = Dexc |∇ (Sn + Sp)| . (3.30)

The coupling of electrons and holes with the excitons is now considered. Using equation

3.27, equation 3.8 is written as

∂n(p)

∂t
=
kdiss(E)X − FX

h
+ (−)

1

e
∇ · Jn(p), (3.31)

where the term in kdiss(E)X and FX account for polaron pair dissociation and forma-

tion from free charges respectively. Care needs to be exercised when considering the

coupling between the populations of excitons and free charges via polaron pair recom-

bination. This is because for each polaron pair which recombines only one exciton is

created, or, half an exciton in each polymer on average. Therefore equation 3.24 is

modified as

∂S

∂t
= ∇ · (Dexc∇S)− S

τexc
+
Q

hν
+
ηstkrecX

2h
. (3.32)

It is important here to consider the spin statistics inherent in the theory of molecular

photochemistry. When two spin 1
2 particles come together they can generate a singlet

or a triplet state and they are created in a ratio 1:3 [90]. The factor ηst in equation

3.32 accounts for this. Only singlet excitons can recombine radiatively [90] to give

luminescence and therefore, absorbed photons can only generate singlets. What this

means is that the model contains the population of singlet excitons only. Emission

from triplet states is possible and this is known as phosphorescence [91] but this occurs

on timescales of several orders of magnitude slower than luminescence in general. The

efficiency of luminescence limited LEDs is therefore limited to 25%, and hence ηst=0.25.

There has been recent interest, however, in enhancing this limit by using phosphorescent

emitters where the quantum yield can be enhanced above 25% [92].

Figure 3.5 illustrates the different mechanisms of capture and dissociation in this sys-

tem. The precise nomenclature in reference [73] has been altered in this figure to

emphasise the analogy with reference [55] since it is the latter formalism which is used

here. In fact the only significant difference between the two methods is in the calcu-

lation of the dissociation rate, kdiss. Reference [55] uses a formalism due to Jonscher

[93], which considers the dissociation over one hemisphere, or 2πSr, due to the distinct
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Figure 3.5: Schematic illustration of the different possible states after photon absorp-
tion in the donor (D) component of a bulk heterojunction solar cell. Adapted from
[73, 94].

material phases present in a bilayer device. However, in the bulk heterojunction case,

dissociation can occur over the full 4πSr sphere.

The dissociation rate considered in reference [73] is a modified version of that due to

Onsager to describe the recombination and dissociation of ions in solution [95, 96].

The original calculation [96] gave the fraction of pairs of oppositely charged ions which

recombine in the presence of an electric field assuming that the transport occurs by

Brownian motion [97, 96]. Braun [94] modified this theory to include a non-zero lifetime

of the charge transfer state [73]. This means that the intermediate state will not nec-

essarily recombine, should the distance between the pair vanish [94], but can generate

free carriers by dissociating with a field-dependent rate kdiss(E). The recombination

rate is field-independent in all models considered above [55, 73, 94, 95].

The rate of polaron pair dissociation at the heterojunction used here, kdiss(E) is given

by

kdiss(E) =
2kdiss(0)

M

[

exp [M ]

(

1− 1

M

)

+
1

M

]

, (3.33)

for E < 0 (the factor of 2 is absent in reference [55]), and by

kdiss(E) = kdiss(0)
4πǫ0ǫrk

2
BT

2

e3E

(

1− exp

( −e3E
4πǫ0ǫrk2

BT
2

))

(3.34)
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for E > 0, where

M =
e

kBT

√

−eE
πǫ0ǫr

. (3.35)

In equations 3.34 and 3.35, E is the average value of the x component of the electric

field at the interface. This will be discussed in more detail in section 3.7.

Figure 3.6 illustrates kdiss(E) and shows that polaron pair dissociation is reduced,

compared to zero field, for positive fields and increased for negative fields. Also in

figure 3.6 the dissociation rate for the Onsager formalism is shown [94, 95], kOnsager.

It can be seen that kOnsager < kdiss(E) for negative fields and that kOnsager is an even

function of the field. In the simulations presented here, excitons can only be dissociated

in one direction, i.e., electrons to the cathode (right) and holes to the anode (left).

Electrons (holes) drift to the right (left) in a negative field and therefore, dissociation

is enhanced when E < 0 [55]. In the case considered by Onsager however, the electrons

and holes can move in either direction after dissociation and therefore

kOnsager(E) = kOnsager(−E). (3.36)

The authors of reference [97] have considered a modified Onsager theory and have

shown that interfacial dissociation is increased relative to that in the bulk because the

charges are confined to their own material phases. Different functional forms for the

dissociation with positive and negative fields are not considered however.

3.5 Photons in organic semiconductors

The main difference between the physics of solar cells to that of OLEDs is that a net

generation of charge is necessary to obtain a photovoltaic effect and a net recombination

is needed for light emission. The initial photoexcited state in a conjugated polymer

is an exciton, so therefore it is necessary to simulate the incoming light in the solar

cell and the excitons themselves. Several authors have considered optical effects in

organic devices [84, 85, 98, 99] and used matrix methods based upon the fact that the

incident light can be considered to only consist of an optical electric field, the tangential

component of which is continuous at material interfaces. The essential input parameters

are the real (η) and imaginary (κ) parts of the complex, refractive index, ñ,
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Figure 3.6: The electric field dependence of the polaron pair dissociation rate as used
here (solid line) [55] and that due to Onsager (dashed line) [95]. Both forms have been
normalised to their values at zero field.

ñ = η + iκ, (3.37)

where i =
√
−1, and the wave equation of interest is that describing the optical electric

field in the direction of illumination, E~ω is

∇× (∇× E~ω)− ñ2k2
0E~ω = 0, (3.38)

where k0 is the free space wavenumber of the light [100].

The boundary conditions on this equation are that E~ω at the left hand side of the

device, E~ω,g (where the glass substrate meets the rest of the device), is calculated from

the reflectance at the interface of the outer glass layer, R∗, and that of the interface of

the glass with the rest of the device structure, R [98],

E~ω,g = E~ω,0
1−R∗

ηglass (1−RR∗)
, (3.39)

where E~ω,0 is the optical electric field outside the device. This is necessary because
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the millimetre thickness of the glass layer is much thicker than the distance over which

the light remains coherent. Because of this fact, at the interface between the glass and

the remainder of the device, the amplitudes of the waves must be summed instead of

the phases [84]. At the other side of the device, the electric field very quickly falls to

zero at the metallic back contact [84]. There is a boundary condition built-in to the

COMSOL software which enables calculation of this effect and requires the values

of the real and imaginary parts of the refractive index of the metal in question. The

implementation of the physics contained in this optical modelling is given in appendix

C.

3.5.1 Absorption in organic solar cells

In the exciton continuity equation (equation 3.24), the term defining the absorption of

photons to generate excitons is given by [98]

Q =
1

2
cǫ0αηE

2
~ω , (3.40)

where c is the speed of light and α is the absorption coefficient for a wavelength λ,

α =
4πκ

λ
. (3.41)

3.5.2 Emission in OLEDs

Contrary to the case for photovoltaic devices, OLEDs work on the premise that opposite

charges injected at the electrodes recombine to gives excitons which then decay to give

electroluminescence. As mentioned previously, only a fraction ηst of these excitons

are able to recombine radiatively. Ultimately, the quantity of interest in the study of

OLEDs is the number of charge carrier pairs recombined per charge carrier injected at

the contacts. This is given by the internal quantum efficiency, ηIQE,OLED,

ηIQE,OLED = ηst
Jr

Jtot
, (3.42)

where the recombination current, Jr, is the difference between the electron (or hole)

current at the anode and at the cathode and Jtot is the total device current. The
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external quantum efficiency is the number of photons emitted from the device per

injected charge and is obtained by multiplying the internal quantum efficiency by the

probability of a photon escaping from the device.

3.6 Modelling the open circuit voltage, Voc

The origin and quantification of Voc is an outstanding problem in the field of organic

solar cells [101, 102]. Open circuit conditions apply when the current in the external

circuit is zero for a non-zero applied bias and illumination intensity. This is when

injected and extracted current densities are equal and therefore cancel.

In this section, models describing the open circuit voltages of different types of organic

solar cell are described. Bulk heterojunction and bilayer models in the literature are

given first before an expression for the idealised morphology considered here is derived.

3.6.1 Bulk heterojunction organic solar cells

A model which successfully describes the current-voltage characteristics of a double

Ohmically contacted polymer-fullerene blend device has been published recently [73,

103]. It utilises a drift-diffusion transport scheme, as is standard in continuum models

of device behaviour, in an effective medium model. The bandgap is then equal to

the difference between the donor HOMO and the acceptor LUMO, termed the internal

bandgap, Egi, and the effective medium has a single value for all other relevant material

properties such as electron mobility and dielectric constant. This is illustrated in figure

3.7.

An extension of this model to describe the illumination intensity dependence of the

open-circuit voltage in polymer-fullerene blend solar cells has been published recently

[104]. The key assumption is that the electron and hole quasi-Fermi levels are constant

throughout the single layer device at open circuit. The further consideration that

generation and recombination must cancel throughout the device gives the following

relation for Voc,

Voc =
Eg

e
− kBT

e
ln

(

(1− P ) γN2
C

PG

)

. (3.43)

In equation 3.43, P is the probability of polaron pair (not exciton) dissociation to form
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Figure 3.7: Band diagram for the effective medium considered in reference [73]. Ohmic
contacts are shown as being barrierless at the electrodes and the internal bandgap, Egi,
is shown as being the difference between the donor HOMO and the acceptor LUMO.

free charge carriers, G is the generation rate of polaron pairs and γ is the rate of free

charge recombination [87]. Equation 3.43 has been used to accurately simulate the

open circuit voltages over two orders of magnitude of intensity.

3.6.2 Bilayer polyfluorene organic solar cells

An analytical expression for the open-circuit voltage in bilayer polyfluorenes has been

given in reference [56]. This model first assumes that the electric field in each layer is

given by the potential difference across the layer divided by the width, L. Assuming

that the electrons are confined to the right of the interface (in one dimension) and the

interface defines x = 0, from equation 3.1,

Jn = eµnn

(

Vn

L

)

+ eDn
dn

dx
= 0. (3.44)

which has the solution

n(x) = nintexp

(

− eVn

kBT

x

L

)

, (3.45)

69



where Vn is the potential difference across the electron transporting layer and nint is

the electron density at the heterojunction. Assuming that nint is proportional to the

illumination intensity, I0, raised to power α, with proportionality constant k1,

nint = k1I
α
0 , (3.46)

the following relationship results,

eVn

kBT
= α ln (I0) + ln (k1)− ln (nc) , (3.47)

where nc is the electron density at the cathode (x = L). Combining the analogous

expression for holes (pa is the hole density at the anode),

e (Vn + Vp)

kBT
≡ eVoc

kBT
= 2α ln (I0) + ln (k1k2)− ln (ncpa) . (3.48)

Equation 3.48 reproduces the experimentally seen logarithmic rise in Voc with intensity.

However, it underestimates the 80mV rise per order of magnitude in intensity seen in

experiment by 20mV, assuming α=0.5 [56]. A numerical simulation study of the same

system gives a rise of 55mV [55].

One interesting feature of the open circuit voltage in polyfluorene bilayer cells is that

it tends to saturate at high intensity [56], which is not reproduced in the numerical

model [55]. The authors speculate that this could be due to accumulation of charges or

polaron pairs at the heterojunction causing non-radiative recombination of excitons or

influencing the local electric potential such that exciton dissociation requires an energy

input.

3.6.3 The intermediate case; ideal morphology organic solar cells

Reference [33] has shown that an interdigitated donor-acceptor morphology can be

more efficient that a bilayer or a bulk heterojunction device. This will be referred to

as the ‘ideal morphology’ case in this work and is illustrated in figure 3.8.

The current flowing in a semiconductor can be given by the gradient of the quasi-

Fermi level [1], therefore the electron (hole) quasi-Fermi level at the interface and at
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Figure 3.8: Illustration of the morphology used to simulate polymer solar cells. The
length of the fingers, LF , and the electrode length, Lelec, are systematically varied. The
full device structure is glass substrate/ITO/PEDOT/donor polymer/acceptor poly-
mer/Al. ITO is indium tin oxide and is an electrode material and PEDOT is a poly-
mer improving charge transport across the polymer-electrode interface. This device
structure is based on that given in reference [84] for a bilayer organic solar cell.

the cathode (anode) are identical at open circuit. Figure 3.9 shows an energy band

diagram of the system considered in this work.

From the definition of the quasi-Fermi level [1], the electron (hole) density at the

interface and that at the cathode (anode) can be combined to give

ln

(

nintpint

ncpa

)

=
e

kBT
(ψa − ψc) (3.49)

The subscripts int, a and c indicate a quantity at the polymer-polymer interface,

the anode and the cathode respectively. Following reference [104], the product of the

densities at the interface can be written in terms of the areal polaron pair generation

rate, GX and the probability of polaron pair dissociation, P ,

nintpint =
3ǫ0ǫrPGX

hµsmalle(1− P )
. (3.50)

were h and µsmall are defined in equation 3.28.

At open circuit, the potential at the electrodes is given by the boundary conditions for

the Poisson equation, equation 3.5,

ψa = −φBna + Voc, (3.51)
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Figure 3.9: Energy band diagram of relevant quantities considered in the derivation
of the expression for the open circuit voltage, equation 3.54, where χ is the electron
affinity, φBn is the injection barrier height and Eg is the bandgap. The subscript n
refers to electron, p to holes, a to anode (left hand side here) and c to cathode. The
top horizontal line refers to the common vacuum level.

ψc = −φBnc − χc + χa. (3.52)

Noting that

|Vbi| = φBna − φBnc − (χc − χa), (3.53)

the open circuit voltage can be written as

Voc = |Vbi| − Vth ln (ncpa) + Vth ln

(

P

1− P

)

+ Vth ln

(

3ǫ0ǫrGX

hµsmalle

)

, (3.54)

where Vth is the thermal voltage,

Vth =
kBT

e
. (3.55)

Equation 3.54 can also be recast as a sum of different voltage contributions as
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Voc = |Vbi|+ Velec + VP + VGX
, (3.56)

which makes the open circuit voltage data more amenable to examination. All the

terms in equation 3.54 can now be ascribed a physical meaning and the open-circuit

voltage has been described in terms of deviations from the built-in voltage. The second

term on the right hand side of 3.54 shows that the densities of majority carriers at the

electrodes should be as small as possible to maximise the quasi-Fermi level splitting

between the electrodes and the heterojunction. This in turn will maximise the Voc.

The third term shows how the probability of polaron pair dissociation affects the Voc

and the fourth term gives the variation of Voc with the dissociation rate of excitons.

In this final term, GX is found to be proportional to intensity and therefore recovers

the well known relationship expected from a diode-like current-voltage characteristic,

equation 1.5.

Equation 3.54 can be compared to that describing the Voc of a bilayer device in the

previous section, equation 3.48. In both cases, photogenerated charges diffuse away

from the interface, an electric field counteracting this diffusion is therefore needed to

obtain zero current at open circuit.

Equation 3.54 contains a term which varies as ln(GX), and it is found below that

GX is very accurately proportional to the illumination intensity. Additionally both

expressions for Voc have terms in − ln(ncpa). Reference [56] assumes a voltage, Vn

dropped linearly between the polymer-polymer interface and the electrode to obtain

ln(nint) − ln(nc) = eVn

kBT . However, this is the same result used above for the ideal

morphology case, under the assumption that the quasi-Fermi level is continuous across

the layer, equation 3.49. These two definitions are therefore analogous and the dif-

ference in derivation between the two expressions is thus entirely due to the different

ways in which the charge densities at the interface are defined. The bilayer case uses

nintpint = k1k2I
2α
0 , whereas the more physically realistic expression, equation 3.50, is

used for the ideal morphology case.

This work can therefore be considered as a bridge between the two previous model of

references [55] and [73]; a bilayer in the former and a bulk heterojunction in the latter.

Both of these models are one-dimensional in nature and therefore cannot describe any

morphological dependence of important photovoltaic parameters. Although reference

[73] considers a bulk heterojunction device, the effective medium approximation is used.

This precludes consideration of, for example, transport of the electrons and holes in

their respective phases and the screening of the electric field, which is considered below.

73



3.7 Simulation methods

In this work polymer-polymer blend solar cells with an idealised, interdigitated mor-

phology are considered. A similar morphology has been recently considered in reference

[33] and has been shown to be more efficient than a planar bilayer [55] and even a bulk

heterojunction structure. This type of morphology has also been termed an ‘ideal or-

dered bulk heterojunction’ to describe hybrid organic-inorganic devices such as those

considered in reference [32]. The geometry used for the simulations presented here is

illustrated in figure 3.8.

In order to calculate the optical electric field profile in the devices considered here, the

following values for the refractive indices are used, which are all for λ =459nm

1. glass: ñ = 1.5 + 0 [105].

2. ITO: ñ = 1.9 + 3.8× 10−3i [105].

3. PEDOT: ñ = 1.5 + 2.5 × 10−2i [105].

4. donor: ñ = 1.8 + 1.2× 10−2i [106].

5. acceptor: ñ = 1.7 + 6× 10−1i [106].

6. aluminium: ñ = 6× 10−1 + 5.2i [106].

The ordinary wave values for η and κ from Figure 2 in reference [106] are used for the

donor and acceptor values and the values for aluminium are from figure 5 in the same

reference. The aluminium refractive index is needed for the boundary condition at the

Al electrode where it is known that the optical electric field penetrates only a small

distance into the back electrode [100]. Interference effects are included by consideration

of both incident and reflected optical waves and an example plot of the optical electric

field inside the device is given in figure 3.10. This shows the cancellation of the optical

electric field in the close vicinity of the Al back contact.

If the light intensity were assumed to decay exponentially with distance inside the

device and interference effects were neglected, then for a given position, x, the light

intensity would be the same in each phase respectively. This means that each finger of

donor material would have the same intensity at a given value of x. This would apply

equally to the acceptor, although the intensities would be different in the two materials

because they have different refractive indices. Figure 3.10 shows that this is not the

case when the wave equation for E~ω is solved (equation 3.38) since there is a clear
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Parameter Donor Acceptor

ǫr 4 4

NC (m−3) 1027 1027

Nv (m−3) 1027 1027

µn0 (m2V−1s−1) 10−12 3×10−10

µp0 (m2V−1s−1) 10−10 3×10−12

γ (V−1/2m1/2) 3×10−4 1.55×10−4

φBn (eV) 2.3 0.5

φBp (eV) 0.5 1.9

τexc (ns) 1 1

Dexc (m2s−2) 10−7 10−7

Lexc (nm) 10 10

Table 3.1: Simulation parameters for the simulation of idealised morphology polymer
blend solar cells. These are as given in reference [55] except for the γ value for the
acceptor material.

oscillation in the value of E~ω in the direction parallel to the electrodes. A comparison

of current-voltage characteristics obtained with these two different illumination schemes

is performed in section 3.8.2.

Because the excitons have a finite diffusion length, it is desirable to generate excitons as

close to the heterojunction as possible. The peaks of the optical electric field in figure

3.10 profile should therefore be close to the junction to maximise the photovoltaic

response. Reference [107] has shown that for a bulk heterojunction organic solar cell,

the short circuit current can be optimised with respect to the thickness of the active

layer and reference [84] has given analogous results for the optimum layer thickness in a

bilayer organic solar cell. It would be an interesting extension to this work to examine

the relationship between quantum efficiency and device thickness in the intermediate

case considered here for an ideal morphology organic solar cell.

Table 3.1 gives the invariant electrical simulation parameters for all morphology schemes

used in this chapter.

To calculate the generation and recombination rates for the electrons and holes the

model uses the value of the x component of the electric field and the value of the

majority carrier concentrations at the polymer-polymer heterojunction [55]. For a

distributed junction the value of these quantities at a point cannot be used. This is

circumvented by splitting the interface into sections as seen in figure 3.8 and using an

average generation rate in each interface subdomain. The electric field (the majority

carrier densities are obtained analogously) is calculated from
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Figure 3.10: Example plot of the magnitude of the optical electric field (in Vm−1)
inside a device at 0.1 Sun for the refractive indices given on page 74, Lelec=440nm and
Lint=1072nm. The figure also illustrates the underlying device morphology.

Ēx(y) =

∫ l
0 Ex(y)dx(y)
∫ l
0 dx(y)

, (3.57)

where l is the length of the interface region in question. It is ensured that the numbers of

generated electrons and holes are equal, which ensures continuity of charge throughout

the device.

It is necessary to consider several different factors which affect the power conversion

efficiency of any organic photovoltaic device and these are defined as

1. The photon absorption efficiency, ηA =
number of absorbed photons

number of photons incident on cell

2. The exciton dissociation efficiency, ηe = number of dissociated excitons
number of absorbed photons

3. The charge transport efficiency, ηc = number of electrons in the external circuit
number of dissociated excitons

4. The internal quantum efficiency, ηIQE = ηeηc

5. The external quantum efficiency, ηEQE = ηAηIQE
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The formalism of reference [55] is used here for quantifying the illumination intensity.

Monochromatic illumination at 459nm is incident on the cells with a power density of

1Wm−2. Therefore, 1 Sun illumination is defined as a power density of 1Wm−2. The

illumination intensity (in photons per unit are per unit time) is given by the power

density divided by the energy of a photon at 459nm, which is equal to 2.3×1018m−2s−1.

3.7.1 Organisation of results

In the results section below, two different sets of morphologies are of interest,

1. where the electrode length, Lelec is fixed and the length of the interface, Lint is

varied by changing LF .

2. where Lint is varied to the same extent as considered in (1) but Lelec is also varied

so that the ratio Lint

Lelec
is kept constant.

The total length of the interface, Lint, is given by

Lint = 2NFLF + Lelec, (3.58)

where NF is the number of fingers (4 throughout this work). Table 3.2 gives the

morphological parameters considered in this chapter for cases 1 and 2 in the above list.

Firstly, for each of these two cases in turn, the relationship between morphology and

ηIQE is studied by studying ηc and ηe.

Next, the inclusion of a full optical model to describe the incident sunlight on the solar

cells is justified by comparing current-voltage characteristics obtained using the full

model and an exponentially decaying illumination profile.

The variation of the key photovoltaic parameters Jsc, Voc, ηmpp and FF with variations

in morphology and illumination intensity are then considered for the two morphology

schemes. In addition to this, scheme 1 is also considered in the absence of polaron pairs

so that excitons dissociate directly into free charges. When polaron pairs are absent,

the charge continuity equation (equation 3.31) is modified as,

∂n(p)

∂t
=
GX − FX

h
+ (−)

1

e
∇ · Jn(p), (3.59)
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where all symbols are as defined previously.

Finally, the effect of the electric field on device performance is discussed with relation

to field screening in the region surrounding the fingers in the device geometry. Results

are presented showing that field screening can improve or degrade the Voc.

3.8 Results

3.8.1 Quantum efficiency as a function of morphology

A considerable advantage of multi-dimensional modelling in the study of excitonic solar

cells is that it enables the investigation of the morphological dependence of the effi-

ciency. This is, after all, the parameter all solar cell research is ultimately intent on

improving. It has been shown before by both experimental [108] and theoretical [109]

research that the internal quantum efficiency does not always increase monotonically

with increasing interfacial area as might be expected. Reference [109] showed that as

the interfacial area is increased, the exciton dissociation efficiency increases. This is

because the excitons are more likely to find an interface within an exciton diffusion

length of their creation site. However, the charge transport efficiency is decreased be-

cause charges are more likely to recombine across the heterojunction. Since ηIQE is the

product of these two quantities, it may exhibit a peak at intermediate morphologies.

The device model in reference [109] is a bulk heterojunction device consisting of a 3D

blend of donor and acceptor materials and considered ratios of interfacial to electrode

areas roughly two orders of magnitude higher than those considered here. To elucidate

the effect of morphology on the results, simulations including polaron pairs are con-

sidered for the two cases where the ratio of electrode length, Lelec to interface length,

Lint, is either constant or varying.

Variable electrode to interfacial area ratio

Firstly, the fraction Lelec

Lint
is varied. Figures 3.11 and 3.12 show the charge transport

and exciton dissociation efficiency for this case.

Up to biases approaching Voc, the charge transport efficiency in figure 3.21 is unity

because there is insufficient recombination to cancel out the photocurrent. By defini-

tion, ηc will go to zero at Voc because there are no carriers delivered to the external

circuit. One may expect the charge transport efficiency to decrease as the interfacial
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Figure 3.11: The charge transport efficiency
as a function of applied bias and morphology for
varying Lelec

Lint
and for 0.1 Sun. The values are

normalised to the highest value found for each
applied bias.
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Figure 3.12: The exciton dissociation efficiency
as a function of applied bias and morphology for
varying Lelec

Lint
and for for 0.1 Sun. The values are

normalised to the highest value found for each
applied bias.
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Figure 3.13: The internal quantum efficiency
efficiency as a function of applied bias and mor-
phology for varying Lelec

Lint
and for 0.1 Sun. The

values are normalised to the highest value found
for each applied bias.
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Figure 3.14: The active area fraction for vary-
ing Lelec

Lint
.

area increases due to increased recombination as found in reference [109] but this is not

seen except at biases close to Voc.

The exciton dissociation efficiency shows a monotonic increase with increasing interfa-

cial area in agreement with reference [109]. In order to quantify this, the active area

fraction of the solar cells is defined as the ratio of the area within an exciton diffusion

length (10nm) of the interface to that of the whole device. If this fraction grows as

the length of the interface increases then the exciton diffusion efficiency is expected to

increase also. Figure 3.14 shows that this is case.

The product of ηc and ηe gives the IQE, which is shown in figure 3.13. At low bias

the shape of the internal quantum efficiency is dominated by the rise in the diffu-

sion efficiency since ηc is unity and at high bias the rise in the diffusion efficiency is

overwhelmed by the decrease in ηc. At biases between 0.77-0.88V a peak in ηIQE is

observed, which is in agreement with the modelling studies in reference [109].

Reference [110] reports data at short circuit conditions for a similar, interdigitated
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Figure 3.15: The charge transport efficiency
as a function of applied bias and morphology for
constant Lelec

Lint
and for 0.1 Sun. The values are

normalised to the highest value found for each
applied bias.
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Figure 3.16: The exciton diffusion efficiency
as a function of applied bias and morphology for
constant Lelec

Lint
and for 0.1 Sun. The values are

normalised to the highest value found for each
applied bias.
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Figure 3.17: The internal quantum efficiency
efficiency as a function of applied bias and mor-
phology for constant Lelec

Lint
and for 0.1 Sun. The

values are normalised to the highest value found
for each applied bias.
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Figure 3.18: The active area fraction for con-
stant Lelec

Lint
.

morphology to that considered here and shows that as the interfacial area between

the donor and acceptor becomes longer, a peak in Jsc is observed for most conditions

considered. This is shown to be due to competition between increasing generation and

increasing recombination, which grow in strength at different rates. This is entirely

analogous to the results reported here where a peak in ηIQE is observed between 0.77-

0.88V.

Constant electrode to interfacial area ratio

In the previous section, the ratio Lelec

Lint
was allowed to vary. In this section this fraction

is kept constant and figures 3.15-3.17 show ηc, ηe and ηIQE as a function of morphology

and applied bias.

From examination of figure 3.15 it is clear that all free charges escape the device

without recombination except for biases very close to Voc in agreement with figure
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3.11. However, figure 3.16 shows that ηe exhibits a peak at intermediate interfacial

area and is broadly independent of the applied bias. The value of ηe is defined as the

number of dissociated excitons per absorbed photon and figure 3.18 shows that the

active area fraction saturates at high values of the interface length. Therefore, the

fact that ηe exhibits a peak at intermediate morphologies indicates that the number

of excitons generated is not saturating also. Since ηc is unity at short circuit and the

active area fraction saturates, the value of Jsc is also expected to saturate and this is

seen in figure 3.20 on page 93.

Figure 3.17 shows the IQE and is highly dependent on the morphology and applied

bias, exhibiting a maximum in the IQE at every bias considered. At high bias, the

charge transport efficiency is considerably decreased and therefore the maximum in

ηIQE is shifted towards increasingly low interfacial areas as the bias approaches Voc.

3.8.2 Validity of the Lambertian illumination profile

Several organic solar cell device models use a Lambertian absorption profile where

the light intensity decreases exponentially with distance inside the device [110, 33].

Figure 3.19 shows a comparison of the current-voltage characteristics of two devices,

one with a Lambertian profile and one using the optical electric field obtained by solving

equation 3.38. For the Lambertian case, the transmitted intensity is calculated using

the reflectance at the air-glass interface, R∗, so that

Q =
1

2
cǫ0αηE

2
~ω,0 (1−R∗) exp (−αx) , (3.60)

where Q is the parameter denoting exciton generation in equation 3.24.

Figure 3.19 shows that by using the Lambertian illumination profile (including the ITO

and PEDOT layers) reduces the predicted Jsc by an order of magnitude and the Voc by

approximately 50mV. The currents decrease with increasing applied bias because the

internal electric field is decreasing, which decreases polaron pair dissociation. It will be

seen below that when solving for the full optical electric field profile, these reductions

are commensurate with a reduction in the illumination intensity by roughly an order of

magnitude. This is because the Jsc is proportional to the intensity (except at very high

illumination levels) for each decade increase in intensity the Voc increases by between

50 and 60mV. This emphasises the necessity of using a realistic illumination profile for

predicting the response of organic solar cells.
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Figure 3.19: Comparison of different illumination profiles on the current-voltage char-
acteristic for Lelec=105nm, LF =19nm including polaron pairs at 0.1 Sun. The Solid
line uses the Lambertian profile in equation 3.60 and the dashed line uses the optical
electric field obtained by solving equation 3.38.
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Figure 3.20: Short circuit current density nor-
malised to the illumination intensity for constant
Lelec and with polaron pairs.
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Figure 3.21: Charge transport efficiency at
short circuit for constant Lelec and with polaron
pairs.

3.8.3 Key photovoltaic parameters: Varying Lint, constant Lelec, po-

laron pairs included

Short circuit current

Figure 3.20 shows the short circuit current density as a function of intensity and mor-

phology for the constant Lelec and varying Lint. The Jsc has been normalised to the

illumination power density (that is Jsc

P0
) because it is expected to increase linearly with

P0 [2]. In this work, the illumination intensity is varied over 8 orders of magnitude and

so providing the quantity Jsc

P0
enables the results to be analysed more easily.

Figure 3.20 shows that the Jsc increases as the contact area between the two phases

increases. This is because the active area ratio of the device is increasing, as seen previ-

82



−6 −4 −2 0 2 0
0.2

0.4
0.6

0.8−4

−3.5

−3

−2.5

−2

−1.5

L
int

 (µ m)
log

10
(P

0
) (Suns)

E
in

t (
M

V
m

−
1 )

Figure 3.22: The average short circuit electric field at the interface for constant Lelec

and with polaron pairs.

ously in figure 3.14. Therefore, more excitons are able to diffuse to the heterojunction

and dissociate into free charges. These free charges then move to the electrodes where

they are extracted and establish a photocurrent.

Two effects will principally affect the short circuit current,

1. Free charge recombination, reflected in the charge transport efficiency ηc, figure

3.21.

2. The effect of the electric field on the polaron pair dissociation, which will ul-

timately determine how many photogenerated excitons can contribute to the

photocurrent, figure 3.22.

Figure 3.21 shows that ηc decreases at high intensity. This will act to decrease the short

circuit current as observed in figure 3.20. The average electric field at the interface be-

tween the polymer phases is shown in figure 3.22. The electric field increases (becomes

less negative) at high intensity. This will act to decrease the polaron pair dissociation

rate further and will decrease the short circuit current as has been previously reported

in reference [55].

Maximum power point efficiency

The power conversion efficiency at the maximum power point is given by the equation,
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Figure 3.23: Maximum power point current
density normalised to the illumination intensity
for constant Lelec and with polaron pairs.
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Figure 3.24: Charge transport efficiency at
the maximum power point for constant Lelec and
with polaron pairs.
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Figure 3.25: The electric field at the interface between the polymer phases at maximum
power point for constant Lelec and with polaron pairs.

ηmpp =
Jmpp

P0
× Vampp. (3.61)

It is therefore of interest to study the two quantities
Jmpp

P0
and Vampp. Figures 3.23-3.26

show the current, the charge transport efficiency ηc, the average interfacial electric field

and the applied bias at the maximum power point voltage respectively.

Figure 3.23 shows that the current density increases as the length of the fingers increases

and also decreases for increasing illumination intensity. This is precisely the same

behaviour as noted above for Jsc and the increase in Jmpp is due to the increasing

active area fraction seen in figure 3.14. As for the short circuit current considered

in figure 3.20, the decrease in Jmpp for intense illumination can be seen to be due to

the combined factors of the decreased charge transport efficiency, figure 3.24, and the

electric field, figure 3.25, which acts to decrease polaron pair dissociation.
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Figure 3.26: The maximum power point volt-
age for constant Lelec and with polaron pairs.
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Figure 3.27: The maximum power point effi-
ciency for constant Lelec and with polaron pairs.

The applied bias at the maximum power point, Vampp, is constant up to ∼1 Sun and

decreases for higher intensities. From figure 3.19, it is clear that the current decreases

with increasing applied bias in this case. The power is given by the product of the

current and the applied voltage, therefore, if the maximum power point voltage is

constant at low to intermediate intensity, this means that the associated currents are

all decreasing at the same rate with respect to the applied bias. The currents decrease

with increasing applied bias because the internal electric field is decreasing and hence

polaron pair dissociation is inhibited. The decrease in Vampp at high intensity will be

due partly to the decrease in the charge transport efficiency at high intensity, figure

3.24, meaning that the injected current will be able to cancel out the photogenerated

current at lower applied biases. The decrease in the polaron pair dissociation efficiency,

figure 3.25, will have the same effect.

If the electric field in the devices was constant across the devices, it would take the

value

E =
Va − Vbi

d
. (3.62)

Therefore, if Vampp is decreasing (as is observed at high intensity in figure 3.25), the

interfacial electric field would be expected to become more negative. This is in op-

position to what is seen in figure 3.25 and the observed decrease in magnitude of the

electric field must therefore be solely due to the build up of space charge.

The maximum power point efficiency is shown in figure 3.27. From the previous con-

sideration of the current and the maximum power point voltage, it can be immediately

seen that the increase in efficiency with increasing Lint is due to the increase of the

current, figure 3.23. Also, it can also be seen that the decrease at high intensity is due

to the combined effects of the decreased maximum power point voltage, figure 3.26 and

the decrease in current, figure 3.23.

85



−6 −4 −2 0 2 0
0.2

0.4
0.6

0.8−20

−15

−10

−5

0

L
int

 (µ m)
log

10
(P

0
) (Suns)

V
el

ec
 (

m
V

)

Figure 3.28: Velec relative to that calculated
for the lowest intensity and interfacial area con-
sidered for constant Lelec and with polaron pairs.
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Figure 3.29: VP relative to that calculated for
the lowest intensity and interfacial area consid-
ered for constant Lelec and with polaron pairs.

Open circuit voltage

The open circuit voltage is examined in terms of its constituent components as set

out in equations 3.54 and 3.56. It has been found that that the different terms in

equation 3.56 can differ significantly from one another in magnitude. Therefore they

are plotted with respect to the value for the smallest value of Lint and illumination

intensity considered. This gives a feel for the trends involved as the morphology and

optical bias are varied, which is the behaviour of interest.

Figure 3.28 shows the evolution of Velec and it is clear that this term acts to decrease

the open circuit voltage and is therefore detrimental to device performance. The fact

that this term is increasing in magnitude means that the densities of majority carriers

at their respective electrodes are increasing, acting to reduce the quasi-Fermi level

splitting between the polymer-polymer interface and the electrodes. This behaviour

has been noted previously for a bilayer device [55] and effect becomes more pronounced

for higher illumination intensities and for increased interfacial area.

Figure 3.29 shows VP for the same system and again it is seen that VP tends to reduce

the Voc and shows a general increase in magnitude with increasing intensity. In contrast

to Velec, VP tends to decrease faster for lower interfacial areas. These effects will tend

to cancel each other out in the final value of Voc. In these simulations P is between 4%

and 8% and VP will only give a positive contribution if P > 1
2 .

The behaviour of VGX
is considered in figure 3.30. This figure has been displayed

in two parts since the size of the term obscures the change with morphology. The

change in VGX
as the intensity is increased is significantly more pronounced than Velec

and VP and is also significantly more uniform as the morphology is varied. For every

morphology and intensity considered, the rise in Voc with each decade of intensity is

59.5mV. The uniformity with increasing illumination intensity implies that it is solely
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Figure 3.30: VGX
relative to that calculated for the lowest intensity and interfacial area

considered for constant Lelec and with polaron pairs. The right hand side of the figure
shows the behaviour as the morphology changes for 10−6 Sun illumination (©) and
the ratio of the active area to Lint relative to the shortest value of Lint in table 3.2
(�). This observed decrease in VGX

in the right hand pane is seen uniformly for all
intensities considered and is obscured by the large increase as the intensity is increased
(left hand pane).

the morphology of the system which affects this term and this is borne out by the

fact that the change in VGX
with morphology is unchanged when vastly different light

powers are incident. As the interfacial area between the polymer phases increases, VGX

decreases by up to approximately 13mV. This means that fewer excitons are being

dissociated per unit interfacial area.

The quantity, VGX
is a measure of the total number of dissociated excitons per unit

interfacial area. Therefore, the behaviour of VGX
in the right panel of figure 3.30 should

reflect the ratio of the active area to total length of the interface, Lint. This behaviour

is evident in the right hand pane of figure 3.30 and shows that Lint is increasing at a

faster rate that the active area.

The three terms VP , Velec and VGX
are all plotted for Lelec=50nm and Lint=362nm

in figure 3.31. The very large increase in VGX
compared to the other terms means

that plotting all three on the same axes would obscure the relative magnitudes of the

changes in VP and Velec. From figure 3.31 it is clear that the behaviour of Voc as the

intensity is increased is dominated by VGX
.

Equation 3.54 begins to break down at high interfacial areas and illumination intensi-

ties. The discrepancy between the equation and the simulation results originates from

the fact that in each interface subdomain, the average of the electron and hole densities

and the electric field are used, equation 3.57. At high interfacial areas and illumination
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Figure 3.31: The left hand panel shows VP (©) and Velec (�) and the right hand panel
shows VGX

. All quantities are for Lelec=50nm and Lint=362nm and are with respect
to their values at the shortest finger length and lowest intensity considered.

intensities, these quantities vary rapidly at the interface and therefore the product of

the averages are not rigorously equal to the local values. However, for the shorter val-

ues of Lint considered here, the agreement between the simulations and the equation

is excellent as shown in figure 3.32.

Fill factor

The fill factor, FF , is defined in equation 1.3 and the form of the second equality will

be used here because the behaviour of each of the quantities in this definition have

already been considered. Figure 3.33 shows the FF as a function of Lint and P0.

Figure 3.33 shows that the FF decreases at a constant rate for all intensities up to

1 Sun and then decreases more rapidly. Figures 3.27 and 3.20 show that ηmpp and
Jsc

P0
are roughly constant up to this intensity and so this initial decrease in FF can be

attributed to the logarithmically increasing Voc. Above 1 Sun, the decrease in the FF

is accelerated. The open circuit voltage continues to rise logarithmically, so the further

decrease in FF is due to the decrease in ηmpp. This is because the decrease in Jsc

P0
will

act to increase the FF , contrary to what is observed in figure 3.33.

3.8.4 Key photovoltaic parameters: Varying Lint, constant Lelec, po-

laron pairs not included

Simulations are now considered without the presence of polaron pairs.
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Figure 3.32: Comparison of simulated Voc as a function of illumination intensity (©)
and calculated from equation 3.54 (solid line) for constant Lelec and with polaron pairs
for Lelec=50nm and Lint=122nm.
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Figure 3.33: The fill factor for constant Lelec and with polaron pairs.

Short circuit current

Figure 3.34 shows that the decay of polaron pairs at the interface provides a significant

loss mechanism at short circuit because the currents are roughly a factor of two larger in

figure 3.34 compared to those in figure 3.20 when polaron pairs are present. Addition-

ally, Jsc is seen to grow with increasing Lint due to the increasing active area fraction in

figure 3.14. The charge transport efficiency at short circuit is shown in figure 3.35 and

the decrease at high intensity is in agreement with figure 3.21. In this case the decrease

in Jsc at high intensity can be solely attributed to this decrease in charge transport

efficiency because the polaron pairs are absent and hence the interfacial electric field

does not affect free charge generation.
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Figure 3.34: Short circuit current density nor-
malised to the illumination intensity for constant
Lelec and without polaron pairs.
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Figure 3.35: Charge transport efficiency at
short circuit for constant Lelec and without po-
laron pairs.
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Figure 3.36: Maximum power point current
density normalised to the illumination intensity
for constant Lelec and without polaron pairs.
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Figure 3.37: Charge transport efficiency at
the maximum power point for constant Lelec and
without polaron pairs.

Figure 3.35 shows that the decrease in ηc is greater at high values of Lint and illumina-

tion intensities compared to the case when polaron pairs are present, figure 3.21. This is

attributed to the fact that in the absence of polaron pairs, all of the free charges which

recombine will be lost. However, in figure 3.21, the polaron pairs can re-dissociate back

into free charges, increasing ηc.

Maximum power point efficiency

Figures 3.36-3.38 show the current, charge transport efficiency and the applied bias at

the maximum power point. Figure 3.36 shows that the current increases with increasing

Lint due to the increasing active area fraction. The decrease at high intensity is again

attributed solely to the reduced charge transport efficiency, figure 3.37, due to the

absence of polaron pairs in the simulations.

The shape of the maximum power point voltage results in figure 3.38 is rather different

from that seen above in the presence of polaron pairs, figure 3.26. The latter shows a

constant value up to high illumination intensity as opposed to the peak at ∼ 10−3 Suns

in figure 3.38. This differing behaviour can be attributed to the effect of the electric
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Figure 3.38: The maximum power point volt-
age for constant Lelec and without polaron pairs.
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Figure 3.39: The maximum power point ef-
ficiency for constant Lelec and without polaron
pairs.
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Figure 3.40: Current-voltage characteristics for constant Lelec with polaron pairs (solid
line) and without polaron pairs (dashed line) for Lint=682nm, Lelec=50nm and 0.01
Sun.

field on the polaron pair dissociation. Figure 3.40 compares the shapes of the current-

voltage characteristics in the presence and absence of polaron pairs. Since the polaron

pair dissociation rate, and hence the current, is dependent on the electric field, the

resultant current will decrease with increasing applied bias because the internal field

is decreasing. In addition, for biases above Vbi, there will be a significant amount of

charge injected into the device, which will act to increase recombination and decrease

the current further [55]. In the absence of polaron pairs, the current only starts to

decrease for Va ≈ Vbi because the photocurrent is electric field independent as is clear

from figure 3.40. The initial rise in the maximum power point voltage in the absence of

polaron pairs, figure 3.38, is therefore due to the increasingly large bias needed for the

injected current to overwhelm the increasing photocurrent. The subsequent decrease

in Vampp will be due to the decrease in charge transport efficiency, meaning that less

photogenerated charges reach the electrode, and so a smaller applied bias is required

to cancel out the photocurrent.
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Figure 3.39 shows ηmpp in the absence of polaron pairs. It is immediately apparent that

the peak in ηmpp is due to the peak in Vampp and that the decrease at high intensities

is due to the combined effects of the decreased maximum power point voltage, figure

3.38, and the decreased current, figure 3.36.

Open circuit voltage

It is unnecessary here to include the VP term since excitons are dissociated directly into

free charges. The term VGX
is again found to be remarkably consistent in its behaviour

when the intensity and morphology are changed with the increase of VGX
lying between

59 and 60mV per decade of intensity and again decreasing with increasing Lint. It is

interesting to examine the difference in the value of the open circuit voltage depending

on whether or not polaron pairs are included. It would certainly be expected that

in this latter case, higher open circuit voltages would result since in the case where

polaron pairs are present, some dissociated excitons will never give rise to free charges.

This is precisely what is observed and the difference between the open circuit voltages

can be entirely attributed to the voltage loss due to the decay of polaron pairs, VP .

With VP varying between 60 and 85mV, this is a significant loss channel in organic

solar cells.

Fill factor

The situation is more complicated in the absence of polaron pairs because the shape of

the ηmpp curve exhibits a peak at intermediate intensity, figure 3.41. However, the peak

in the FF is less pronounced and is shifted to lower values of the illumination intensity

due to the increasing open circuit voltage. Since Jsc

P0
is constant up to 1 Sun, figure

3.34, the decrease in FF at low intensity is therefore due to the increasing Voc. Also,

as noted above, the decreasing value of Jsc

P0
at high intensity will only act to increase

the FF . Above 10−3 Suns, the decrease in ηmpp will also aid the decrease in the FF .

In figures 3.38, 3.39 and 3.41, Vampp, ηmpp and FF are significantly higher than found

in figures 3.26 3.27 and 3.33. This can be attributed to the more rectangular current-

voltage curve in figure 3.40, where the current decreases with increasing forward bias

even near short circuit where polaron pairs are present. These higher values of the FF

and ηmpp give further indication of the significant loss mechanism brought about by

the presence of polaron pairs in organic solar cells.
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Figure 3.41: The fill factor for constant Lelec and without polaron pairs.

−6 −4 −2 0 2 0
0.4

0.8
1.20.02

0.03

0.04

0.05

0.06

L
int

 (µ m)
log

10
(P

0
) (Suns)

J sc
/P

0

Figure 3.42: Short circuit current density nor-
malised to the illumination intensity for varying
Lelec and with polaron pairs.
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Figure 3.43: The charge transport efficiency at
short circuit for varying Lelec and with polaron
pairs.

3.8.5 Key photovoltaic parameters: Varying Lint and Lelec, polaron

pairs included

Short circuit current

Now the effect of the ratio between Lint and Lelec on the Jsc is considered in figures 3.42-

3.44. As well as the decrease in the current at high illumination intensity in agreement

with figure 3.20 and 3.34, it is clear that the current saturates at high values of the

interfacial area.

Figure 3.18 shows that the active area fraction in this geometry saturates as Lint

increases. The length of the electrode, Lelec is increasing at the same rate as the total

volume of the device and therefore the current density is expected to saturate also,

which is observed in figure 3.42.

When Lelec is held constant and polaron pairs are included, the charge transport ef-
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Figure 3.44: The electric field at the interface at short circuit for varying Lelec and
with polaron pairs.

ficiency figure 3.21 at high intensity is significantly lower than in the equivalent case

where Lelec varies, figure 3.43. This is attributed to the fact that in the former case

there is more interfacial area per cross sectional area of the device and therefore more

chance for recombination of free carriers at the junction. The decrease in charge trans-

port efficiency at high intensity, figure 3.43, is in agreement with the constant Lelec

case given above in figure 3.21, acting to decrease the Jsc at high intensity. Figure 3.44

shows the electric field at the interface at short circuit and shows that it becomes less

negative at high intensity. This is in agreement with figure 3.22 for constant Lelec and

will act to reduce the Jsc further.

Modelling studies using similar morphologies, references [111, 112], have shown that

the value of Jsc is shown to decrease as the width of the fingers is increased for constant

finger length. This is in opposition to figure 3.42, which shows a saturation of Jsc with

increasing finger width. This difference can be rationalised by noting that in references

[111] and [112], the active area fraction will be decreasing as the finger width increases

and therefore less excitons are able to reach to the heterojunction before decaying.

In the results presented here, the active area fraction, figure 3.18 saturates for wider

fingers and so Jsc saturates also. Reference [112] also shows that as the finger length

is increased for constant finger width, the current increases and tends to saturate, in

agreement with figure 3.42.

The results presented here and in references [109, 112, 111] show how sensitive the

value of Jsc is to the underlying device morphology. Indeed, increasing the width of

characteristic features of the device geometry can actually be detrimental to device

performance even though there will be more sites for exciton dissociation. This work

has shown that a crucial parameter controlling the efficacy of photon-to-current light
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Figure 3.45: Maximum power point current
density normalised to the illumination intensity
for varying Lelec and with polaron pairs.
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Figure 3.46: Charge transport efficiency at the
maximum power point for varying Lelec and with
polaron pairs.
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Figure 3.47: The electric field at the interface between the polymer phases at maximum
power point for varying Lelec and with polaron pairs.

conversion is the active area fraction, as indicated by the different shapes of figures

3.14 and 3.18.

Maximum power point efficiency

Figures 3.45-3.48 show the quantities of interest for the calculation of the maximum

power point efficiency.

Firstly examining figure 3.45, it is clear that a saturation occurs for increasing interfacial

area and the current decreases at high intensity. The saturation of the current with

increasing finger length is expected in the light of the previous discussion concerning

the Jsc in figure 3.42. Next, the charge transport efficiency at maximum power point is

shown in figure 3.46. As shown previously, there is a sharp decrease at high intensity,

which will act to decrease the current, as seen in figure 3.45. It should be noted here
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Figure 3.48: The maximum power point volt-
age for varying Lelec and with polaron pairs.
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Figure 3.49: The maximum power point effi-
ciency for varying Lelec and with polaron pairs.

that the fall in the charge transport efficiency in figure 3.46 is substantially less than for

figure 3.24 at high intensity. This effect has been seen above for the charge transport

efficiency at short circuit and was attributed to the relatively larger area of the interface

compared to the heterojunction, thus providing more pathways for recombination.

Additionally, the electric field at the interface acts to decrease polaron pair dissociation

at high intensity, figure 3.47, and this will also act to decrease the current in agreement

with the simulations presented above. The value of Vampp is shown in figure 3.48

and is found to be very similar to that found when the Lelec is kept constant, figure

3.26. The same conclusions can therefore be reached for the shape of this curve from

examination of the decreasing polaron pair dissociation and charge transport efficiency

at high intensity on page 85.

Figure 3.49 shows the maximum power point efficiency. The saturation is expected

because the value of Jmpp saturates similarly and the Vampp is constant at low to

intermediate intensities, figure 3.48. The decrease in ηmpp at high intensity can then be

attributed to the decreased current, figure 3.45, and the reduced maximum power point

voltage, figure 3.48, in agreement with the simulations with constant Lelec, figures 3.27

and 3.39.

Open circuit voltage

Figure 3.50 shows Velec for the case of varying Lelec, including polaron pairs with

reference to that for the lowest area and intensity. The same trend is seen as for figure

3.28 and the magnitude is also very similar. The majority carriers build up at the

electrodes causing Velec to be detrimental to device performance, which becomes more

pronounced for higher values of Lint.

Figure 3.51 shows VP and again the magnitude of the decrease of VP is very similar
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Figure 3.50: Velec relative to that calculated
for the lowest intensity and interfacial area con-
sidered for varying Lelec and with polaron pairs.
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Figure 3.51: VP relative to that calculated for
the lowest intensity and interfacial area consid-
ered for varying Lelec and with polaron pairs.
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Figure 3.52: VGX
relative to that calculated for the lowest intensity and interfacial area

considered for varying Lelec and with polaron pairs. The right hand side of the figure
shows the behaviour as the morphology changes for 10−6 Sun illumination (©) and
the ratio of the active area to Lint relative to the shortest value of Lint in table 3.2
(�). This observed increase in VGX

in the right hand pane is seen uniformly for all
intensities considered and is obscured by the large increase as the intensity is increased
(left hand pane).

to that found before for constant Lelec, figure 3.29. The trend with morphology is the

same also, with the decrease becoming greater for smaller interfacial areas.

Figure 3.52 shows VGX
, plotted in two parts as in figure figure 3.30. Figure 3.52 has

a rather different form to that for constant electrode length, figure 3.30, saturating

at high values of Lint. Again the behaviour of this term with changing morphology

is independent of intensity. The right hand panel of Figure 3.52 shows the ratio of

the active area to the interface length, relative to that for the smallest value of Lint

considered. As with figure 3.30 the behaviour of VGX
tracks this quantity, as expected.

As with figure 3.31, VP , Velec and VGX
are plotted for the intermediate finger length

of 38nm in figure 3.53. Again, it is clear that the behaviour of Voc as the intensity is
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Figure 3.53: The left hand panel shows VP (©) and Velec (�) and the right hand panel
shows VGX

. All quantities are for Lelec=216nm and Lint=528nm, and are with respect
to their values at the shortest finger length and lowest intensity considered.

−6 −4 −2 0 2 0 0.20.40.60.81 1.210

15

20

25

30

35

L
int

 (µ m)
log

10
(P

0
) (Suns)

F
F

 (
%

)

Figure 3.54: FF for varying Lelec and with polaron pairs.

increased is dominated by VGX
.

Fill factor

The behaviour with changing morphology and intensity, as well as the magnitude of

the FF for this case, figure 3.54, is very similar to that of constant electrode length,

figure 3.33. The slower decrease at low to medium intensity is due to the logarithmically

increasing Voc when Jsc is proportional to the intensity, figure 3.42, and ηmpp is constant,

figure 3.49 and equation 1.3. Then at high intensity, the faster decrease in FF is due to

the additionally decreasing ηmpp, which in turn is because of the decreased maximum

power point current and the decrease in the maximum power point voltage.
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Lelec(1)(nm) LF (1)(nm) Lint(1)(nm)
L

int(1)
L

elec(1)
Lelec(2) (nm) LF (2) (nm) Lint(2)(nm)

L
int(2)

L
elec(2)

50 9 122 2.44 50 9 122 2.44

50 19 202 4.04 105 19 257 2.44

50 39 362 7.24 216 39 528 2.44

50 59 522 10.44 328 59 800 2.44

50 79 682 13.64 440 79 1072 2.44

Table 3.2: Morphology parameters for the two simulation schemes.
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3.8.6 Electric field screening and its effect on the open circuit voltage

The results presented above have shown that the electric field at the polymer-polymer

heterojunction has been shown to have a significant effect on the device performance.

However, the complex morphology of these devices can also have a significant effect on

the distribution of the electric field. In reference [55], a bilayer photovoltaic device is

considered and since there is no charge transport across the heterojunction, majority

holes are confined to the left of the interface and majority electrons to the right (as

is considered here). Since minority carrier densities are negligible in the bilayer case

[55], the electric field will have a positive gradient on the left hand side and a negative

gradient on the right hand side of the junction. The electric field will therefore always

exhibit a maximum at the interface. For the interdigitated case, the morphology is

more complicated and the previous analysis will not hold since large carrier densities

can now overlap by interpenetration via adjacent fingers in the morphology.

Figure 3.55 shows charge density and electric field plots for Lint=1072nm and Lelec=440nm.

The electric field plotted here is the x component, where x is perpendicular to the elec-

trodes. This is so because the polaron pair dissociation rate depends on this quantity

[55] and not on Ey. At short circuit, the charge densities are low and the electric field is

approximately equal to that given by the built-in voltage divided by the thickness, i.e.,

approximately 4MVm−1. At Va = Vbi, the charge density is similar in magnitude to that

at short circuit and the field is approximately zero. However when Va−Vbi = 0.3V, there

is a significant increase in the charge density which will be due to charges injected from

the electrodes above the built-in bias [55]. In the interface region for figures 3.55(vi),

where the charge densities are highest, the electric field is seen to be heavily screened.

In addition, neighbouring fingers contain oppositely charged carriers and the electric

field may therefore be expected to vary rapidly in the y-direction. This behaviour is

absent from figure 3.55 and can be explained by the fact that the form of the Poisson

equation in 2 dimensions has the form,

−∇2ψ =
∂Ex

∂x
+
∂Ey

∂y
=
e(p − n)

ǫ0ǫr
. (3.63)

Therefore, the rapid change in sign of the source term in the y direction can be expressed

by a change in ∂Ex

∂x or
∂Ey

∂y or a combination of the two. This can be seen from

examination of the y component of the electric field for the same data. Figure 3.56

shows the x and y components of the electric field for the conditions in figure 3.55(vi)

and shows that the y component of the field is varying rapidly from finger to finger. The

change in sign of the source term is mostly taken up in the y component of the field and

Ex does not vary significantly in the y direction because of the additional 0.3V applied
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Figure 3.55: Colour plots for carrier density (base 10 logarithm) (i-iii) and resultant
electric fields Ex (MVm−1) (iv-vi) for Lelec=440nm and Lint=1072nm at varying ap-
plied bias for 1 Sun illumination. The top two figures are for short circuit, Va = 0, the
middle two for Va = Vbi, and the bottom two for Va − Vbi = 0.3V.
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Figure 3.56: The x and y components of the electric field for the result in figure 3.55(vi)
(MVm−1).

in the x direction. This oscillatory behaviour in the field direction perpendicular to the

electrodes has been observed before in simulation in figure 3(a) of reference [112].

The polaron pair dissociation rate increases as the x component of the electric field

becomes either less positive or more negative. It is therefore of considerable interest to

investigate if the field screening observed in figure 3.55 is having any noticeable effect

on the open circuit voltage, which is a parameter of significant research interest. In

order to do this, the value of the expression, VP , defined above in equations 3.54 and

3.56 is compared to its value assuming that no field screening occurs, Voc,lin. In this

latter case, the electric field will be given by Voc−Vbi

d . This comparison is performed in

figure 3.57 where the percentage difference between these two quantities is shown.

It is evident that the Voc does not always increase for higher intensities. It can be

seen that as the length of the fingers increases, the tendency is to move from a relative

decrease to a relative increase in Voc compared to Voc,lin. The same trend has been

observed for the case of constant electrode length and therefore is not considered further

here. It is therefore beneficial to device performance for the fingers to be as long as

possible in order for the space charge effects reported here to have a positive effect on

the Voc.
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3.9 Conclusions and further work

Idealised morphology polymer blend solar cells have been simulated both with and

without intermediate charge transfer states and also with varying ratios between the

heterojunction area and the electrode area.

In agreement with previously published experimental and theoretical studies, the in-

ternal quantum efficiency has been shown to be a complex function of the morphology.

However, this work takes this a step further by consideration of two different morphol-

ogy schemes, where the ratio of heterojunction length to electrode length is fixed or

varying. This difference has been shown to have a significant effect on device perfor-

mance.

Many experimentally relevant parameters have been investigated with the aim of pro-

viding ‘rules of thumb’ for the device behaviour with illumination intensity and mor-

phology. The morphology has been shown to be crucial in determining the device

performance. Reduced charge transport efficiency at high intensities has been shown

to be a significant loss factor affecting currents at short circuit and maximum power

point which, in turn, degrade the other solar cell parameters of interest. Geometrical

factors have been consistently shown to be crucial for understanding the quantum yield

in organic solar cells. The active area fraction is a critical parameter for understanding

device performance since only excitons generated within an exciton diffusion length of

the heterojunction can contribute to the photocurrent. Additionally, the ratio of ac-

tive area to interface length should be optimised in order to maximise the open circuit

voltage.
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Electric fields have been shown to have a significant influence upon all aspects of the

device physics, particularly at high intensities where space charge effects tend to be

detrimental to device performance through reduction of polaron pair dissociation. An

equation describing the various losses at open circuit has been derived which provides

a bridge between two previously published models: one describing a bilayer device and

the other a bulk heterojunction. Both of these models are able to use simplifications

which cannot be utilised here. For example, the space charge effects in the interdigitated

model are more complex than either of the two predecessors due to the inherently multi-

dimensional architecture. Direct application of this model has shown the presence of

polaron pairs can account for an open circuit voltage loss of up to 80mV. With further

relation to space charge effects, electric field screening has been observed in the interface

region. This has been shown to have a relatively small effect on the open circuit voltage,

although the length of the fingers should be maximised to increase the potential increase

in the open circuit voltage brought about by electric field screening.

Future work should extend the model to give a better quantitative understanding of the

origin of Voc by including the energetics of exciton separation at the polymer-polymer

heterojunction. This is necessary because the work presented here assumes that all

excitons which reach the heterojunction are dissociated, either into free charges or po-

laron pairs. In reality, this dissociation will only occur if the resulting charge-transfer

state is lower in energy than the original exciton. The modelling of hybrid organic-

inorganic systems such as those reported by Coakley et al. is a possible future avenue

for research using this simulation scheme and would require minimal modification of the

existing framework [31, 32]. The experimental morphologies of these hybrid systems

(specifically those containing ZnO nanorods) can be much more akin to the idealised,

interdigitated systems considered here when compared to the more frequently used bulk

heterojunction devices, for which accurate devices models already exist [73]. Previous

studies have shown that device performance can be optimised by varying the layer

thickness in organic solar cells due to optical interference effects. This has been per-

formed for bulk heterojunction [107] and bilayer devices [84] and it would be instructive

to carry out similar studies on the ideal morphology devices considered in this work.
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Chapter 4

Simulation of dendrimer OLEDs

Dendrimers are a novel form of organic molecule wherein the separate properties of

solubility and colour of light emission, for example, can be tuned in isolation. This is

because different parts of the molecule perform different tasks. This is in contrast to

standard conjugated polymers where changing the side groups attached to the backbone

of the structure would tend to affect the solubility and the emission range. In this

chapter, the numerical model of the previous chapter is used to simulate experimental

current-voltage characteristics and extract parameters of interest such as the injection

barrier height and the equivalent circuit series resistance. No generation of charges

from incident light is considered and hence excitons and polaron pairs are absent.

4.1 Introduction

A dendrimer is a branched molecule consisting of a conjugated core, conjugated den-

drons and surface groups [113, 114, 115]. Figure 4.1 illustrates a generic dendrimer

molecule.

Dendritic architectures hold out significant promise in the field of optoelectronics due

to the spatial separation of their functional properties. In an OLED configuration the

dendrimer core controls the colour of light emission and the electron affinity and the

surface groups control the solubility [116, 113]. Charge transfer can occur between the

core or the dendrons however. The light-emitting core is then able to be processed

in solution and enables the electronic and manufacturing properties to be optimised

separately [113, 115, 116, 117] as opposed to the behaviour in small molecule devices

and co-polymers [116].

105



Figure 4.1: Schematic molecular structure of a dendrimer molecule. The central rect-
angle is the core, L is a linker and s is a side group. The large circle in the upper left
indicates a dendron. The dotted lines in the bottom and top right corners indicate
parity with the top left. Adapted from [113].

Another unique property of dendrimers is the ability to build molecules of successive

generation. Figure 4.1 illustrates a first generation structure. However, if there were

another layer of dendrons attached to those of the first generation, then a second

generation molecule would result. In dendrimers of high generation, it will generally

only be the surface groups or outermost branches which will interact. This should tend

to reduce the aggregation seen in some organic systems, which is deleterious to device

operation [115, 116]. The attachment of surface groups can enable the development of

new materials made from previously studied chromophores, which otherwise would not

be processible due their insolubility [113, 115]. The efficiency of dendrimer OLEDs is

found to depend on the generation with almost an order of magnitude increase when

a first generation material is exchanged for its second generation equivalent having

been reported in the literature [116]. Additionally, the efficiency has been shown to

be improved if a bilayer configuration is used [113] and active layer thickness has been

shown to affect the colour of light emission, giving another means by which to vary the

emission spectrum [113].
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Figure 4.2: Chemical structure of dendrimer
1.

Figure 4.3: Chemical structure of dendrimer
2.

A further advantage of the separate nature of the core and branches is that if the

HOMO-LUMO splitting of the core regions is smaller than the branched regions, then

excitations will tend to be directed toward the core [116] where recombination occurs.

This is an advantage for an OLED since the goal is to bring electrons and holes together

to drive the electroluminescence. It has also been suggested that transfer of charges to

the core may also facilitate charge recombination due to the formation of an electric

field [115, 113]. The funneling of charges to the core can also be achieved by making the

conjugation length of the dendrons shorter than that of the core [117]. These factors

mean that a single dendrimer layer can have a function akin to that of a polymer LED

with several layers [114].

In this work, single layer dendrimer OLEDs using the two molecules shown in figures

4.2 and 4.3 are studied. These two materials shall be referred to as dendrimers 1 and 2

respectively throughout and are both first generation materials. Dendrimer 1 has cores

of fac- tris(2-phenylpyridine) iridium, [(Irppy)3], with phenylene dendrons covalently

bonded to it [118]. This material has been used previously for LED applications and

exhibits core to core transport properties [119]. Material 2 contains carbazole moieties,

which have been shown to transfer the transport of the molecule to the dendrons [120].

4.1.1 Experimental method

Both dendrimers studied here are soluble in chloroform and were spin-coated onto

various substrates which were cleaned before deposition. All devices studied here had

the same sandwich device architecture; an injecting bottom anode contact (ITO, ITO-

Au, Au or Pt), the dendrimer layer and a top metal cathode electrode (Al, Au, Pt or

Ca). Electrode materials were deposited at pressures of 3×10−6mbar but between the

electrode application stages the device was removed from the evaporator in order to

spin coat the dendrimer. The device characterisation was taken at room temperature

in air and in the dark. The fact that the device was not kept in vacuum during the
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Material Workfunction LUMO HOMO

ITO 5.1 [122] - -

Au 5.2 [123] - -

Pt 5.5 [123] - -

Al 4.3 [124] - -

Ca 2.9 [125] - -

Dendrimer 1 - 2.5 [120] 5.6 [120]

Dendrimer 2 - 2.5 [120] 5.7 [120]

Table 4.1: Electrode work functions for dendrimer devices.

Dendrimer 1 Dendrimer 2

T (K) 300 300

µp0 (m2V−1s−1) 9.3×10−11 [119] 1.2×10−9 [120]

γ (V−1/2m1/2) 3.4×10−4 [119] 3×10−4 [120]

NC(V ) (m−3) 1027 [55] 1027 [55]

d (nm) 100 100

Table 4.2: Invariant parameters for device simulation.

entire manufacture and testing process means that impurities are likely to have been

taken up by the device, which may adversely affect the performance. This point will

be discussed in detail below.

Most of the devices considered here are hole only. That is, the barrier for electron

injection is so high as to make the electron component of the current negligible. A

table of literature electrode work functions is shown in table 4.1 as well as the frontier

orbitals for the dendrimers used 1.

4.2 Methods

Due to the large number of simulation parameters involved (band edge density of states,

mobilities, field dependence of mobilities, barrier height for the thermionic emission

etc.), the data has been simulated within as consistent a parameter set as possible.

That is, keeping many parameters constant with values obtained from experiment

where available. Values of the invariant parameters used are given in table 4.2.

1The work function of ITO is poorly characterised and values ranging from 4.1-5.53eV can be found
in the literature [121]. A more recent value is quoted here, noting that it is only the relative value
of the electrode work function to the frontier orbital levels which controls the device behaviour in the
simulations.
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Figure 4.4: Equivalent circuit diagram of the dendrimer transport region (diode symbol)
and the series resistance RI . The horizontal arrow shows the direction of hole flow.

4.2.1 Series resistance

To simulate the current-voltage characteristics of different materials, the barrier for hole

injection from the metal work function into the dendrimer HOMO is varied to change

the magnitude of the resultant current. It has been shown consistently in this work that

varying the value of the injection barrier height and the zero-field mobility, to a very

good approximation, only affects the magnitude of the current, not the gradient. As a

general rule, it has been found that an increase in the injection barrier height by 0.1eV

has a similar effect on the current magnitude as decreasing the hole mobility by a factor

of 10. To vary the gradient of the current with respect to the voltage, the parameter

controlling the field-dependence of the mobility, γ, could be varied as in reference

[126]. However, this parameter is available for both materials under consideration.

Therefore, γ is kept constant throughout and an equivalent circuit series resistance,

RI , is introduced as shown in figure 4.4.

The approach of using a series resistance in an equivalent circuit for an organic device

model has been used previously to simulate degradation at the interface between layers

of polyethylenedioxythiophene/polystyrenesulphonate (PEDOT:PSS) and a fluorene

based polymer [127]. The first step to simulating this problem is to find a value of

the injection barrier height which gives the correct order of magnitude of the current.

Values from table 4.1 can be used as a starting point and a current-voltage characteristic

is generated. This then gives the relationship between the applied bias and the current
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assuming that all of the bias falls across the dendrimer layer; i.e. RI = 0. This yields the

differential resistivity of the active layer and therefore the current given the potential

difference across the dendrimer. Now, consider a finite resistance in series with the

organic layer. For a given current, the potential difference across the resistance can

be obtained from Ohm’s law. The bias across the dendrimer layer is then known from

the original data and the current can be evaluated. Using this algorithm, the injection

barrier height at the anode and RI can be used as the only fitting parameters. This

is because it has been found that the results are highly insensitive to the value of the

barrier height at the counter electrode. Expressed mathematically,

Vdendrimer = Va − IRI , (4.1)

where Vdendrimer and Va are the potential differences across the dendrimer and the

entire system respectively and I is the current. Therefore, when fitting current-voltage

characteristics, Va = Vdendrimer+IRI is plotted against I. In the numerical simulation

there is no resistance present, and so the results obtained from the numerical model

are Vdendrimer and I.

4.2.2 Ensuring zero current at zero applied bias

A simple thought experiment shows that a current flowing at zero applied bias (optical

and electrical) in an OLED must be unphysical. One simply has to imagine a battery

isolated from any leads, in which case the current has nowhere to flow to. It will now

be shown that this result follows straightforwardly from consideration of the boundary

conditions on the electron density and electrostatic potential. To begin with, any

effects altering the height of the charge carrier injection barrier will be neglected. The

analysis is deliberately kept as general as possible, without explicit consideration of the

precise form of the governing equations themselves. The following Neumann boundary

condition for the flux, Γ, of electrons into the device is used,

Γ1(2) = vrn

(

neq1(2) − n1(2)

)

= Jinj − Jrec. (4.2)

This gives the flux of electrons - not the flux of charge, which would require an extra

factor of e - at the left hand side (1) and the right hand side (2), vrn is the recombination
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velocity, neq is the equilibrium density when no current flows and n1(2) is the electron

density at the left (right) hand side of the device. The term

Jinj = vrnneq, (4.3)

represents the thermionic injection of electrons into the conduction band of the semi-

conductor from the electrode [77] and the term.

Jrec = vrnn, (4.4)

is the backflowing interface recombination current [77]. Complimentary to this is the

Dirichlet condition on the electrostatic potential, ψ [128],

ψ1(2) = −φBn1(2). (4.5)

The transport of electrons is by a combination of drift and diffusion and the bulk

electron current density is given by

Jn = eµnnE + eDn
dn

dx
= −eµnn

dφn

dx
. (4.6)

The final equality defines the electron quasi-Fermi level, φn,

φn = ψ − kBT

e
ln

(

n

NC

)

. (4.7)

From equation 4.7, it is clear that the current will only go to zero if the gradient of the

quasi-Fermi level vanishes everywhere in the device. This can only be the case if

φn1 = φn2 (4.8)

or
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ψ1 −
kBT

e
ln

(

n1

NC

)

= ψ2 −
kBT

e
ln

(

n2

NC

)

. (4.9)

Assuming that the device current is zero yields n1(2) = neq1(2) from equation 4.2 and

the values for ψ1(2) are known from the potential boundary conditions, equation 4.5.

Therefore,

ψ1 − ψ2 = −φBn1 −−φBn2. (4.10)

Substituting from above gives

−φBn1 + φBn2 = −kBT

e
ln





NC exp
(

−eφBn2

kBT

)

NC



+
kBT

e
ln





NC exp
(

−eφBn1

kBT

)

NC



 ,

(4.11)

which yields

−φBn1 + φBn2 = −φBn1 + φBn2. (4.12)

Therefore, the form of the boundary conditions for the electron flux and the potential

automatically ensure zero current at zero applied bias. A complication arises when it

is considered that the boundary conditions are more complicated than considered thus

far. Firstly, there is the Schottky barrier height lowering. To include this, the electron

flux, Γ, is modified thus

Γ1(2) = vrn

(

neq1(2)Θ− n1(2)

)

, (4.13)

where Θ > 1 represents the barrier lowering due to the Schottky effect. Therefore to

keep the electron flux zero at zero applied bias, equation 4.13 must be modified as

follows,

Γ1(2) = vrn

(

neq1(2)Θ− n1(2)Θeq

)

, (4.14)
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where Θeq is the value of Θ at zero applied bias. In addition, the injection-recombination

formalism used here [55, 80] has two further additions to the expressions for the particle

flux densities,

1. The injection term, vrnneq1(2), is multiplied by a factor θ < 1 when the Schottky

effect is not valid (the precise form of the equations is not important, only the

physics of enforcing zero current at zero bias).

2. The interface recombination term, vrnn1(2), is multiplied by a factor ϑ > 1 when

the Schottky effect is valid.

For this formalism to be successfully applied, the sign of the electric field at zero

electrical bias is required because this affects the form of the equations. For example,

the Schottky effect will not be present for holes at the left hand side of the device if the

field is negative at zero bias; so Θ = 1 and θ < 1. Also ϑ = 1 because this quantity only

deviates from unity when the Schottky effect is valid. An example is now considered

for the case of the hole current at the left hand side of the OLED where the electric

field is negative at zero applied bias. Firstly, the Schottky effect is not valid here so

that, as a first order consideration

Γ = vrp (peqθ − pθeq) . (4.15)

This will ensure zero hole current. However, when a forward bias is applied, the

electric field will change sign and become positive. In this case the Schottky effect will

be ‘turned on’, represented by multiplication of the injection term by Θ > 1. Therefore

Γ = vrp (peqΘ− pθeq) . (4.16)

The factor θ has disappeared from the left hand term of the previous equation because

it is now equal to unity but the θeq term must remain to ensure continuity of current

as the electric field changes sign. Since the current on the left hand side has been dealt

with, the current on the right hand side will not need any modification because charge

continuity will ensure that it is zero on the other side also.

The Schottky effect in essence changes the shape of the potential profile near the

electrode. However, the potential boundary conditions are invariant. That is, the

value of the potential is kept the same at the electrode whether or not the Schottky
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Device run Anode Dendrimer Cathode Bias direction

IV01 ITO 1 Al +

IV02 Au 1 Au +

IV03 Au 1 Au -

IV04 ITO 2 Al +

IV05 ITO 2 Au +

IV06 ITO 2 Au -

IV07 Au 2 Au -

IV08 Au 2 Au +

IV01b ITO-Au 1 Au +

IV02b ITO-Au 1 Au +

IV03b Au 2 Au +

IV06b Au 1 Au +

IV01c ITO 1 Au +

IV02c ITO 1 Ca-Al +

IV06c ITO 2 Ca-Al +

IV01d Au 2 Al +

IV02d Au 2 Al +

IV03d Au 2 Al -

IV04d ITO-Au 2 Al +

IV05d ITO-Au 2 Al -

IV06d Au 1 Al +

IV07d Au 1 Al -

IV08d ITO-Au 1 Al +

IV09d ITO-Au 1 Al -

IV01e Pt 1 Au +

IV02e Pt 1 Au -

IV03e ITO 1 Pt +

IV04e Au 1 Pt +

IV05e Au 1 Pt -

IV06e ITO 2 Al +

Table 4.3: Device structures used.

effect is valid. The Schottky effect only lowers the barrier for charge injection for one

carrier at a time. That is, when the electron injection barrier height is lowered, the

hole barrier is not lowered also, but is raised [55, 82] by an amount which is not equal

to the Schottky lowering amount for the electrons, as is clear by comparing equations

3.20 and 3.23. What this means, is that if the potential boundary conditions tracked

the values of the barrier heights of the respective carriers, then the difference between

the potentials at the electrodes would not be equal to the built-in potential, Vbi.
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Figure 4.5: Experimental (+) and simulation fits to the current-voltage characteristics
of an ITO/dendrimer 1/Al device with (solid line) and without (dashed line) a series
resistance of 1.2 × 103Ω. The solid line fits the data considerably better, however at
low bias the difference is small.

4.3 Results

Table 4.3 summarises all data that is considered in this chapter and an example of how

the fitting of an experimental IV curve can be improved with the addition of RI is

shown in figure 4.5. It is clear that the addition of the series resistance decreases the

current for a given applied bias as expected and justifies the use of this method as a

fitting procedure. The difference between the two fits in figure 4.5 becomes increasingly

marked at higher values of the applied bias since the correction due to the resistance

is proportional to the current, given by equation 4.1. Many of the experimental data

sets had curvature (that is dI
dV

) which are considerably smaller than those obtained

using the model with the experimental data for µp0 and γ. These results will therefore

benefit from having a series resistance term in their equivalent circuit.

4.4 Dendrimer 1 results

In table 4.4, the data describing the hole only devices for dendrimer 1 are given. Due to

the large number of simulations carried out, it is not deemed necessary to show every

fit obtained and therefore only one current-voltage characteristic for each injecting

electrode material considered is shown in figure 4.6.
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φBp (eV) φ
(SM)
Bp (eV) RI (Ω)

ITO/1/Al∗ 0.4 0.5 1.2×103

ITO/1/Au 0.48 0.5 7× 103

ITO/1/Pt 0.74 0.5 7× 107

Au/1/Au 0.64 0.4 1× 108

Au/1/Au 0.57 0.4 1.1 × 108

Au/1/Au 0.5 0.4 4× 106

Au/1/Al∗ 0.69 0.4 0

Pt/1/Au 0.65 0.4 2× 106

Au/1/Pt 0.7 0.4 5× 106

ITO-Au/1/Au∗ 0.76 0.4 (Au) 0

ITO-Au/1/Au 0.76 0.4 (Au) 0

Au/1/Al∗ 0.64 1.3 0

ITO-Au/1/Al 0.55 1.3 2× 106

Pt/1/Au∗ 0.61 0.1 0

Au/1/Pt 0.67 0.1 7× 106

Table 4.4: Simulated hole injection barrier heights, φBp (compared with values calcu-

lated from the Mott-Schottky model, φ
(SM)
Bp ) and the series resistance RI for dendrimer

1-based devices. The injecting electrode material is underlined in each case and the
results marked with an asterisk are plotted in figure 4.6.

4.4.1 ITO injecting electrodes

Firstly considering Al as an electrode material, there will be a large barrier to hole

injection into dendrimer 1 because there is a large offset of 1.3eV between the Al work

function of 4.3eV and the dendrimer HOMO level of 5.6eV. The barrier for electron

injection is expected to be roughly 1.8eV and therefore, the injection of electrons and

holes is expected to be suppressed. The barrier for hole injection in the ITO case is

expected to be just 0.5eV. Because of these two effects, the device current is expected

to be hole only. This makes an important assumption, i.e. that the barrier for injection

of electrons (holes) is given by the difference between the metal work function and the

dendrimer LUMO (HOMO). This is the Mott-Schottky model which will be considered

in further detail below. Table 4.4 shows that the value of the hole injection barrier at

the ITO/dendrimer 1 interface is fitted as 0.4eV, this is smaller than the 0.5eV value

given by the Mott-Schottky model and may be attributable to the fact that the work

function of ITO can be altered depending on the way it is prepared [129].

In this same device structure, figure 4.6 shows that a significant current was recorded.

However, no electroluminescence was present and therefore the device was not func-

tioning as an OLED. This indicates that the electron injection is sufficiently poor to

prevent significant bimolecular charge recombination occurring, which will in turn give
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Figure 4.6: Current-voltage characteristics for dendrimer 1. The different injecting
contact materials are underlined, ITO/dendrimer 1/Al (+), Pt/dendrimer1/Au (△),
Au/dendrimer 1/Al(�), Au/dendrimer 1/Al (©), ITO-Au/dendrimer1/Au (⋄). The
symbols are the experimental data and the solid lines are the simulation data.

rise to light emission. This justifies the above assumption made above that the Al

cathode gives rise to negligible electron injection.

To further investigate this, an ITO/dendrimer 1/Au device was fabricated. In sub-

stituting Al for Au, the increase in the cathode work function of ∼1eV is expected

to decrease any electron injection still further due to the larger injection barrier. The

same anode material is expected to keep the hole injection properties unchanged. How-

ever, it can be seen from table 4.4 that the fitted barrier for hole injection increases by

almost 0.1eV. As mentioned above, it is found that an increase of the barrier height of

this magnitude gives rise to a decrease in the current of roughly a factor of 10 in the

simulation. It is therefore clear that the counter electrode material has a significant

effect on device performance. Additionally, it is also possible that there exists a finite

barrier layer through which holes must be extracted at the Au cathode. This could

be due to contamination of the interface from air borne particulates incurred during

device fabrication, which may also affect the Au work function [123]. The increase in

the fitted value of the series resistance for the Au cathode device adds weight to this

hypothesis that the counter electrode is somehow hindering hole transport.

The fact that the current is reduced by roughly a factor of 10 in moving from an Al

to an Au cathode further gives further weight to the assumption that the current in

these devices is hole only. This is because, to give such a marked decrease, 90% of the

current in the former case would need to have been due to electron transport, which

is unphysical here. It can therefore be said with some confidence that the devices

considered thus far are hole only in nature.
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The area of the devices considered throughout this work is ∼10−6m2 and therefore

the sheet resistance of the ITO anode devices considered thus far compares well with

previously reported results for conjugated polymer systems of ∼108Ωm−2 [127].

4.4.2 Au injecting electrodes

Devices with Au injecting contacts are now considered in detail to see what effect

reducing the expected barrier height for hole injection has on the device characteristics.

Replacing an ITO injecting anode with the higher work function metal Au would give an

increase in the current assuming Mott-Schottky theory holds as is frequently assumed

in organic device models [75]. With the exception of the third ITO anode device (where

the counter electrode is Pt) the converse is seen however and the barrier is higher in

the cases with Au injecting electrodes. This is unexpected from the above analysis

and shows that the Au/dendrimer interface is of poorer quality than that between the

dendrimer and the ITO.

The unusual properties of Au/organic polymer contacts have been noted before and

were explained in terms of interfacial dipoles, which lower the Au work function and

thereby increase the hole injection barrier [130, 131, 132].

The first three runs for Au injecting contacts in table 4.4 are of the structure Au/dendrimer

1/Au. For these devices, values of the injection barrier of 0.64, 0.57 and 0.5eV respec-

tively were obtained. For these values of the injection barrier, values of the RI of

between 106Ω and 108Ω were found. This large variation in both the values of φBp and

RI is a further indication of the effect contamination can have on device performance.

For the fourth run in table 4.4 (Au/dendrimer 1/Al), a good fit can be obtained with

a barrier of φBp = 0.69eV without the need for a series resistance. This indicates that

the presence of a second Au contact further deteriorates the device performance. The

fifth and sixth runs having an Au injecting contact have Pt counter electrodes and will

be considered later.

4.4.3 ITO-Au injecting electrodes

The next electrode is a hybrid of the two previous materials; where Au is deposited

on the ITO coated substrate to form the injecting contact. The counter electrode in

these cases is Au as previously considered. This device structure requires the highest

fitted value of the injection barrier height for any of the devices considered in this work

using dendrimer 1, thus giving a very low current, figure 4.6. It is again clear that Au
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is hindering the device performance and that the presence of the ITO underlayer does

not help to increase the current, but decreases it still further.

4.4.4 Pt as an injecting electrode and counter electrode material

The inclusion in this work of Pt as an electrode material is interesting because its work

function has been reported to be very close to that of the HOMO level of dendrimer

1. Reference [123] gives a value of 5.5V for its work function and the HOMO level

of dendrimer 1 lies at 5.6eV. If this were the case in a device configuration then the

injection of holes from Pt into the dendrimer would be barrierless [74] and should be

simulated as an ohmic contact in contrast to the Schottky method used thus far (see

table 4.4 for numerical details). Simulations with ohmic injecting electrodes, however,

gave currents which were too large to be fitted even with a large value of RI . The

use of an injection barrier at the Pt/dendrimer 1 interface was therefore needed to

fit the data. Two device structures were considered using Pt as the injecting contact;

Pt/dendrimer 1/Au and Au/dendrimer 1/Pt. The values of the fitted barrier heights

(0.61eV and 0.67eV respectively) are sufficiently similar to give confidence that this

fitting method is suitable. In addition to these devices, 3 devices with Pt counter

electrodes were also examined. Of these, the 2 Au devices were fitted with φBp values

of 0.65eV and 0.7eV and very similar values of RI . Finally an ITO/dendrimer 1/Pt

device was fitted with a 0.74eV barrier and a high series resistance of 7×107Ω.

Why the ITO/dendrimer 1/Pt device should have such poor performance is not clear.

However, it is of note that the series resistance is required for a good fit for all of the

devices where Pt is present as the counter electrode but not where it is the injecting

electrode. This raises the interesting possibility that there is a finite barrier for the

extraction and injection of holes at a Pt electrode. This is because a large series

resistance is required for Pt used as the counter electrode, and also that the devices

with a Pt injecting electrode cannot be fitted with ohmic contacts.

For the device structure Pt/dendrimer 1/Au, the experiment needs to be run in reverse

bias (negative bias on Pt side) for Au to constitute the injecting contact. From a simu-

lation point of view, this is no different from applying a positive bias to the Au contact.

Therefore, the two experiments Pt/dendrimer 1/Au (reverse bias) and Au/dendrimer

1/Pt (forward bias) were simulated identically. The hole injection barrier heights and

series resistances for these two cases can be seen to agree favourably (see table 4.4).

This further supports the use of the modelling methodology employed here.
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φBp (eV) φSM
Bp (eV) RI (Ω)

ITO/2/Al 0.4 0.6 0

ITO/2/Au∗ 0.54 0.6 7× 105

ITO/2/Al 0.68 0.6 1× 105

ITO/2/Au 0.55 0.5 4× 106

Au/2/Au 0.80 0.5 0

Au/2/Au 0.80 0.5 0

Au/2/Au 0.82 0.5 1× 108

Au/2/Al 0.6 0.5 3× 105

Au/2/Al∗ 0.71 0.5 0

ITO-Au/2/Al∗ 0.48 0.5 (Au) 4× 104

Au/2/Al 0.72 1.4 0

ITO-Au/2/Al∗ 0.56 1.4 6× 104

Table 4.5: Simulated hole injection barrier heights, φBp (compared with values calcu-

lated from the Mott-Schottky model, φ
(SM)
Bp ) and the series resistance RI for dendrimer

2-based devices. The injecting electrode material is underlined in each case and the
results marked with an asterisk are plotted in figure 4.7.

4.4.5 Al injecting electrodes

Lastly, devices consisting of an Al injecting electrode were considered. A very large

injection barrier was expected to be found because the difference between the vacuum

work function of the Al and the dendrimer 1 HOMO is 1.3eV. However, values of

0.55eV and 0.64eV were found. This result adds further weight to the hypothesis that

the Mott-Schottky model is not valid under many of the situations considered herein.

4.5 Dendrimer 2 results

Several similar device structures are now considered using dendrimer 2 as the active

layer and the parameters obtained from simulation are given in table 4.5.

4.5.1 ITO and Au injecting contacts

As before, ITO injecting electrodes are considered first. Upon substitution of different

counter electrodes, no immediate pattern is seen. However, the same general increase

in fitted barrier heights (noted above for dendrimer 1) is seen when ITO is replaced

by Au as the injecting contact. The device structure Au/dendrimer 2/Au requires a

larger barrier height than that of any of the other devices where Au is only present
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Figure 4.7: Current-voltage characteristics for dendrimer 2. The different injecting con-
tact materials are underlined, ITO-Au/dendrimer 2/Al (⋄), ITO-Au/dendrimer 2/Al
(△), ITO/dendrimer 2/Au (©)and Au/dendrimer 2/Al (�). The symbols are the
experimental data and the solid lines are the simulation data

as the injecting contact. This gives increased weight to the hypothesis given above for

dendrimer 1 that there exists a thin barrier layer for extraction at Au and Pt counter

electrodes.

4.5.2 ITO-Au injecting contacts

For an ITO-Au injecting anode, the fitted value of the barrier height is unexpectedly

low at just 0.48eV. This was a surprising result for two reasons. Firstly, a barrier for

hole injection of 0.76eV at the ITO-Au/Dendrimer 1 interface has already been fitted

and secondly, the dendrimer 2 HOMO lies at 5.7eV compared to 5.6eV for dendrimer

1. In this case, an increase in the barrier would therefore be expected, not the ob-

served decrease. A significant difference between these results however is that for the

dendrimer 1 case, the counter electrode is Au, whereas in this case it is Al. This is

in agreement with the results presented above which show worse device performance

when Au is used as the counter electrode.

There are examples in the literature of a barrier for the extraction of electrons from

organic optoelectronic devices [133, 134] and in fact, these studies have shown this to be

beneficial to device performance. The reason for this is that the electrons build up at

the extraction barrier and increase the electric field strength there, thereby increasing

hole injection. An extraction barrier has not been considered herein, however it would

be an interesting addition to the modelling procedure to do so and would be a departure

from the frequently used assumption that the counter electrode has little or no effect
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on device performance. The conclusions reached in references [133] and [134] will not

be directly relevant here since only unipolar devices have been considered thus far.

However, consideration of related space charge effects in bipolar dendrimer devices are

considered below.

4.5.3 Al injecting contacts

The final hole-only device structures to be considered have an Al injecting contact and

has been fitted with a barrier for hole injection very much smaller than that expected

from the Mott-Schottky model. This further emphasises the inability to predict the

barrier heights from literature values of electrode work functions and organic material

frontier orbital levels as consistently noted above and is in agreement with the results

found for dendrimer 1 attached to Al injecting contacts.

4.5.4 Comparison between the dendrimers for the device

structure Au/dendrimer/Al

An interesting comparison between the current-voltage characteristics of the two den-

drimers can be seen for the structure Au/dendrimer/Al, where Au is the injecting

contact. The current for the dendrimer 1 device (fitted without a series resistance) is

smaller than when the dendrimer is swapped for dendrimer 2. This is the case even

though the fitted barrier height for the former device is the smaller of the two. This

counterintuitive conclusion can be rationalised by noting that dendrimer 2 has a higher

value of µp0. This is also evidence for the differing ways holes are transported in the

two dendrimers; that is, hopping between localised states in the molecular core for

dendrimer 1 and between the branches, or dendrons, of dendrimer 2 [119, 120].

4.6 Bipolar device performance

All of the devices considered thus far have contained only holes as mobile charges.

Therefore, to be able to model the transport characteristics of devices containing elec-

trons and holes with confidence, the properties of devices containing only electrons

need to be considered first. The bipolar devices considered later have the struture

ITO/dendrimer/Ca-Al and Ca has a work function of just 2.9eV, which is considerably

smaller than the electrodes considered thus far. Since the two dendrimers have a com-

mon LUMO level of 2.5eV, a large number of electrons can be expected to be injected
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Figure 4.8: A current-voltage characteristic for a Ca-Al injecting contact into dendrimer
1. The solid lines represent the change in slope at the onset of tunneling.

over the 0.4eV barrier. Devices with two Ca-Al contacts were therefore considered

to be electron only and their current-voltage characteristics were examined to try to

obtain the relevant material parameters.

Due to significant noise in the experimental currents, considerably larger biases were

needed to be applied to the electron only devices to obtain currents which increase

monotonically with applied bias over a bias range of roughly 10V or more. The high-

est bias in these cases were roughly 50V, much larger than the maximum of 15V for

the hole only devices. At these large applied voltages, tunneling will tend to be the

largest component of the device current [77]. An abrupt change in the slope of the

current-voltage curve at high voltage is the signature of tunneling controlling the de-

vice behaviour and is evident in figure 4.8 where Ca-Al is the injecting contact into a

dendrimer 1-based device.

4.6.1 Electron injection barrier height

Because a tunneling component to the injected current is not considered, the fitting

algorithm as described above for fitting hole only device currents cannot be used for the

electrons. The Fowler-Nordheim method was therefore used, which gives the barrier

height for charge injection into a semiconductor given a tunneling current, I, and

associated electric field, E [135]. In this method, ln
(

I
E2

)

is plotted against 1
E . The
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Figure 4.9: Fowler-Nordheim plots for dendrimer 1 (©) and dendrimer 2 (�). The
devices are assumed to be electron only with Ca-Al injecting electrodes. Equation 4.17
is assumed to hold in the region indicated by the the solid lines.

gradient, κ, yields the barrier for injection, φBn, from equation 4.17

κ =
8π (2m∗)1/2 φ

3/2
Bn

6π~e
, (4.17)

wherem∗ is the effective mass (taken to be equal to the free electron value here). Figure

4.9 shows the relevant Fowler-Nordheim graphs for dendrimers 1 and 2.

The fitted barrier heights were 0.6eV for dendrimer 1 and 0.3eV for dendrimer 2. Since

the two materials have the same LUMO level of 2.5eV, it was expected that the value

of the injection barrier would be the same for both dendrimers considered. The fact

that this is not the case is a further indication that the Mott-Schottky model is not

necessarily a good indicator of the actual barrier height for charge injection in a real

device. This also shows that this is possibly the case for electrons as well as holes, as

found previously. It should be noted however, that the gradient of the Fowler-Nordheim

graph for dendrimer 1 in figure 4.9 is not as constant as that of dendrimer 2. Since the

premise of the method is that the current is dominated by tunneling, this non-linearity

in figure 4.9 may be an indication that there is a finite thermionic emission component

to the injection current in the dendrimer 1 case.

The other parameters needed for the simulation of the bipolar devices are the electron
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Figure 4.10: Simulated (solid line) and experimental (©) current-voltage characteristics
for an ITO/2/Ca-Al device.

mobility factors µn0 and γn. These parameters have not been experimentally obtained

for either dendrimer, it is therefore postulated that γn = γp and that µn0 = µp0/100

since both materials are preferentially hole transporting. This latter assumption has

been used previously for the relationship between majority and minority carrier mobil-

ities in organic polymers [136, 137, 138]. Figure 4.10 shows the simulated and experi-

mental current-voltage characteristic for an ITO/dendrimer 2/Ca-Al device.

The fit of the simulation in figure 4.10 is encouraging since the model gives the same

order of magnitude for the current as seen experimentally. However, the slope of the

experimental curve is higher than that obtained with the model. This means that

the fit cannot be improved by the addition of a series resistance as this will always

tend to reduce the gradient of the simulated data. The electron component of the

simulated current here is significantly larger than the hole component and therefore

better agreement could be found by using a larger value of γn. As mentioned above,

γn = γp here since no experimental value exists in the literature at present.

The simulation of the ITO/dendrimer 1/Ca-Al device was not successful in that the

predicted device current was ∼2 orders of magnitude too low. In light of the large

barrier for electron injection into the device fitted above (0.6eV c.f. 0.3eV for the

dendrimer 2 device), this is further indication that tunneling may not be the dominant

current component in figure 4.9 above for the dendrimer 1 data and that the fitted

barrier height is significantly too high.

125



4.6.2 Comparison of experimental bipolar device results

Now considering the bipolar results for the two dendrimers together, the current-voltage

and external quantum efficiency characteristics obtained from experiment can be seen

in figure 4.11. The currents given in figure 4.11 were higher than any other result con-

taining either dendrimer respectively. This is indicative of a large electron component

of the device current in both devices considered and justifies the use of Ca-Al as an

electron injecting electrode material.

The external quantum efficiency in emissive devices will depend not only on the current

(that is, the transport properties of the organic layer) but also the balance between

transport and charge injection [74]. It has been found experimentally that, when the

intensity of light emission is equal to 100 cdm−2, the external quantum efficiency of

dendrimer 1 is 0.21% and that of dendrimer 2 is lower at 0.14%. Biases of 6V and

8.8V need to be applied to the dendrimer 1 and 2 devices respectively to achieve

this brightness level. Efficiencies as high as 16% have been reported for dendrimer 1

[139], significantly higher than those obtained herein, which is further evidence for the

crucially important balance between injection and transport in OLEDs.

The bipolar devices considered here are of the structure ITO/dendrimer/Ca-Al. The

hole mobility of dendrimer 1 has been experimentally shown to be smaller than that

of dendrimer 2 and it is therefore assumed that the electron mobility in dendrimer 1

is also smaller. If this is the case, it is surprising that the current is larger for the

dendrimer 1-based device since the two have identical electrode materials.

The fitted electron barrier height for dendrimer 1 gave a simulated current which was

significantly too low, so if it is assumed that the two devices have equal electron injection

barrier heights, then the lower current for the dendrimer 2 device may be ascribed to

a larger hole barrier height. Although it has been experimentally established that the

hole mobility is larger in dendrimer 2, the dendrons in this material are larger, and it

is therefore possible that this deteriorates the electron transport. This would lower the

electron mobility value in dendrimer 2 and may therefore give rise to a lower bipolar

device current in spite of its higher hole mobility.

4.6.3 Space charge effects in bipolar devices

The charge densities and the electric field inside the dendrimer devices has also been

considered in order to examine what rôle space charge effects play in device perfor-

mance. Firstly, the bipolar device which was more successfully simulated is considered,
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Figure 4.11: Current-voltage and external quantum efficiency plots for
ITO/dendrimer/Ca-Al devices, where the active layer is dendrimer 1 (©) and
dendrimer 2 (�). The current-voltage curve for dendrimer 2 is the same as shown in
figure 4.10.

that is, the ITO/dendrimer 2/Ca-Al device. Figure 4.12 shows the electron and hole

densities at an applied bias of 12V for the data considered in figure 4.10. It has been

noted above that the current is dominated by the electrons because of the low electron

injection barrier height and therefore the higher density of electrons seen in figure 4.12

is expected. The contribution of the holes to the resultant electric field profile is negli-

gible because their density is so much lower than that of the electrons and a negative

gradient in the electric field everywhere is therefore evident and is shown in figure 4.13.

Considering figures 4.12 and 4.13, it is clear that the electron density is exerting a

noticeable influence upon the electric field in the device. It is interesting to note that

the electron density exhibits a peak at the anode (left hand side) even though there

is no barrier for extraction, as considered in the work of Murata et al. [133]. This is

because the extraction rate for charge carriers in these simulations is proportional to

their mobility [80]. Since the electron mobility is assumed to be only 1% of that of

the holes, the electrons tend to accumulate at the extracting electrode. The fall in the

hole density at the other side of the device in figure 4.12 is conversely due to the larger

value of the hole mobility. If the electric field in the device were constant, it would

be equal to 100MVm−1. The fact that the deviation in figure 4.13 from the uniform

electric field is relatively small implies that the increase in electron density at the left

hand side will only have a minor effect on the device behaviour.
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Figure 4.12: Electron (solid line) and hole (dashed line) densities for an ITO/dendrimer
2/Ca-Al device at 12V forward bias. The anode (cathode) contact is on the left (right)
hand side of the device.
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Figure 4.13: Resultant electric field for the carrier densities shown in figure 4.12.

Although the fitting of the ITO/dendrimer 1/Ca-Al current-voltage characteristic was

not successful, the carrier densities and electric field profiles in the device should be

considered also. This is done at the same applied bias of 12V as for the ITO/dendrimer

2/Ca-Al above in order to note any similarities or differences between the two bipolar

devices. The electron and hole profiles are shown in figure 4.14. Firstly, the electron

density is ∼4 orders of magnitude lower in this device compared to that when dendrimer

2 is the active layer. This can be attributed to the larger electron injection barrier of

0.6eV compared to 0.3eV for dendrimer 2. The densities of electrons and holes are

relatively low compared to the electron density for the dendrimer 2 device in figure

4.12 and therefore the electric field was found to be uniform across the device, with a

value of 100MVm−1. The peak in the electron density at the anode and the fall in the

hole density at the cathode (due to the factor of 100 difference in their mobilities) are
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Figure 4.14: Electron (solid line) and hole (dashed line) for the structure
ITO/dendrimer 1/Ca-Al at 12V applied bias. The carrier densities are significantly
lower than the electron density in figure 4.12 for an ITO/dendrimer 2/Ca-Al device.

again evident in figure 4.14.

4.7 Invariance of effective electrode work function in hole

only devices

It was mentioned above that the fitted barrier heights for many of the hole only devices

were significantly different from the Mott-Schottky model. To probe this further, every

hole-only current-voltage characteristic was fitted again without any additional series

resistance in order to obtain values for the hole barrier heights (and hence, effective

electrode work functions) with no further adjustable parameters. As can be seen from

figure 4.5, the absence of RI will mean that the quality of some of the simulated

current-voltage characteristics will be worsened. However the large number of devices

considered will give a better overall picture of the interface behaviour using different

electrode materials. The injecting contact work functions, Φ were calculated using

Φ = HOMO− φBp. (4.18)

and the average value was found to be 5± 0.1eV with only 3 data points lying outside

of the error bounds. The error bounds, ±∆, are given by standard error equation,
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∆ =
σ√

Ntrials
, (4.19)

where σ is the standard deviation and Ntrials is the number of devices considered. A

similar conclusion has been reported recently [123] for junctions between the organic

polymer α-sexithiophene and electrode materials which have vacuum work functions

varying in excess of 1eV. By studying the barrier for the injection of holes in this case,

it was found that the effective electrode work function changed by just 0.2eV.

A key similarity between the work in reference [123] and that presented here is that

both sets of devices contained electrode-organic interfaces which had not been kept

exclusively under vacuum. All the hole only devices presented here were tested under

ambient conditions and the dendrimer layers were not deposited in vacuum, therefore

leaving them open to contamination. The hole-only device characteristics are therefore

expected to be substantially affected by the presence of contaminants. Reference [123]

shows that an expected change in barrier height of ∼1eV is reduced to ∼0.2eV by

the presence of impure contacts. However, the results presented here indicate that

this effect may give rise to even more uniform injection barrier heights than given in

reference [123]. This is because the difference between the work functions of Al and Pt

has been reported to be as high as 1.2eV, but the results given above show a standard

error of just 0.1eV.

4.8 Conclusions and further work

The current-voltage characteristics of phosphorescent dendrimer-based OLEDs have

been considered using a detailed device model. The significant difference between the

molecular structure of the active materials is that the dendrons of dendrimers 1 and 2

incorporated phenylene and carbazole respectively. The model contains realistic bound-

ary conditions and drift-diffusion transport to simulate the device currents in order to

extract the barrier height for the injection of majority carriers and the equivalent circuit

series resistance.

It has been shown from inspection of many different device structures that the pre-

diction of the injection barrier height from the Mott-Schottky model will invariably

give substantially different results compared to those obtained from simulation. Au

was found to be consistently deleterious to device performance, even when used as a

counter electrode material. This is interesting because modelling studies of organic

devices frequently ignore the effect of the extracting electrode on device performance.
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Pt was found to form a blocking, Schottky, contact at interfaces with dendrimer 1.

This result is unexpected from consideration of the value of the vacuum work function

for Pt, which has been reported to lie just 0.1eV above the dendrimer 1 HOMO level.

The transport characteristics of the two active materials considered here have been

shown to be noticeably different from one another. For example, the higher bipolar

device current for dendrimer 1 in spite of its significantly lower hole mobility. However,

both materials show invariance of the injection barrier height with changing electrode

work function, in agreement with recent literature reports.

The large electron density in a dendrimer 2 device containing electrons and holes has

been shown to have a noticeable effect on the internal electric field. This will, however,

not greatly affect the device performance because the deviation from uniformity is

small. Additionally, the low electron mobility reduces the extraction rate at the anode,

causing a peak in the density there. This is analogous to literature results which

attribute electron accumulation to a physical barrier for electron extraction, which is

not present in these studies.

The counter electrode has been shown to have a significant effect on device performance

and future work on modelling these devices should consider charge extraction explicitly,

perhaps including a barrier for charge injection as in references [133] and [134]. It would

also be prudent to consider more electron only devices, especially at low applied bias,

with a view to better understanding the bipolar properties of these materials. This

would enable the fitting of electron barrier heights and series resistances without the

need to resort to the Fowler-Nordheim formalism. This does rely on the availability of

experimental data for the values of µn0 and γn however, which are currently lacking.

The advantages of being able to tune different properties of dendrimers by alteration

of different parts of their underlying structure is shown to be a unique advantage in

the device physics of organic materials. This is in agreement with the literature and

this work has been submitted for publication [118].
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Chapter 5

Overall conclusions and their

relation to future

experimentation

This work has considered the simulation of excitonic solar cells and OLEDs using

the Finite Element Method. To the authors’ knowledge, this is the first such study

of these devices using this modelling technique. A recurring theme throughout this

work has been the effect of electric fields on device behaviour. In part I, the inability

of a field-free model to accurately describe diffusion-limited photovoltage rise times

has been, in part, attributed to the lack of consideration of the bandstructure at the

TiO2/substrate interface. It has also been shown that high doping densities could

improve device performance by, firstly, reducing recombination by keeping electrons

away from the grain surfaces, and secondly by the formation of a back surface field at

the counter electrode. The author is unaware of any experimental studies where the

device performance of a DSSC has been examined in terms of the TiO2 doping density.

This would be a fruitful avenue of further study in this field, as well as the examination

of the bandstructure and electric field at the extracting electrode in such devices. The

amount of band bending in the grains has been shown to increase with their radius

and therefore, studies of the effect of grain size on device performance would also be

instructive.

Part II was concerned with purely organic-based solar cells and LEDs. The study of

ideal morphology polymer solar cells has quantified the effect of polaron pairs for the

first time, showing that they can lead to significant losses in the open circuit voltage,

the fill factor and the efficiency at maximum power point. Therefore, any processes

132



which aid their dissociation into free charges would be beneficial to device performance.

Again it is the electric field which plays the most significant rôle here since it has been

shown that the reduction of its magnitude at open circuit by space charge effects can

increase the open circuit voltage if the finger length is long enough. Therefore, future

experimental studies should consider the measurement of the electric field in these

devices and the effect of the amount of interpenetration between the donor and acceptor

phases with a view to the observation of field screening. A very interesting parameter

to vary in experiment would be the dielectric constant. The polaron pair dissociation

rate increases with this quantity for positive electric fields, which occur at open circuit

in this model. Additionally, the recombination rate is inversely proportional to it. The

increase of the dielectric constant may therefore act as a positive feedback loop at open

circuit whereby reduction of interfacial recombination is accompanied by an increase in

polaron pair dissociation. This effect should be particularly marked in devices where

inorganic acceptor materials are used since their dielectric constants tend to be higher

compared to prototypical organic polymers and dendrimers.

There are two main conclusions of the research into dendrimer-based OLEDs. The first

is that the Mott-Schottky model for the height of the injection barrier into OLEDs is

not adhered to in devices which are prepared, at least partly, under ambient conditions.

The second is that Au is consistently deleterious to device performance as a hole injec-

tion and extraction material. These conclusions lead to two potentially very important

corollaries. Firstly, that it is not crucial which material is chosen for the injection of

charges into devices which are not entirely prepared under vacuum. This is because

the effective electrode work function is found to be highly invariant. Secondly, that

Au should be avoided as a hole injection and extraction material altogether in devices

prepared in this way. It is generally accepted that interfaces between metallic elec-

trodes and conjugated organic materials should be barrierless, that is, ohmic, in order

for device performance to be optimised. However, it has been shown conclusively, in

agreement with the recent literature, that the Mott-Schottky model cannot be used to

predict which materials will form ohmic contacts in these devices. This may enable the

use of more cost-effective electrode materials to be used in these applications since the

use of a potentially more expensive metal to achieve ohmic injection will ultimately not

lead to better injection properties. This is because of the invariance of the injection

barrier upon alteration of the injecting contact material. The rôle of electric fields has

been found to be small in the bipolar devices considered herein. This has been found

from simulations which do not take the possible existence of an extraction barrier into

account however. Barriers of this kind have been shown to have a significant effect

on device performance in the literature. The results presented here have shown that

there may be a barrier of this kind at some counter electrodes and so future experi-

mental studies should examine the space charge effects present in such devices. This

work could be accompanied by related simulations to those considered here with the
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presence of an extraction barrier explicitly included.
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Appendix A

Derivation of field dependent

behaviour of metal-organic

currents

Equations 3.16 and 3.19 are now derived [63] using the nomenclature in reference [80].

Near a metal-organic interface the total potential, ψ, is described by,

ψ = φBn −Ex−
e2

16πǫx
, (A.1)

from equation 3.9, where ǫ = ǫ0ǫr. The maximum of the potential is obtained from the

null differential, where x = xME ,

∂ψ

∂x
= −eE +

e2

16πǫx2
= 0, (A.2)

so

xME =

√

e

16πǫE
. (A.3)

Therefore
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ψ (xME) = φBn − eE
√

e

16πǫE
− e2

16πǫ

√

16πǫE

e
= φBn −

2e3/2E1/2

(16πǫ)1/2
. (A.4)

The potential at xc is

ψ
(

x±c
)

= ψ (xME)− kBT, (A.5)

therefore

φBn − eExc −
e2

16πǫxc
= φBn −

2e3/2E1/2

(16πǫ)1/2
− kBT, (A.6)

and

eEx2
c =

(

2e3/2E1/2

(16πǫ)1/2
+ kBT

)

xc =
e2

16πǫ
= 0. (A.7)

Now, since e2

16πǫ = rckBT
4 ,

eEx2
c −

(

(rckBTe)
1/2 + kBT

)

xc +
rckBT

4
= 0. (A.8)

Multiplying the first term in equation A.8 by r2
ckBT

r2
ckBT

and the second term by rc

rc
gives

(

eErc
kBT

)(

xc

rc

)2

rckBT −
(

(

eErc
kBT

)1/2

rckBT + rckBT

)

xc

rc
+
rckBT

4
= 0. (A.9)

Using the reduced field, f = eErc

kBT ,

f

(

xc

rc

)2

−
(

f1/2 + 1
) xc

rc
+

1

4
= 0. (A.10)
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Therefore

x±c
rc

=
1

2f

{

(

1 + f1/2
)

±
√

(

1 + f1/2
)2 − f

}

=
1

2

{

f1/2 + f−1 − f−1
(

1 + 2f1/2
)

.
}

(A.11)

Now using to the definition of the recombination velocity in reference [80],

S(E) =
Jrec(E)

ne
= µEtot = µ

(

−E +
e

16πǫx2
c

)

(A.12)

=

(

µ

[

16πǫ (kBT )2

e3

])

erckBT

4

1

(kBT )2

(

−E +

(

rckBT

4e

)

1

xc

2
)

(A.13)

= S(0)

[−eErc
4kBT

+
rc
4

kBTe

(kBT )2
rc (kBT )

4ex2
c

]

(A.14)

=

[

−f
4

+
1

16

(

rc
xc

)2
]

(A.15)

= S(0)











−f
4

+
1

16
4

[

f−1/2 + f−1 − f−1
(

1 + 2f1/2
)1/2

]2











(A.16)

=
S(0)

4

{

−f +
1

ψ(f)2

}

. (A.17)

The final two identities yield equations 3.16 and 3.19, which are equations (7) and (9)

in reference [80].
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Appendix B

The finite element method

Throughout this work, the finite element method is used to solve systems of partial

differential equations. This Appendix gives a brief introduction to the method.

B.1 Introduction

Methods of discretisation of continuum equations grew up around the turn of the last

century with mathematicians and engineers approaching the problem from different

angles [140]. Mathematicians were interested in solutions to fundamental problems in

differential, finite difference equations. Engineers on the other hand, were concerned

with solutions to real world problems where the situation of interest was made of actual

discrete parts, such as trusses [141].

A basic definition of the finite element method (FEM) is,

“The finite element method is a numerical technique that gives approximate

solutions to differential equations that model problems arising in physics

and engineering [142].”

This method has only existed in its current mathematical form since the 1950s and

one of its first applications was in the field of aircraft design [142]. Since then it has

become one of the widely used numerical techniques in structural engineering. FEM

remains a relatively unknown discipline outside of the engineering sciences however.
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Figure B.1: An example Delaunay mesh, generated using MATLAB

The first step in performing an FEM simulation is setting up the mesh upon which

to solve the equations. The simulation method used here uses an algorithm based on

Delaunay triangulation. Given an arbitrary set of vertices on a 2D plane, a Delaunay

mesh is one where the circle through the vertices of an element does not contain any

other vertices [143]. Figure B.1 shows a generic example using the

delaunay

command in MATLAB. Throughout the Appendices in this work, any text written in

the above font surrounded by spacing above and below signifies that it is computer

code.

After the specification of the mesh, it is now possible to look at how the finite element

method yields approximations to the underlying equations. The basic premise is to be

able to approximate the actual solution, u say, by a combination of a finite number

of parameters: the degrees of freedom. Consider an example consisting of just two

mesh elements joined by three points or nodes [144]. The two intervals exist over

0 < x < 1 and 1 < x < 2 respectively and that the function u is linearly varying

between the nodes. This latter assumption corresponds to so-called linear elements. In

this example, all that is needed to completely define the solution are the values of the

function at the nodes x1, x2 and x3. Using the notation u(x = x1 = 0) = U(0), the

degrees of freedom are Ui,
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u(x) = U1φ1(x) + U2φ2(x) + U3φ3(x) =
∑

i

Uiφi. (B.1)

In equation B.1, φi have the property that they are equal to unity at node i and zero

at all other nodes. They are known as basis functions and higher order polynomials

can be used to interpolate between the nodes to achieve higher accuracy. Consider

quadratic, second order, functions for example. In this case, two more nodes at the

midpoints of the previous three are required, x4 = 0.5, x5 = 1.5,

u(x) = U1φ1(x) + U2φ2(x) + U3φ3(x) + U4φ4(x) + U5φ5(x). (B.2)

The function u(x) between point 1 and 2, say, is defined by the degrees of freedom at

the end points (1 and 2) and at the midpoint (point 4). In the general, N -dimensional

space, the basis functions are known as shape functions and they will be referred to as

such in the remainder of this work. Once the equations have been discretised in the

manner described above, the Galerkin method is used to solve the problem.

B.2 The Galerkin Method

In this section, the example given in chapter 2 of reference [142] is considered to illus-

trate the assumptions implicit in the Galerkin method. As a generic example, consider

equation B.3 below for the conduction of heat as a function of x in a medium with

thermal conductivity κ, absolute temperature T and a rate of heat generation Q,

−κd2T

dx2
= Q. (B.3)

This can be discretised as set out above to give,

T (x) =

n+1
∑

i=1

aiφi(x), (B.4)

where the φi are the shape functions. Since equation B.4 is an approximation, it will

never yield the exact solution to a problem with a finite number of terms. Mathemat-

ically, if the actual solution is T ∗ and the approximate solution as T , then
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Figure B.2: Example linear interpolation function for an arbitrary temperature profile
T as function of x. From [142]

κ
d2T

dx2
+Q 6= 0 ≡ R(T, x), (B.5)

where R(T, x) is a residual function with the property R(T ∗, x) ≡ 0. It is impossible

to force the residual to be equal to zero everywhere. It is therefore assumed that

the residual can be multiplied by a weighting function, W (x), and the integral of the

product set to zero,

∫ L

0
W (x)R(T, x)dx = 0. (B.6)

The Galerkin method is therefore also known as the method of weighted residuals. The

choice of weighting function depends on the technique used. In the Galerkin method,

they are chosen to be equal to the shape functions, φi. So, in summary,

∫ L

0
W (x)R(T, x)dx =

∫ L

0
φ(x)

{

−κd2T

dx2
−Q

}

dx = 0. (B.7)

The problem is now one of finding appropriate forms for the φi. T (x) must be contin-

uous, so the obvious first guess is linear interpolation between nodes of the simulation

domain as shown in figure B.2. It becomes clear however upon examination of the

governing equation that this method will not yield physically realistic results without

some modification.
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In the integral form of the Galerkin weighted residuals method, it is assumed that the

resulting integrals are integrable [140]. It is therefore necessary to only use integrals

which have finite solutions. Consider figure B.2. It is clear that at the nodes between the

elements, the first derivative of the linear fit is discontinuous and the second derivative is

undefined. However, the integral of the first derivative is integrable. This Ansatz gives

the trivial result that d2
T

dx2
= 0 everywhere, which is unsatisfactory. In the general case,

it is clear that for equations containing derivatives of the form dn

dxn
, the derivative dn−1

dxn−1

must be continuous. Often, integration by parts can be used to lower the derivative

order by one since, in general

∫

udv = uv −
∫

vdu. (B.8)

Now the continuity is only required in dn−2

dxn−2
. It should be noted here that the above

mentioned integration by parts is simply an implementation of the divergence theorem

[145],

∫ ∫ ∫

V
∇ · FdV =

∫ ∫

S
F · dS, (B.9)

where the divergence of a vector field, F, within a bounded volume, V is evaluated by

considering the normal flux, F·dS over the surface, S of the volume [145, 141]. Equation

B.9 is the three-dimensional case of the theorem but is equally valid in n-dimensions.

Furthermore, applying the condition that d2
T

dx2
must exist everywhere is incompatible

with another analytically soluble situation of interest, such as equation B.10,

−κd2T

dx2
= δ(x− xsource). (B.10)

Here δ(x − xsource) is the Dirac delta function, which has the property of being equal

to unity when x = xsource and zero otherwise. It also has an infinite first derivative.

This can be resolved by using integration by parts. From equation B.7,

∫ L

0
φ

d2T

dx2
dx = φ

dT

dx

∣

∣

∣

∣

L

0

−
∫ L

0

dφ

dx

dT

dx
dx, (B.11)
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Figure B.3: Comparison between the analytical (solid line) and finite element (dashed
line) solutions to equation B.13.

and therefore

∫ L

0
κ

dφ

dx

dT

dx
dx−

∫ L

0
φQdx− κφdT

dx

∣

∣

∣

∣

L

0

= 0. (B.12)

Equation B.12 is very important and is known as the weak form of equation B.7; the

highest derivate has been lowered, or weakened by one.

A beautifully simple example of the implementation of this method can be seen by con-

sideration of equation B.13 over the interval between zero and one, with the boundary

conditions J(0) = J(1) = 0.

−d2J

dx2
= 1. (B.13)

Trying a solution, J(x) = a1 sinπx, the Galerkin form of equation B.13 is

∫ 1

0
sinπx

(

− d2

dx2
[a1 sinπ] x− 1

)

dx = 0. (B.14)

143



Splitting the integral into its constituent terms and integrating the first term by parts

gives the weak form,

− sinπx
d

dx
sinπx |10 +

∫ 1

0

(

d

dx
a1 sinπx

)2

dx−
∫ 1

0
sinπxdx (B.15)

= 0 +

∫ 1

0
a1π

2 cos2 πxdx−
∫ 1

0
sinπxdx (B.16)

=
a1π

2

2
− 2

π
(B.17)

= 0. (B.18)

Therefore a1 = 4
π3 . A comparison between the analytical and finite element solutions

to the problem can be found in figure B.3 and illustrates the power and underlying

simplicity of the Finite Element Method.
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Appendix C

COMSOL Multiphysics Manual

COMSOL is commercially available and it is the aim of this section of the thesis to

act as a ‘manual’ for solving electrical problems in the systems considered herein. For

ease of reading, when a term specific to COMSOL is used, it will be printed in bold

font. Begin by typing

comsol &

at a command line, followed by

ps aux | grep comsol | grep -v flexlm |grep -v grep |

awk ’{print $2}’ | xargs renice +10

which increases the stability of the simulations by increasing the value of the Unix

‘nice’ parameter. The Model Navigator now appears on screen, figure C.1.

In creating a new model, the dimension of the problem must be chosen, 1-3. In addition,

radially symmetric problems can be considered. The Application Modes from the

given list are then chosen; for example COMSOL Multiphysics→ Convection and

Diffusion→ Convection and Diffusion→ Steady-state analysis for dealing with

time independent charge distributions where electric fields and diffusion gradients affect

the transport. An arbitrary name for variable to be solved for is then chosen.
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Figure C.1: The COMSOL Multiphysics Model Navigator

One of the main selling points of the COMSOL software is its ability to deal with so-

called Multiphysics simulations; that is, interacting equations which can be coupled

together. An example of this is the coupling between charge density and electric po-

tential, i.e., the gradient of the electric field is proportional to the charge density, but

the flux of charges is dependent on the electric field. By clicking on the Multiphysics

button on the lower right hand side of the Model Navigator as many different Appli-

cation Modes as desired can be chosen. The term Application Mode refers to the

solution of each dependent variable.

For some of the Application Modes, the default Application mode properties

must be altered. For example, for Convection-Diffusion the Equation Form must

be changed to Conservative from Non-Conservative. Also, this is where the Weak

Constraints are activated or de-activated. These are important for calculation of the

flux of particles and can only be used in conjunction with Dirichlet boundary conditions.

Pressing OK opens the main COMSOL window. There are many different expressions,

fields, constraints and couplings which can be filled in here but only relatively few will

be explored here. The alteration of the explicit equation system which is solved is

possible (that is, the actual underlying form of the equations themselves), however this

is not encountered in this work. The CAD interface of the software is used to generate
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Figure C.2: Choosing Multiphysics application modes.

the simulation subdomain which is to be simulated and this should be the first task

undertaken in any simulation. The Draw mode is accessed by clicking on Draw →
Draw Mode, which gives a default grid of extent -1 → 1. However, the domains

of interest here are of sizes in the range nm to µm so this must be reduced. This is

done by going to Options→ Axes/Grid Settings. Here the extent of the modelling

domain and the grid settings can be altered. To draw the shape of interest, click on

the relevant shape on the far left hand side of the window and click-and-drag with

the mouse. Fine tuning of the size and position of the selected shape can be achieved

by clicking on Draw → Object Properties. This is shown in figure C.3. To draw

an arbitrary shaped polygon using straight lines, first select the Line option from the

drawing bar and click on the grid points to define the desired shape. The shape is

complete by right-clicking at the final desired vertex. If the initial and final points are

not coincident then COMSOL will connect them with another line.

After the drawing of the relevant figures it is necessary to set up the equation system.

Constants are set by clicking on Options→Constants. Position dependent quantities

or those which are only valid on boundaries, or on certain subdomains must also be

specified. These are specified in Options→ Expressions→Boundary Expressions

or Subdomain Expressions. The treatment of each variable is done using the name

given in the model navigator and derivatives are specified using the simple syntax for the
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Figure C.3: Example of a rectangle drawn inside an arbitrary shaped polygon drawn
with straight lines. The Object Properties option is shown from the Draw menu
from where the dimension, geometrical origin and rotational orientation can be speci-
fied.
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Figure C.4: Example of the Boundary Expressions and Subdomain Settings dialogue
boxes. Clicking between the two boxes changes the view mode. This can be done
manually using the Ω and ∂Ω buttons on the top of the window for Subdomains and
boundaries respectively.

generic variable J(x, y, z, t). An example of the Boundary and Subdomain Expressions

dialogue boxes are shown in figure C.4

Jx, Jy, Jz, Jxy, Jt, Jtt...

where these quantities represent ∂J
∂x , ∂J

∂y , ∂J
∂z , ∂2J

∂x∂y , ∂J
∂t and ∂2J

∂t2 .

This description of the general mathematical language used by COMSOL is now ex-

plored further using the Convection-Diffusion solver as an example. Fundamentally,

all COMSOL requires as an input is for the user to enter parameters and/or expres-

sions in the fields Physics → Boundary Settings, and Physics → Subdomain

Settings, as in figure C.5.

Specifically, all the solver needs to know for calculation of the bulk transport proper-

ties is the diffusion coefficient and the speed of ‘convection’. In semiconductor device

physics, this is almost always called the drift velocity. One can either enter the de-

sired expression directly into the dialogue box or use the name of an expression given

in the Subdomain Expressions box, for example. In the case of the Diffusion

Coefficient, D and velocity (in one dimension),
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Figure C.5: Example of the Boundary Expressions and Subdomain Settings
dialogue boxes.

D=kT/e*mu

using the Einstein relation (k, T, mu and e are Boltzmann’s constant, the temperature,

the mobility and the electronic charge respectively) and

velocity=-mu*psix or mun*E

the alternative expression can only be used once ‘E’ has been defined in the Subdo-

main Expressions dialogue for example,

E=-psix

The Reaction Rate box in the Subdomain Expressions dialogue needs more care-

ful consideration; this is where the form of the charge generation and/or recombination

profile is specified. Because of the way COMSOL expects input, generation terms

must be positive and recombination terms must be negative. The solution is for the

density of charge carriers, not the charge density, so it is crucial that the Reaction

Rates have the units of inverse metres cubed, velocities have units of metres per second,
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and diffusion coefficients units of metres squared per second. The units are however ar-

bitrary in a generic model as long as they are internally consistent. Other unit systems

can be specified in the Physics → Model Settings → Base Unit System field,

although ‘None’ is used throughout this work and SI units are used internally through-

out. All that is left to specify in the Convection-Diffusion Subdomain Settings is

the Initial Condition tab. This is the initial guess of the solution at the beginning of

the simulation. It should be mentioned at this point that for modelling pure diffusion

(as used for modelling exciton transport) the method of setup is the same but one does

not need to specify a drift velocity. The Convection-Diffusion solver could be used

instead with zero drift velocity. The Element tab in the Subdomain Settings box

should be left unchanged.

A very important aspect of the Subdomain Settings box is the Active in this

domain check box. This determines whether or not the solver gives a solution in

a particular subdomain. This is crucial for the consideration of Internal Boundary

Conditions. Consider the geometry in figure C.3, if the interior rectangle is considered

active then boundary conditions on its edges cannot be specified unless the Interior

boundaries check box is ticked in the Boundary Settings dialogue.

The Boundary Settings dialogue for the Convection-Diffusion solver is now con-

sidered. There are essentially two types of boundary condition which are considered

here; Dirichlet and Neumann. In the former, the flux of carriers is specified, which

corresponds to a Schottky boundary condition. In the latter case the density is speci-

fied, which is an Ohmic condition. In the case of flux boundary conditions it is again

very important to notice that since the solution is for the number density of electrons

we need to give the flux (current) in the units of inverse metres squared per second.

This corresponds to a flux density; specifying a current density would give a flux which

is 1.6×10−19 (the electronic charge) times too small. Generally, any parameters to be

used in the Boundary Settings dialogue are specified in the Boundary Expressions

field.

The Poisson equation solver is now considered. This is included in the Multiphysics

form by selecting COMSOL Multiphysics → PDE Modes → Classical PDEs

→ Poisson’s Equation in the Model Navigator. In the Subdomain Settings

dialogue the Poisson equation is given in the following form,

∇ · (c∇psi) = f, (C.1)

where f is the ‘source term’. This is in comparison to the standard electrostatic form,
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−∇2ψ =
eρ

ǫ0ǫr
=
e (p− n)

ǫ0ǫr
, (C.2)

where ρ is the total charge density.

The parameter c in equation C.1 is called the Diffusion Coefficient in the COMSOL

nomenclature and enables the user to specify anisotropic diffusion (this is also possible

in the Convection-Diffusion, and Diffusion application modes). This Diffusion

Coefficient is set equal to ǫr (isotropic diffusion) in this work and the source term, f ,

is specified as

f =
e (p− n)

ǫ0
. (C.3)

This enables the recovery of the standard electrostatic form, equation C.2 from equation

C.1. Since ǫr is a constant the Diffusion Coefficient could be set equal to unity and

replace ǫ0 with ǫ0ǫr in equation C.3 without any loss of generality, assuming isotropic

diffusion.

This invokes an interesting property of COMSOL; that is, the same equation can

be solved in several different ways. As long as the solver used is set up to deal with

the Subdomain and Boundary Expressions the user wishes to use, then a solution

can proceed. An interesting example of this was found when dealing with interacting

populations of conduction band and trapped electrons in the modelling of dye-sensitised

solar cells, as will be described later in this Appendix. The boundary conditions for the

Poisson equation are of the Dirichlet form and the potential at the electrodes is equal

to the barrier to electron injection from the metal work function into the semiconductor

LUMO level.

In a simulation with multiple subdomains (boundaries), navigating between them to

ascribe different properties is achieved either by clicking with the mouse or by selecting

from the numbered list on the left hand side of the Boundary Settings/Expressions

dialogue. Any parameter specified on a subdomain (boundary), 1 say, will only be

valid on that one subdomain (boundary) unless multiple subdomains (boundaries) are

selected when typing the relevant expression. Expressions entered in the Options →
Expressions → Scalar Expressions dialogue, however, are universally recognised

and can be considered ‘global’ variables.
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Figure C.6: The default mesh for the geometry in figures C.3-C.5.

The meshing used in this modelling is straightforwardly implemented by pressing Ini-

tialize Mesh button or from the Mesh menu. Considering the geometry in figures

C.3-C.5, the default mesh is shown in figure C.6.

Mesh→Free Mesh Parameters brings up a dialogue box enabling the definition of

the size of the mesh on boundaries on subdomains. The mesh may need to be refined,

for example, at material interfaces where material properties may vary strongly with

position. Alternatively, the mesh can be globally refined using the Refine Mesh

button or select from the Mesh menu.

The relationship between two interacting populations of electrons in a DSSC is now

considered, as alluded to above. The different populations are free, conduction band

electrons and those which are trapped and therefore immobile. Neglecting any re-

combination or so-called ‘back reaction’ between the electrons and the electrolyte or

substrate, then it is clear that the reaction rates for the two electron densities must be

equal and opposite. This is because the act of trapping one electron will remove it from

the conduction band and place it in a trap. As seen earlier, the traps are distributed in

energy below the conduction band in an exponential distribution such that there are

more shallow traps (near conduction band) than deep traps. The coupled equations

describing the conduction band (nc) and trapped (nt) electrons are
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∂nc

∂t
= −∂nt

∂t
= 〈detrapping− trapping〉 . (C.4)

The precise mathematical interpretation of equation C.4 is given elsewhere as it is only

the implementation in COMSOL that is of concern here. The point is that the amount

of trapping at each trap level needs to be weighted by the appropriate number of traps

at that particular level. This is important because the rate of trapping into any level is

independent of its depth but the detrapping rate is dependent thereon. The triangular

brackets in equation C.4 denote an integration over energy. This is to ensure that the

total number of trapping states is the same as if they were all at one energy. The form

of equation C.4 means that a system of integro-differential equations results, which

COMSOL is unable to solve without modification. COMSOL is however capable of

solving some integral equations, but only those which deal with spatial or temporal

integrals [146]. The way around this is to discretise the trap levels from the continuous

exponential distribution and solve for each trap level separately.

If there is just one trapping energy [58], no integration would be necessary. The trap-

ping term will be negative (positive) in the conduction (trapped) electron application

mode and the detrapping term will be positive (negative). Photogenerated electrons

leave through the substrate side of the device via a flux boundary condition and the

electrolyte side is insulating (zero flux). Since the trap distribution is normalised, the

continuous trap distribution can be separated into N discrete levels and transform the

integral into a sum, that is,

∫ EC

EF neq

g(ET )dET ≈
N
∑

i=1

g(ET )i∆ET . (C.5)

What this amounts to in terms of implementing the equations in COMSOL is that

N Application Modes are needed to describe N trap levels of different depths. The

weighting of the trap number density is achieved by firstly assuming that each and

every trap level has the same number of traps as the whole system in reality, Nt,0.

No weighting of the trapping-detrapping Reaction Rates in the N traps level ap-

plication modes is considered. Each trap level reaction rate is then multiplied by the

appropriate factor as described in equation C.5 and then summed to give the total

trapping-detrapping Reaction Rate for the conduction band electron density. This

gives identical results found in reference [61] obtained using a Chebyshev numerical

integration scheme [63]. Another way of thinking about the total trapped electron

density is that the trap occupation probability is given by the total density of trapped

electrons divided by Nt,0.
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The form of the equation for the trapped electron density can be described in terms

of the same solver as used for the conduction band electrons but with zero diffusion

coefficient. This is because the trapped electrons are immobile and hence to do not

contribute to the current in the device. This reduces the continuity equation for trapped

electrons to the following form,

rate of change = reaction rate. (C.6)

The implementation of the optical modelling in polymer blend solar cells is now consid-

ered. Simulation of the optical interference pattern in a multilayered structure requires

the use of one of the add-on modules of COMSOL. Until 2006, this was called the

Electromagnetics module, but has subsequently been split in two (the RF module

and the AC/DC module). The RF module is considered exclusively here. From the

Model Navigator the solver is found from RF Module→ In-Plane Waves→ TE

Waves → Harmonic propagation. For simulations of blended polymer solar cells,

a device architecture similar to that of reference [84] is considered. A problem arises in

the implementation of the equations because the thickness of the glass layer is orders

of magnitude thicker than the rest of the device. This means that complex amplitudes

cannot be summed as in the multilayer stack without the glass. Therefore transmitted

intensities (amplitudes) must be summed instead [84, 98]. Therefore, the reflectance of

the multilayer stack (not including the glass layer) is calculated as well as that due to

the glass/air interface. The glass/air interface is straightforwardly calculated from the

standard Fresnel relations [1]. However, the reflectance of the stack is more complicated

and must be solved numerically.

The back contact on the device is assumed to be aluminium and is therefore highly

reflecting. Electromagnetic radiation at the wavelength of interest, 459nm, only pen-

etrates a very short distance into aluminium [100] so the Impedance boundary con-

dition at the organic/aluminium interface is used. This boundary condition is invoked

when the radiation is known to penetrate only a small distance and negates having to

use a further subdomain in the modelling. The Surface Electric Field, Esz, can be

used to specify a surface current at this interface, but this is not considered here.

In practice, two optical electric field solvers are required,

1. To find the reflectance of the multilayer stack (not including the glass substrate).

2. To calculate the actual value of the optical electric field in the stack given the

electric field at the glass/stack interface, calculated from the former solution.
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To calculate the reflectance of the stack, every interface in the device must be consid-

ered. It is therefore necessary to have a layer with a refractive index equal to that of

glass included. This layer should be thin because it is assumed that the light which is

incident on the glass/stack interface is incoherent [147]. The Port boundary condition

is then applied to the extreme left boundary, which outputs the S-parameters [148].

The S-parameter, S11 gives the power reflection coefficient R̃ [146],

R̃ = |S11|2, (C.7)

which is used in the calculation of the optical electric field at the glass/stack interface.

There are several properties of the Port boundary condition which require considera-

tion. Only one Port is considered and so the Wave excitation at this port check

box should be ticked. The value of the Port power level box is immaterial since the

value of S11 is not dependent on the value of this power. The User Defined option

from the Mode Specification drop-down list is chosen and Eoz is set to an arbitrary

value because S11 is independent thereof. Finally the Cut-off Frequency is set to

zero which implies that the waves of interest can propagate down zero frequency [146].

Since this solver can only be used in dimensions greater than one, to negate variation in

the direction perpendicular to the illumination direction, the Perfect Magnetic Con-

ductor boundary condition is used at the boundaries perpendicular to this direction

[146].

For the RF module Subdomain Settings, all that is required is the (complex) re-

fractive index in the form

refractive index = real part− imaginary part× i, (C.8)

where i =
√
−1. Note the negative sign of the imaginary part, in contrast to most

texts on this subject. The refractive index is almost always wavelength dependent. So

if the illumination is monochromatic, then a numerical value can be entered. However

a more general case has been implemented here enabling any wavelength in a given

range to be used. This is implemented using a Function. These can be defined in

Options → Functions.

The task of these functions is to interpolate between known values of a desired quantity

held in an external text file of the form given in table C.1. COMSOL can also

interpolate from numerical data entered manually or from user defined mathematical
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functions.

When the function dialogue box appears, the desired function name is entered and

the interpolation option selected. If interpolating from a file of data, select File, from

the Use Data From drop down menu and enter the location of the file. On the next

screen choose an Extrapolation Order and an Extrapolation Method. This latter

option is used when the independent variable lies outside of the given range and can

be set to a constant value, an interpolation function or a specific number. To evaluate

a function, the following syntax is used,

numerical value = function name (value of dependent variable) . (C.9)

For example, for a function named Function1, to evaluate it for its argument equal to

π, the code is written

Function1($\pi$)

The optical modelling presented here uses the free space wavelength as the indepen-

dent variable (Alternatively, the frequency can be specified here). These variables are

automatically created in the Physics → Scalar Variables dialogue box. Note that

the names given to these variables indicate to which application mode they refer to.

For example, the free space wavelength will be called

lamda0_Example

A full list of these built-in variables can be found in the COMSOL documentation.

This allows access to the many variables which the Application Modes solve for by

default and saves the user valuable time in Postprocessing.

As with any modelling procedure there are certain conditions under which a simulation

may not converge. There are ways to improve the convergence of a simulation. One of

the most often used is to solve for a simpler case than finally needed and then use this

simpler case as a starting value for the more complicated model. This can be achieved

in a number of different ways. For example, if solving for multiple application modes,

then solving for a smaller subset of these first will aid convergence. These settings can

be changed in the Solve → Solver Manager dialogue box. In the Initial Value

tab, different starting conditions can be specified. These will be the settings that are

used if the Solve button is used to start the solver. This is illustrated by the ‘=’
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Line number Contents of line

1 %

2 values of the independent variable go here separated by spaces (for example wavelength)

3 %

4 values of the dependent variable go here separated by spaces (for example the real part of the refractive index)

Table C.1: Example of an input file for defining a Function in COMSOL
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button seen in figure C.5, for example. However, if the Restart button is used (‘=’

sign with curving arrow above), then the solver uses the current solution as the initial

condition. Note that this will give the same results as if the Current Solution option

in the Initial Value tab of the Solver Manager is checked and the Solve button

is used. For example, in the most complex Multiphysics model considered in this

work there are 9 Application Modes; 4 Convection-Diffusion, 2 Diffusion, a

Poisson’s Equation solver and two RF optical electric fields. First, the Poisson’s

Equation and the two RF modules are solved alone. Then the two Convection-

Diffusion variables containing charge generation at the heterojunction are solved for

(pertaining to majority carriers in both phases). However, the term describing the

charge generation due to exciton dissociation is, at first, not included. This is done by

introducing a parameter Ξ (which is initially set to zero) such that the charge continuity

equation is of the form

Reaction rate = Ξ×generation from exciton dissociation−recombination to form excitons.

(C.10)

After this has been solved, the remaining Application Modes are solved for (still for

Ξ = 0). Only after this has converged is Ξ set to unity, which recovers the full equation

system. Indeed, using the Parametric solver, intermediate values of Ξ could be used

to aid convergence further. This has been found to be a very reliable way of obtaining

solutions to complex problems where other, simpler, methods had failed.

Other conditions where COMSOL models tend to have difficulty are where there are

particularly high Reaction Rates or abrupt, large changes in material properties,

such as dielectric constant. This is particularly acute in simulations involving titanium

dioxide, TiO2 mixed with an organic material. This is because TiO2 has a dielectric

constant approximately an order of magnitude higher than that of standard conjugated

polymers.

Now the solver used throughout this work is considered. The different solvers are

accessed from the solve→Solver Parameters dialogue box. Fundamentally there are

four different types of solver available; Stationary, Eigenvalue, Time-dependent

and Parametric. In this work only the final two of these are considered. For both

of these solution types, the same, default, UMFPACK solver is used. This is the

Unsymmetric-pattern MultiFrontal Package. This uses the matrix equation solution

method known as LU decomposition for sparse matrices [144, 149]. In all the time

independent modelling the Parametric solver is used, which enables the user to vary

one parameter and keep all the results together for analysis. The parameter most
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Figure C.7: The Solver Parameters dialogue box, showing the methods of entering
desired parameter values.

often varied is the applied bias, enabling current-voltage characteristics to be obtained.

Figure C.7 shows the Solver Parameters dialogue box.

Values of the parameter to be solved can be entered in several forms; as single numbers,

as a list of number separated by commas, as vector of the form

starting value:stepping value:end value

as a vector of linearly spaced values of the form

linspace(starting value, end value, number of steps)

or as a vector of logarithmically spaced values of the form

logspace(log10(starting value), log10(end value), number of steps)

The Parametric solver uses the value of the solution ‘active’ in the mode as the initial

guess for the solution. This solver is also an excellent way of attaining convergence on
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difficult problems as illustrated above for the example of the interdigitated polymer

solar cell model. Using the parametric solver, the solution could be obtained using any

combination of values of Ξ from 0 to 1 as long as they increase monotonically.

For the time dependent simulations, all that is necessary is to enter the value of the

time(s) to be used in the Times field after selecting the Time-dependent solver on

the left hand side of the Solver Parameters dialogue box.

With both of these solvers, there are many other parameters which can be changed,

however, it has been found time and time again that application of the correct mathe-

matical and physical data obviates the changing of these fields and they are left at their

default settings as often as possible. In the Solver Manager dialogue, the variables to

be solved for are chosen. This is also where the initial estimate of the solution variable

is specified. It is opened from the Solver Manager button, or from solve→Solver

Manager. In the left hand Initial Value tab, The value of the initial solution is cho-

sen. Any expressions defined elsewhere in the model can be used here, or alternatively

the Current Solution, or a Stored Solution can be used.

Any solution can be stored for future use and this is useful when trying to find a

particular type of solution with an unknown value of a particular parameter. For

example, a very frequently used example of this used throughout this work is to find

the open circuit voltage in a solar cell. This will occur at some finite positive bias,

generally somewhere between 0 and 1.5V. Therefore, a step size of lower precision

than finally required is used first. The solution required (that is, a change of sign of

the current in the case of the Voc) is found to fall between two solution parameters,

i ←→ j, say. Therefore either i or j can be used as the starting parameter by storing

them using the Stored Solution option in the Initial Value tab. It is then essential

to use the solve option not the Restart option. This is because using the Restart

option always ignores anything in the Initial Value tab and just uses the current

solution as the initial estimate for the solution. The next two tabs (Solve For and

Output) simply denote which parameters are found from the solution and which are

available for post-processing. Throughout this work the contents of these two tabs is

identical. Some other miscellaneous capabilities of COMSOL are now explored.

Integration Coupling Variables are extremely useful in several ways. For example,

to find the average value of a quantity along a boundary, a Boundary Integration

Variable can be used. These are defined in Options→Integration Coupling Vari-

ables→Boundary Variables. These variables are defined in exactly the same way as

normal Boundary Expressions except that the variable expression is now integrated

along the boundary. For example, if the expression is unity, the output of the variable

will be the length of the boundary in question. Therefore, to find the average of a
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Name Expression

Length 1

Jbar J/Length

Table C.2: Example of an Boundary Integration Variable

quantity J, Jbar, the formalism in table C.2 is used.

Whenever the variable Jbar is called in the simulation, it will return the average value

of the variable J along the boundary of interest. Note that this can be applied across

as many connected edges as required. Construction of the Subdomain Integration

Variables is handled in a completely analogous way.

Extrusion Coupling Variables are a way of accessing the value of a variable at a

point removed from where the quantity is defined. An example of this is in the consid-

eration of a bilayer organic solar cell, as considered in reference [55]. In this example,

the Reaction Rate of free charges within a finite distance of the interface depends

on the charge densities and electric field at the junction. Mathematically, this means

the evaluation of a Dirac-delta function outside where it is defined. This requires the

use of a Boundary Extrusion Variable. These are accessed via Options→ Extru-

sion Coupling Variable→ Boundary Variables. Again, they are formulated in the

same way as the standard Boundary Expressions but this time with some additional

information denoting where the variable is to be accessed. This amounts to choosing

whether there is a Linear Transformation or a General Transformation. A linear

transformation is used for mapping between regions of the same spatial order, line to

line for example. In the Source tab the variable name and its mathematical form are

defined and the Linear Transformation option is selected. Next, on the Destina-

tion tab, the line where the variable is required to be accessed is chosen, checking the

Use selected boundaries as destination check box. In the Source Vertices tab,

the ends of the source line are chosen, and they are moved into the Source Vertices

list using the arrows. Finally the Destination Vertices are addedin the same order as

the Source Vertices [144]. In the case of a General Transformation, extrusion to

other dimensions is possible, and this is exactly what is necessary in the case considered

in reference [55], where extrusion from a vertex to a subdomain is required. Opening

the Options→ Extrusion Coupling Variable→ Point Variables dialogue box,

the variable to extrude is selected and the General Transformation option at the

bottom is checked. On the Destination tab, the variable can be made available at

another point, at a boundary, or on a subdomain from the Level drop down menu by

checking the appropriate box on the left hand side menu.
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Application Mode Natural Boundary Condition

Convection-Diffusion Insulation/Symmetry

Electrostatics Zero Charge/Symmetry

Poisson’s Equation Neumann Boundary Condition with null coefficients

Table C.3: Examples of Natural Boundary Conditions [146]

Periodic Boundary Conditions are a particular implementation of the extrusion

coupling variable considered in the previous section and are accessed via Physics→
Periodic Conditions →Periodic Boundary Conditions. In this case, any flux

out of the left hand side of the modelling domain, for example, will be accompanied by

an equal flux in at the right hand side. One important technical consideration in the

implementation of these boundary conditions is that standard boundary conditions still

need to be applied to the boundaries under consideration in the Boundary Settings

dialogue. Specifically, the Natural Boundary Condition needs to be specified for

all solvers. Examples of Natural Boundary Conditions are given in table C.3.

Once the periodic conditions have been specified, COMSOL does not use the Natural

Boundary Conditions, but they must be specified in this way [146]. In the Source tab,

the variable to be solved for is specified; for example the electron density, n. COMSOL

conserves the flux here so it is important to specify n here not ∇n. COMSOL provides

a default name for the constraint variable of the form, pconstr[num], where [num] is

the number of the constraint. Next, on the Destination tab, the boundary where

the coupling is desired is chosen and the same expression in the Expression edit

field is specified, making sure that the correct pconstr[num] is selected in the drop

down Constraint Name menu. The addition of Source Vertices and Destination

Vertices proceeds analogously to the Extrusion Coupling Variables considered

above.

Ordinary differential equations can also be solved using COMSOL. An ordinary differ-

ential equation has only one variable, as opposed to the partial case of more than one.

The specific case considered herein is that of the extracted current in the transient pho-

tovoltage modelling in dye-sensitised solar cells. Here, a flux boundary condition which

depends on the time integral of the flow up to that point in time is used. Specifically,

the time-dependent current j(t) is given by

j(t) = ekext

(

nc(x = 0, t)− nc,eq exp

(

eVoc

kBT

)

exp

(

eQ(t)

CsubkBT

))

, (C.11)

as described previously, where
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Name(u) Equation Init(u) Init (ut)

Q Qt-OutFlux 0 0

Table C.4: Implementation of an ordinary differential equation.

Q(t) =

∫ t

0
j(t′)dt′, (C.12)

is the amount of charge collected in a time interval, t = 0 → t′. To implement this,

go to Physics→ ODE Settings. Table C.4 shows how to enter this in the COMSOL

Graphical User Interface.

In table C.4, the far left column defines the variable name (here the integrated current,

or charge, Q(t)). The next defines the equation to be solved, that is, d
dt

Q−OutFlux = 0

and the last two columns give the initial (t = 0) values of Q and d
dt
Q respectively. Note

here the use of the COMSOL shorthand Q ≡ d
dt

Q. The variable OutFlux is defined

via Options→ Integration Coupling Variables→ Boundary Variables, and is

set equal to the current density, j(t). Therefore, in summary

j(t) = ekext

(

nc(x = 0, t) − nc,eq exp

(

eVoc

kBT

)

exp

(

e
∫ t
0 j(t

′)dt′

CsubkBT

))

. (C.13)

Extensive information on all aspects of the implementation of the COMSOL software

can be found in the electronic and paper documentation which is shipped with it.

It is not the aim of this Appendix to supercede this but to summarise the relevant

information needed for the modelling of organic and excitonic devices.
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